Introduction to Quartus® II

Version 6.0
Contents

Preface .............................................................................................................................................. 6
Documentation Conventions ........................................................................................................ 7

Chapter 1: Design Flow ................................................................................................................. 9
Introduction..................................................................................................................... 10
Graphical User Interface Design Flow ........................................................................ 11
EDTool Design Flow .................................................................................................. 18
Command-Line Design Flow ........................................................................................ 23
Command-Line Executables........................................................................... 24
Using Standard Command-Line Commands & Scripts ........................................ 29
Using Tcl Commands ...................................................................................... 32
Creating Makefile Scripts........................................................................... 35
Design Methodologies & Design Planning ................................................................. 37
Top-Down versus Bottom-Up Design Methodologies ........................................ 38
Top-Down Incremental Compilation Flow .................................................. 39
Bottom-Up Incremental Compilation Flow .................................................. 40

Chapter 2: Design Entry .............................................................................................................. 42
Introduction..................................................................................................................... 43
Creating a Project............................................................................................................ 44
Using Revisions................................................................................................ 46
Using Version-Compatible Databases......................................................................... 50
Converting MAX+PLUS II Projects ........................................................................ 51
Creating a Design ........................................................................................................... 52
Using the Quartus II Block Editor ........................................................................ 53
Using the Quartus II Text Editor ........................................................................ 54
Using the Quartus II Symbol Editor ........................................................................ 54
Using Verilog HDL, VHDL & AHDL ........................................................................ 55
Using Altera Megafuctions......................................................................................... 56
Using Intellectual Property (IP) Megafuctions...................................................... 57
Using the MegaWizard Plug-In Manager ........................................................ 58
Instantiating Megafuctions in the Quartus II Software .......................................... 60
Instantiation in Verilog HDL & VHDL ......................................................................... 60
Using the Port & Parameter Definition........................................................................ 60
Inferring Megafuctions................................................................................................. 60
Instantiating Megafuctions in EDA Tools .......................................................... 61
Using the Black Box Methodology ................................................................. 61
Instantiation by Inference ......................................................................................... 62
Using the Clear Box Methodology ........................................................................... 62

Chapter 3: Constraint Entry ....................................................................................................... 64
Introduction..................................................................................................................... 65
Using the Assignment Editor .................................................................................. 66
Using the Pin Planner.............................................................................................. 67
The Settings Dialog Box............................................................................................ 69
Assigning Design Partitions ....................................................................................... 70
Assigning Design Partitions in the Project Navigator .............................................. 71
## Table of Contents

Assigning Design Partitions with the Design Partitions Window............ 71  
Importing Assignments ...................................................................................... 73  
Verifying Pin Assignments .................................................................................. 74  

### Chapter 4: Synthesis .................................................................................. 75  
Introduction........................................................................................................... 76  
Using Quartus II Verilog HDL & VHDL Integrated Synthesis.......................... 77  
Using Other EDA Synthesis Tools.................................................................... 80  
Controlling Analysis & Synthesis ..................................................................... 83  
Using Compiler Directives and Attributes.................................................... 83  
Using Quartus II Logic Options..................................................................... 84  
Using Quartus II Synthesis Netlist Optimization Options.......................... 86  
Using the Design Assistant to Check Design Reliability............................... 87  
Analyzing Synthesis Results With the RTL Viewer and State Machine Viewer... 89  
The RTL Viewer................................................................................................ 89  
The State Machine Viewer.............................................................................. 90  
Analyzing Synthesis Results with the Technology Map Viewer..................... 92  
Performing Incremental Synthesis................................................................. 94  

### Chapter 5: Place & Route ......................................................................... 96  
Introduction........................................................................................................... 97  
Performing a Full Incremental Compilation ..................................................... 99  
Analyzing Fitting Results.................................................................................. 100  
Using the Messages Window to View Fitting Results .................................... 100  
Using the Report Window or Report File to View Fitting Results............... 102  
Using the Timing Closure Floorplan to Analyze Results.............................. 104  
Using the Design Assistant to Check Design Reliability............................... 107  
Optimizing the Fit .............................................................................................. 107  
Using Location Assignments........................................................................... 107  
Setting Options that Control Place & Route................................................... 108  
Setting Fitter Options..................................................................................... 108  
Setting Physical Synthesis Optimization Options....................................... 109  
Setting Individual Logic Options that Affect Fitting..................................... 109  
Using the Resource Optimization Advisor.................................................... 110  
Using the Design Space Explorer.................................................................. 113  
Preserving Assignments through Back-Annotation........................................ 117  

### Chapter 6: Block-Based Design ................................................................. 120  
Introduction........................................................................................................... 121  
Quartus II Block-Based Design Flow................................................................. 121  
Using LogicLock Regions................................................................................... 122  
Using LogicLock Regions in Top-Down Incremental Compilation Flows........... 126  
Exporting & Importing Partitions for Bottom-Up Design Flows..................... 127  
Preparing the Top-Level Design for a Bottom-Up Incremental Compilation Methodology............................................................... 128  
Exporting a Partition to be Used in a Top-Level Project................................... 128  
Importing a Lower-Level Partition Into the Top-Level Project....................... 129
## TABLE OF CONTENTS

### Chapter 7: Simulation
- Introduction ................................................................................................................ 131
  - Simulating Designs with EDA Tools ............................................................................ 132
    - Specifying EDA Simulation Tool Settings ............................................................... 133
    - Generating Simulation Output Files ........................................................................ 134
  - EDA Simulation Flow .................................................................................................. 135
    - EDA Tool Functional Simulation Flow ..................................................................... 135
    - NativeLink Simulation Flow .................................................................................... 136
    - Simulation Libraries ............................................................................................... 137
  - Simulating Designs with the Quartus II Simulator .................................................... 139
    - Creating Waveform Files ....................................................................................... 141
    - Using the Simulator Tool ...................................................................................... 142

### Chapter 8: Timing Analysis
- Introduction ................................................................................................................... 145
  - Choosing the TimeQuest or Classic Timing Analyzer .................................................. 146
  - TimeQuest Timing Analysis ........................................................................................ 146
    - Running the TimeQuest Timing Analyzer ............................................................... 146
      - Using the TimeQuest GUI .................................................................................... 147
      - Tasks Pane ......................................................................................................... 148
      - Console Pane ....................................................................................................... 148
      - Report Pane ......................................................................................................... 148
      - View Pane ............................................................................................................ 148
    - Classic Timing Analyzer ......................................................................................... 149
      - Specifying Classic Timing Requirements ............................................................... 149
        - Specifying Project-Wide Classic Timing Settings .............................................. 151
        - Specifying Individual Timing Assignments ....................................................... 152
      - Performing a Classic Timing Analysis ................................................................. 154
      - Performing an Early Timing Estimate ..................................................................... 156
      - Classic Timing Analysis Reporting ....................................................................... 158
      - Making Assignments & Viewing Delay Paths ....................................................... 159
      - Viewing Timing Delays with the Technology Map Viewer ..................................... 161
    - Performing Timing Analysis with EDA Tools ............................................................ 163
      - Using the PrimeTime Software .............................................................................. 165
      - Using the Tau Software ......................................................................................... 166

### Chapter 9: Timing Closure
- Introduction .................................................................................................................... 168
  - Using the Timing Closure Floorplan ............................................................................ 168
    - Viewing Assignments & Routing ............................................................................. 169
  - Making Assignments ................................................................................................. 171
  - Using the Timing Optimization Advisor ....................................................................... 172
  - Using Netlist Optimizations to Achieve Timing Closure ............................................ 173
  - Using LogicLock Regions to Achieve Timing Closure ................................................ 175
    - Soft LogicLock Regions ......................................................................................... 176
    - Path-Based Assignments ......................................................................................... 176
Using the Design Space Explorer to Achieve Timing Closure............................... 178
Using Incremental Compilation to Achieve Timing Closure................................... 178

Chapter 10: Power Analysis.................................................................................... 179
Introduction........................................................................................................... 180
Performing Power Analysis with the PowerPlay Power Analyzer.......................... 180
Specifying Power Analyzer Options....................................................................... 182
Using the PowerPlay Early Power Estimator.......................................................... 184

Chapter 11: Programming & Configuration............................................................ 186
Introduction........................................................................................................... 187
Programming One or More Devices With the Programmer....................................... 191
Creating Secondary Programming Files.................................................................. 192
Creating Other Programming File Formats............................................................. 193
Converting Programming Files.............................................................................. 195
Using the Quartus II Software to Program Via a Remote JTAG Server.................... 199

Chapter 12: Debugging........................................................................................... 200
Introduction........................................................................................................... 201
Using the SignalTap II Logic Analyzer................................................................. 202
Setting Up the SignalTap II Logic Analyzer............................................................ 203
Using the SignalTap II Logic Analyzer with Incremental Compilation....................... 207
Analyzing SignalTap II Data................................................................................... 208
Using an External Logic Analyzer .......................................................................... 210
Using SignalProbe.................................................................................................. 212
Using the In-System Memory Content Editor......................................................... 214
Using the RTL Viewer & Technology Map Viewer................................................... 216
Using the Chip Editor............................................................................................. 216

Chapter 13: Engineering Change Management...................................................... 217
Introduction........................................................................................................... 218
Identifying Delays & Critical Paths With the Chip Editor......................................... 219
Editing Atoms in the Chip Editor............................................................................ 221
Modifying Resource Properties With the Resource Property Editor......................... 222
Viewing & Managing Changes with the Change Manager......................................... 224
Verifying the Effect of ECO Changes...................................................................... 225

Chapter 14: Formal Verification.............................................................................. 227
Introduction........................................................................................................... 228
Using EDA Formal Verification Tools..................................................................... 229
Specifying Additional Settings............................................................................... 231

Chapter 15: System-Level Design.......................................................................... 233
Introduction........................................................................................................... 234
Creating SOPC Designs with SOPC Builder........................................................... 236
Creating the System............................................................................................... 236
Generating the System......................................................................................... 237
Creating DSP Designs with the DSP Builder........................................................... 238
Instantiating Functions......................................................................................... 239
Generating Simulation Files................................................................................... 239
### Generating Files for Synthesis

Generating Files for Synthesis................................................................. 239

### Chapter 16: Installation, Licensing & Technical Support

- Installing the Quartus II Software......................................................... 242
- Licensing the Quartus II Software ....................................................... 242
- Getting Technical Support................................................................. 245

### Chapter 17: Documentation & Other Resources

- Getting Online Help............................................................................ 248
- Using the Quartus II Online Tutorial.................................................. 249
- Other Quartus II Software Documentation ......................................... 250
- Other Altera Literature .................................................................... 251

Index ........................................................................................................ 253
Preface

The Altera® Quartus® II design software is the most comprehensive environment available for system-on-a-programmable-chip (SOPC) design. This manual is designed for the novice Quartus II software user and provides an overview of the capabilities of the Quartus II software in programmable logic design. It is not, however, intended to be an exhaustive reference manual for the Quartus II software. Instead, it is a guide that explains the features of the software and how these can assist you in FPGA and CPLD design. This manual is organized into a series of specific programmable logic design tasks. Whether you use the Quartus II graphical user interface, other EDA tools, or the Quartus II command-line interface, this manual guides you through the features that are best suited to your design flow.

The first chapter gives an overview of the major graphical user interface, EDA tool, and command-line interface design flows. Each subsequent chapter begins with an introduction to the specific purpose of the chapter, and leads you through an overview of each task flow. It shows how to integrate the Quartus II software with your existing EDA tool and command-line design flows. In addition, the manual refers you to other resources that are available to help you use the Quartus II software, such as Quartus II online Help and the Quartus II online tutorial, application notes, white papers, and other documents and resources that are available on the Altera web site.

Follow this manual through a tour of the Quartus II software to learn how it can help you increase productivity and shorten design cycles, integrate with existing programmable logic design flows, and achieve design, performance, and timing requirements quickly and efficiently.
Documentation Conventions

The *Introduction to Quartus® II* manual uses the following conventions to make it easy for you to find and interpret information.

**Typographic Conventions**

Quartus II documentation uses the typographic conventions shown in the following table:

<table>
<thead>
<tr>
<th>Visual Cue</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold Initial Capitals</strong></td>
<td>Command names; dialog box, page, and tab titles; and button names are shown in bold, with initial capital letters. For example: <em>Find Text</em> command, <em>Save As</em> dialog box, and <em>Start</em> button.</td>
</tr>
<tr>
<td><strong>bold</strong></td>
<td>Directory names, project names, disk drive names, file names, file name extensions, software utility names, software executable names, and options in dialog boxes are shown in bold. Examples: <em>quartus</em> directory, <em>d:</em> drive, <em>license.dat</em> file.</td>
</tr>
<tr>
<td>Initial Capsitals</td>
<td>Keyboard keys, user-editable application window fields, and menu names are shown with initial capital letters. For example: Delete key, the Options menu.</td>
</tr>
<tr>
<td>“Subheading Title”</td>
<td>Subheadings within a manual section are enclosed in quotation marks. In manuals, titles of Help topics are also shown in quotation marks.</td>
</tr>
<tr>
<td><strong>Italic Initial Capitals</strong></td>
<td>Help categories, manual titles, section titles in manuals, and application note and brief names are shown in italics with initial capital letters. For example: <em>FLEXlm End Users Guide</em>.</td>
</tr>
<tr>
<td><strong>italics</strong></td>
<td>Variables are enclosed in angle brackets (&lt; &gt;) and shown in italics. For example: <code>&lt;file name&gt;</code>, <code>&lt;CD-ROM drive&gt;</code>.</td>
</tr>
<tr>
<td>Courier font</td>
<td>Anything that must be typed exactly as it appears is shown in Courier. For example: <code>\quartus\bin\lmutil lhostid</code>.</td>
</tr>
<tr>
<td>←</td>
<td>Enter or return key.</td>
</tr>
<tr>
<td>■</td>
<td>Bullets are used in a list of items when the sequence of the items is not important.</td>
</tr>
<tr>
<td>🧵</td>
<td>The feet show you where to go for more information on a particular topic.</td>
</tr>
<tr>
<td>✓</td>
<td>The checkmark indicates a procedure that consists of one step only.</td>
</tr>
<tr>
<td>🔄</td>
<td>The hand points to information that requires special attention.</td>
</tr>
</tbody>
</table>
Terminology

The following table shows terminology that is used throughout the Introduction to Quartus II manual:

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>“click”</td>
<td>Indicates a quick press and release of the left mouse button. It also indicates that you need to use a mouse or key combination to start an action.</td>
</tr>
<tr>
<td>“double-click”</td>
<td>Indicates two clicks in rapid succession.</td>
</tr>
<tr>
<td>“select”</td>
<td>Indicates that you need to highlight text and/or objects or an option in a dialog box with a key combination or the mouse. A selection does not start an action. For example: Select Chain Description File, and click OK.</td>
</tr>
<tr>
<td>“turn on”/“turn off”</td>
<td>Indicates that you must click a check box to turn a function on or off.</td>
</tr>
</tbody>
</table>
Chapter One
Design Flow

What's in Chapter 1:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>10</td>
</tr>
<tr>
<td>Graphical User Interface Design Flow</td>
<td>11</td>
</tr>
<tr>
<td>EDA Tool Design Flow</td>
<td>18</td>
</tr>
<tr>
<td>Command-Line Design Flow</td>
<td>23</td>
</tr>
<tr>
<td>Design Methodologies &amp; Design Planning</td>
<td>37</td>
</tr>
</tbody>
</table>
Introduction

The Altera® Quartus® II design software provides a complete, multiplatform design environment that easily adapts to your specific design needs. It is a comprehensive environment for system-on-a-programmable-chip (SOPC) design. The Quartus II software includes solutions for all phases of FPGA and CPLD design (Figure 1).

**Figure 1. Quartus II Design Flow**

In addition, the Quartus II software allows you to use the Quartus II graphical user interface, EDA tool interface, or command-line interface for each phase of the design flow. You can use one of these interfaces for the entire flow, or you can use different options at different phases of the design flow. This chapter explains the options that are available for each stage of the design flow. The remaining chapters describe individual stages in more detail.
Graphical User Interface Design Flow

You can use the Quartus II software to perform all stages of the design flow; it is a complete, easy-to-use, stand-alone solution. Figure 2 shows the features that the Quartus II graphical user interface provides for each stage of the design flow.

Figure 2. Quartus II Graphical User Interface Features

<table>
<thead>
<tr>
<th>Design Entry</th>
<th>System-Level Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Editor</td>
<td>SOPC Builder</td>
</tr>
<tr>
<td>Block &amp; Symbol Editor</td>
<td>DSP Builder</td>
</tr>
<tr>
<td>MegaWizard Plug-In Manager</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Constraint Entry</th>
<th>Block-Based Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Editor</td>
<td>LogicLock Window</td>
</tr>
<tr>
<td>Pin Planner</td>
<td>Timing Closure Floorplan</td>
</tr>
<tr>
<td>Settings Dialog Box</td>
<td>VQM Writer</td>
</tr>
<tr>
<td>Timing Closure Floorplan</td>
<td></td>
</tr>
<tr>
<td>Design Partitions Window</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Synthesis</th>
<th>EDA Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis &amp; Synthesis</td>
<td>EDA Netlist Writer</td>
</tr>
<tr>
<td>VHDL, Verilog HDL &amp; AHDL</td>
<td></td>
</tr>
<tr>
<td>Design Assistant</td>
<td></td>
</tr>
<tr>
<td>RTL Viewer</td>
<td></td>
</tr>
<tr>
<td>Technology Map Viewer</td>
<td></td>
</tr>
<tr>
<td>Incremental Synthesis</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Place &amp; Route</th>
<th>Power Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fitter</td>
<td>PowerPlay Power Analyzer Tool</td>
</tr>
<tr>
<td>Assignment Editor</td>
<td></td>
</tr>
<tr>
<td>Timing Closure Floorplan</td>
<td>PowerPlay Early Power Estimator</td>
</tr>
<tr>
<td>Incremental Compilation</td>
<td></td>
</tr>
<tr>
<td>Report Window</td>
<td></td>
</tr>
<tr>
<td>Resource Optimization Advisor</td>
<td></td>
</tr>
<tr>
<td>Design Space Explorer</td>
<td></td>
</tr>
<tr>
<td>Chip Editor</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Timing Analysis</th>
<th>Timing Closure</th>
</tr>
</thead>
<tbody>
<tr>
<td>TimeQuest Timing Analyzer</td>
<td>Timing Closure Floorplan</td>
</tr>
<tr>
<td>Classic Timing Analyzer</td>
<td></td>
</tr>
<tr>
<td>Report Window</td>
<td></td>
</tr>
<tr>
<td>Technology Map Viewer</td>
<td></td>
</tr>
<tr>
<td>Chip Editor</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Simulation</th>
<th>Debugging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulator</td>
<td>SignalTap II</td>
</tr>
<tr>
<td>Waveform Editor</td>
<td>SignalProbe</td>
</tr>
<tr>
<td></td>
<td>In-System Memory Content Editor</td>
</tr>
<tr>
<td></td>
<td>RTL Viewer</td>
</tr>
<tr>
<td></td>
<td>Technology Map Viewer</td>
</tr>
<tr>
<td></td>
<td>Chip Editor</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Programming</th>
<th>Engineering Change Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembler</td>
<td>Chip Editor</td>
</tr>
<tr>
<td>Programmer</td>
<td>Resource Property Editor</td>
</tr>
<tr>
<td>Convert Programming Files</td>
<td>Change Manager</td>
</tr>
</tbody>
</table>
Figure 3 shows the Quartus II graphical user interface as it appears when you first start the software.

**Figure 3. Quartus II Graphical User Interface**

The Quartus II software includes a modular Compiler. The Compiler includes the following modules (modules marked with an asterisk are optional during a full compilation, depending on your settings):

- Analysis & Synthesis
- Partition Merge*
- Fitter
- Assembler*
- Classic Timing Analyzer and TimeQuest Timing Analyzer*
- Design Assistant*
- EDA Netlist Writer*
- HardCopy® Netlist Writer*
To run all Compiler modules as part of a full compilation, on the processing menu click **Start Compilation**. You can also run each module individually by clicking the command for the module you want to start from the **Start** submenu of the Processing menu. You can also run some of the Compiler modules incrementally. See “Top-Down Incremental Compilation Flow” on page 39 for more information.

In addition, to start the Compiler modules individually, click **Compiler Tool** on the Tools menu and run each module from the Compiler Tool window (Figure 4). The Compiler Tool window also allows you to open the settings file or report file for the module, or to open other related windows.

*Figure 4. Compiler Tool Window*

The Quartus II software also provides predefined compilation flows that you can use with commands from the Processing menu. Table 1 lists the commands for some of the most common compilation flows.
### Table 1. Commands for Common Compiler Flows

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
<th>Quartus II Command from Processing Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full compilation flow</td>
<td>Performs a full compilation of the current design.</td>
<td>Start Compilation command</td>
</tr>
<tr>
<td>Compilation and simulation flow</td>
<td>If the simulation mode is timing, flow performs a full compilation and then a simulation of the current design. If the simulation mode is functional, the flow runs only the Generate Functional Simulation Netlist command and then simulates the current design.</td>
<td>Start Compilation and Simulation command</td>
</tr>
<tr>
<td>SignalProbe™ flow</td>
<td>Routes user-specified signals to output pins without affecting the existing fitting in a design, so that you can debug signals without completing a full compilation.</td>
<td>Start SignalProbe Compilation command</td>
</tr>
<tr>
<td>Early Timing Estimate</td>
<td>Performs a partial compilation, but stops and generates early timing estimates with the Classic Timing Analyzer before the Fitter is complete.</td>
<td>Start Early Timing Estimate command</td>
</tr>
</tbody>
</table>

You can customize the layout, menus, commands, and icons in the Quartus II software according to your individual preferences. You can choose between the standard Quartus II user interface or the MAX+PLUS® II look and feel when starting the Quartus II software for the first time, or you can choose the look and feel later with the Customize dialog box available from the Tools menu. If you have previously used the MAX+PLUS II software, the MAX+PLUS II look and feel allows you to use the familiar MAX+PLUS II layout, commands, and icons to control functions of the Quartus II software. Figure 5 shows the Customize dialog box.
Figure 5. Customize Dialog Box

The Customize dialog box also allows you to choose whether you want the optional Quartus II or the MAX+PLUS II quick menus to display, and whether you want them on the right or left side of the menu bar. The Quartus II quick menu contains menu commands for each Quartus II application and common processing commands. The MAX+PLUS II quick menu, which is similar to the MAX+PLUS II menu from the MAX+PLUS II software, provides commands for applications and common MAX+PLUS II menu commands. The commands on the MAX+PLUS II menu perform the same functions as the corresponding Quartus II commands. Figure 6 shows the Quartus II and MAX+PLUS II quick menus.
Figure 6. Quartus II and MAX+PLUS II Quick Menus

Quartus II Quick Menu

- New Text File
- New Block Diagram/Schematic File
- New Block Symbol File
- New Memory Initialization File
- New Vector Waveform File
- Project Navigator Alt+H
- Node Finder Alt+I
- Tcl Console Alt+2
- Messages Alt+3
- Status Alt+4
- Change Manager Alt+5
- Assignment Editor Ctrl+Shift+A
- Pin Planner Ctrl+Shift+N
- Timing Closure Floorplan
- LogicLock Regions Window Alt+L
- Design Partitions Window Alt+O
- Compilation Report Ctrl+H
- Simulation Report Ctrl+Shift+H
- Compiler Tool
- Simulator Tool
- Timing Analyzer Tool
- PowerPlay Power Analyzer Tool
- TimeQuest Timing Analyzer
- Resource Optimization Advisor
- Timing Optimization Advisor
- Power Optimization Advisor
- Chip Editor
- RTL Viewer
- Technology Map Viewer
- State Machine Viewer
- SignalTap II Logic Analyzer
- In-System Memory Content Editor
- Logic Analyzer Interface Editor
- Programmer

MAX+PLUS II Quick Menu

- Hierarchy Display
- Graphic Editor
- Symbol Editor
- Text Editor
- Waveform Editor
- Floorplan Editor
- Compiler
- Simulator
- Timing Analyzer
- Programmer
- Message Processor

Quick Start Guide
- File
- Assign
- Options
- Help
### For Information About

<table>
<thead>
<tr>
<th>Using the Quartus II design flow for MAX+PLUS II users</th>
<th>The <em>Quartus II Design Flow for MAX+PLUS II Users</em> chapter in volume 1 of the <em>Quartus II Handbook</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing the user interface</td>
<td>“About Customizing the User Interface” in Quartus II Help</td>
</tr>
<tr>
<td>Using the MAX+PLUS II look and feel</td>
<td>“MAX+PLUS II Quick Start Guide for the Quartus II Software” and “List of MAX+PLUS II Commands” in Quartus II Help</td>
</tr>
</tbody>
</table>

The following steps describe the basic design flow for using the Quartus II graphical user interface:

1. To create a new project and specify a target device or device family, on the File menu, click **New Project Wizard**.

2. Use the Text Editor to create a Verilog HDL, VHDL, or Altera Hardware Description Language (AHDL) design. Use the Block Editor to create a block diagram with symbols that represent other design files, or to create a schematic.

3. Use the MegaWizard® Plug-In Manager to generate custom variations of megafunctions and IP functions to instantiate in your design, or create a system-level design by using SOPC Builder or DSP Builder.

4. Specify any initial design constraints using the Assignment Editor, the Pin Planner, the **Settings** dialog box, the Floorplan Editor, or the Design Partitions window.

5. (Optional) Perform an early timing estimate to generate early estimates of timing results before fitting.

6. Synthesize the design with Analysis & Synthesis.

7. (Optional) If your design contains partitions and you are not performing a full compilation, merge the partitions with partition merge.

8. (Optional) Generate a functional simulation netlist for your design and perform a functional simulation with the Simulator.

9. Place and route the design with the Fitter.
10. Perform a power estimation and analysis with the PowerPlay Power Analyzer.

11. Use the Simulator to perform timing simulation for the design. Use the TimeQuest Timing Analyzer or the Classic Timing Analyzer to analyze the timing of your design.

12. (Optional) Use physical synthesis, the Timing Closure floorplan, the LogicLock feature, and the Assignment Editor to correct timing problems.

13. Create programming files for your design with the Assembler and program the device with the Programmer and Altera programming hardware.

14. (Optional) Debug the design with the SignalTap® II Logic Analyzer, an external logic analyzer, the SignalProbe™ feature, or the Chip Editor.

15. (Optional) Manage engineering changes with the Chip Editor, the Resource Property Editor, and the Change Manager.

**EDA Tool Design Flow**

The Quartus II software allows you to use the EDA tools you are familiar with for various stages of the design flow. You can use these tools together with the Quartus II GUI or with the command-line interface. Figure 7 shows the EDA tool design flow.
Table 2 shows the EDA tools that are supported by the Quartus II software, and indicates which EDA tools have NativeLink® support. NativeLink technology facilitates the seamless transfer of information between the Quartus II software and other EDA tools and allows you to run the EDA tool automatically from within the Quartus II software.
### Table 2. EDA Tools Supported by the Quartus II Software (Part 1 of 2)

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported EDA Tools</th>
<th>NativeLink Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Entry &amp; Synthesis</td>
<td>Mentor Graphics Design Architect</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics LeonardoSpectrum</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics Precision RTL Synthesis</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics ViewDraw</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synopsys Design Compiler</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synopsys Design Compiler FPGA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synopsys FPGA Compiler II</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synplicity Synplify</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synplicity Synplify Pro</td>
<td>✓</td>
</tr>
<tr>
<td>Simulation</td>
<td>Cadence NC-Verilog</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Cadence NC-VHDL</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Cadence Verilog-XL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics® ModelSim®</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics ModelSim-Altera</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synopsys VCS MX</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synopsys VCS</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synopsys VSS</td>
<td></td>
</tr>
<tr>
<td>Timing Analysis</td>
<td>Mentor Graphics Tau (through Stamp)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synopsys PrimeTime</td>
<td>✓</td>
</tr>
<tr>
<td>Board-Level Design</td>
<td>Hyperlynx (through Signal Integrity IBIS)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XTK (through Signal Integrity IBIS)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICX (through Signal Integrity IBIS)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SpectraQuest (through Signal Integrity IBIS)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mentor Graphics Symbol Generation (Viewdraw)</td>
<td></td>
</tr>
<tr>
<td>Formal Verification</td>
<td>Cadence Encounter Conformal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Synopsys Formality</td>
<td></td>
</tr>
</tbody>
</table>
Table 2. EDA Tools Supported by the Quartus II Software (Part 2 of 2)

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported EDA Tools</th>
<th>NativeLink Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Synthesis</td>
<td>Magma Design Automation PALACE</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Synplicity Amplify</td>
<td></td>
</tr>
</tbody>
</table>

On the Assignments menu, click Settings to specify which EDA tools you want to use on EDA Tool Settings page of the Settings dialog box (Figure 8.)

Figure 8. EDA Tool Settings Page in the Settings Dialog Box
The individual pages under **EDA Tool Settings** provide additional options for each type of EDA tool.

The following steps describe the basic design flow for using other EDA tools with the Quartus II software. Refer to Table 2 on page 20 for a list of the supported EDA tools.

1. Create a new project and specify a target device or device family.

2. Specify which EDA design entry, synthesis, simulation, timing analysis, board-level verification, formal verification, and physical synthesis tools you are using with the Quartus II software, and specify additional options for those tools.

3. Create a Verilog HDL or VHDL design file by using a standard text editor or use the MegaWizard Plug-In Manager to create custom variations of megafUNCTIONS.

4. Synthesize your design by using one of the Quartus II–supported EDA synthesis tools, and generate an EDIF netlist file (`.edf`) or a Verilog Quartus Mapping File (`.vqm`).

5. (Optional) Perform functional simulation on your design by using one of the Quartus II–supported simulation tools.

6. Compile your design with the Quartus II software. Run the EDA Netlist Writer to generate output files for use with other EDA tools.

7. (Optional) Perform timing analysis and simulation on your design by using one of the Quartus II–supported EDA timing analysis or simulation tools.

8. (Optional) Perform formal verification by using one of the Quartus II-supported EDA formal verification tools to make sure that Quartus post-fit netlist is equivalent to that of the synthesized netlist.

9. (Optional) Perform board-level verification with one of the Quartus II-supported EDA board-level verification tools.

10. (Optional) Perform physical synthesis by using one of the Quartus II-supported EDA physical synthesis tools.

11. Program the device by using the Programmer and Altera hardware.
Command-Line Design Flow

The Quartus II software offers a complete command-line interface solution. It allows you to perform every stage of the design flow by using command-line executables and options. Using the command-line flow allows you to reduce memory requirements; control the Quartus II software with scripts or Tcl commands; and create makefiles (Figure 9).
**Command-Line Executables**

The Quartus II software includes separate executables for each stage of the design flow. Each executable occupies memory only while it is being run. You can use these executables with standard command-line commands and scripts, with Tcl scripts, and in makefile scripts. See Table 3 for a list of all of the available command-line executables.
Stand-Alone Graphical User Interface Executables

The Quartus II software also provides some stand-alone graphical user interface (GUI) executables. The `qmegawiz` executable provides a stand-alone GUI version of the MegaWizard Plug-In Manager, the `quartus_pgmw` executable provides a stand-alone GUI for the Programmer, and the `quartus_stpw` executable provides a stand-alone GUI for the SignalTap II Logic Analyzer.

### Table 3. Command-Line Executables  (Part 1 of 2)

<table>
<thead>
<tr>
<th>Executable Name</th>
<th>Title</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>quartus_map</td>
<td>Analysis &amp; Synthesis</td>
<td>Creates a project if one does not already exist, and then creates the project database, synthesizes your design, and performs technology mapping on the project's design files.</td>
</tr>
<tr>
<td>quartus_fit</td>
<td>Fitter</td>
<td>Places and routes a design. Analysis &amp; Synthesis must be run successfully before running the Fitter.</td>
</tr>
<tr>
<td>quartus_drc</td>
<td>Design Assistant</td>
<td>Checks the reliability of a design based on a set of design rules. Design Assistant is especially useful for checking the reliability of a design before converting the design for HardCopy devices. Either Analysis &amp; Synthesis or the Fitter must be run successfully before running the Design Assistant.</td>
</tr>
<tr>
<td>quartus_sta</td>
<td>TimeQuest Timing Analyzer</td>
<td>Performs ASIC-style timing analysis of the circuit using constraints entered in Synopsys Design Constraint format.</td>
</tr>
<tr>
<td>quartus_tan</td>
<td>Classic Timing Analyzer</td>
<td>Analyzes the speed performance of the circuit using Quartus II style constraints.</td>
</tr>
<tr>
<td>quartus_asm</td>
<td>Assembler</td>
<td>Creates one or more programming files for programming or configuring the target device. The Fitter must be run successfully before running the Assembler.</td>
</tr>
<tr>
<td>quartus_eda</td>
<td>EDA Netlist Writer</td>
<td>Generates netlist files and other output files for use with other EDA tools. Analysis &amp; Synthesis, the Fitter, or the Timing Analyzer must be run successfully before running the EDA Netlist Writer, depending on the options used.</td>
</tr>
</tbody>
</table>
### Table 3. Command-Line Executables  (Part 2 of 2)

<table>
<thead>
<tr>
<th>Executable Name</th>
<th>Title</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>quartus_cdb</td>
<td>Compiler Database Interface (including VQM Writer)</td>
<td>Also imports and exports version-compatible databases and merges partitions. Generates internal netlist files, including VQM Files, for the Quartus II Compiler database so they can be used for back-annotation and for the LogicLock feature, and back-annotates device and resource assignments to preserve the fit for future compilations. Either the Fitter or Analysis &amp; Synthesis must be run successfully before running the Compiler Database Interface.</td>
</tr>
<tr>
<td>quartus_sim</td>
<td>Simulator</td>
<td>Performs functional or timing simulation on your design. Analysis &amp; Synthesis must be run before performing a functional simulation. The Timing Analyzer must be run before performing a timing simulation.</td>
</tr>
<tr>
<td>quartus_pow</td>
<td>Power Analyzer</td>
<td>Analyzes and estimates total dynamic and static power consumed by a design. Computes toggle rates and static probabilities for output signals. The Fitter must be run successfully before running the PowerPlay Power Analyzer.</td>
</tr>
<tr>
<td>quartus_pgm</td>
<td>Programmer</td>
<td>Programs Altera devices.</td>
</tr>
<tr>
<td>quartus_cpf</td>
<td>Convert Programming Files</td>
<td>Converts programming files to secondary programming file formats.</td>
</tr>
<tr>
<td>quartus_stp</td>
<td>SignalTap II Logic Analyzer</td>
<td>Sets up your SignalTap II File (.stp). When it is run after the Assembler, the SignalTap II Logic Analyzer captures signals from internal device nodes while the device is running at speed.</td>
</tr>
<tr>
<td>quartus_sh</td>
<td>Tcl Shell</td>
<td>Provides a Tcl scripting shell for the Quartus II software.</td>
</tr>
</tbody>
</table>
You can run each executable individually, but you can also run all the Compiler executables at once by using the following command:

```
quartus_sh --flow compile <project name> [-c <revision name>]
```

This command will run the `quartus_map`, `quartus_fit`, `quartus_asm`, and `quartus_tan` executables as parts of a full compilation. Depending on your settings, it may also run the optional `quartus_drc`, `quartus_edb`, `quartus_cdb`, and `quartus_sta` executables.

### The quartus_cmd Executable

If you have used the `quartus_cmd` executable to perform project compilation in previous versions of the Quartus II software, this executable is still supported for backward compatibility; however, Altera recommends that for all new designs, you do not use the `quartus_cmd` executable, but use the executables that are listed in Table 3 on page 25. If you are used to using the `quartus_cmd` executable to compile a design, you can get the same functionality by using the `quartus_sh` executable with the `--flow compile` option.

Some of the executables create a separate text-based report file that you can view with any text editor. The name of each report file uses the following format:

```
<revision name>.<abbreviated executable name>.rpt
```

For example, if you want to run the `quartus_map` executable for the `chiptrip` project, you could type the following command at the command prompt:

```
quartus_sh --flow compile chiptrip [-c revision]
```
quartus_map chiptrip

The `quartus_map` executable analyzes and synthesizes the design and produces a report file with the name `chiptrip.map.rpt`.

**Using Quartus II Settings Files with Quartus II Executables**

When you are using the Quartus II executables, the Quartus II software uses the revision that has the same name as the project name, by default. If you want to use a revision with a name that is different from the project name, you can use the `-c` option to specify the name of the revision and its associated Quartus II Settings File (.qsf). For example, if you want to run the `quartus_map` executable for the `chiptrip` project with a revision named `speed_ch` and its associated `speed_ch.qsf` file, you could type the following command at the command prompt:

`quartus_map chiptrip -c speed_ch`

The `quartus_map` executable performs analysis and synthesis using that revision and settings, and produces a report file with the name `speed_ch.map.rpt`.

The Quartus II software also offers several predefined compilation flows that use the Quartus II executables. You can use these commands with the `quartus_sh --flow` command, or with the Tcl `execute_flow` command. Table 4 shows some of the most common Compiler flows.

**Table 4. Command-Line Compiler Flows (Part 1 of 2)**

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
<th>Command-Line Option for quartus_sh --flow or execute_flow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full compilation flow</td>
<td>Performs a full compilation of the current design.</td>
<td><code>compile</code></td>
</tr>
<tr>
<td>Compilation and simulation flow</td>
<td>If the simulation mode is timing, performs a full compilation and then a simulation of the current design. If the simulation mode is functional, generates a functional simulation netlist and then performs a simulation of the current design.</td>
<td><code>compile_and_simulate</code></td>
</tr>
</tbody>
</table>
### Table 4. Command-Line Compiler Flows  (Part 2 of 2)

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
<th>Command-Line Option for quartus_sh --flow or execute_flow</th>
</tr>
</thead>
<tbody>
<tr>
<td>SignalProbe flow</td>
<td>Routes user-specified signals to output pins without affecting the existing fitting in a design, so that you can debug signals without completing a full compilation.</td>
<td>signalprobe</td>
</tr>
<tr>
<td>Early Timing Estimate</td>
<td>Performs a partial compilation, but stops and generates early timing estimates with the Classic Timing Analyzer before the Fitter is complete.</td>
<td>early_timing_estimate</td>
</tr>
</tbody>
</table>

### For Information About  Refer To

| Using compilation flows | “About Compilation Flows” in Quartus II Help |

### Using Standard Command-Line Commands & Scripts

You can use the Quartus II executables with any command-line scripting method, such as Perl scripts, batch files, and Tcl scripts. These scripts can be designed to create new projects or to compile existing projects. You can also run the executables from the command prompt or console.

Figure 10 shows an example of a standard command-line script. The example demonstrates how to create a project, perform Analysis & Synthesis, perform place and route, perform timing analysis, and generate programming files for the filtref tutorial design that is included with the Quartus II software. If you have installed the tutorial design, it is in the /altera/qdesigns<version number>/tutorial directory. You should create a new directory and copy all the design files (*.v, *.bsf, *.bdf) from the /altera/qdesigns<version number>/tutorial directory to the new directory, in order to compile the design flow example. You can run the four commands in Figure 10 from a command prompt in the new project directory, or you can store them in a batch file or shell script. These examples assume that the
/Quartus II system directory/win directory (or the
/Quartus II system directory/<platform> directory on UNIX or Linux
workstations, where <platform> can be solaris, linux, or hp_II) is included
in your PATH environment variable.

**Figure 10. Example of a Command-Line Script**

```
quartus_map filtref --family=Stratix
```

*Creates a new Quartus II project targeting the Stratix device family*

```
quartus_fit filtref --part=EP1S10F780C5 --fmax=80MHz --tsu=8ns
```

*Performs fitting for the EP1S10F780C5 device and specifies global timing requirements*

```
quartus_tan filtref
```

*Performs classic timing analysis*

```
quartus_asm filtref
```

*Generates programming files*

**Figure 11** shows an excerpt from a sample command-line script for use on a
UNIX workstation. The script assumes that the Quartus II tutorial project
called *fir_filter* exists in the current directory. The script analyzes every
design file in the *fir_filter* project and reports any files that contain syntax
errors.

**Figure 11. Example of a UNIX Command-Line Shell Script (Part 1 of 2)**

```
#!/bin/sh

FILES_WITH_ERRORS=""

for filename in `ls *.bdf *.v`
```
do
    quartus_map fir_filter --analyze_file=$filename
    if [ $? -ne 0 ]
    then
        FILES_WITH_ERRORS="$FILES_WITH_ERRORS $filename"
    fi
done

if [ -z "$FILES_WITH_ERRORS" ]
then
    echo "All files passed the syntax check"
    exit 0
else
    echo "There were syntax errors in the following file(s)"
    echo $FILES_WITH_ERRORS
    exit 1
fi

---

**Figure 11. Example of a UNIX Command-Line Shell Script (Part 2 of 2)**

---

For Information About

Refer To

Command-Line Scripting  
*Command-Line Scripting* chapter in volume 2 of the *Quartus II Handbook*  
*Quartus II Scripting Reference Manual*
Using Tcl Commands

In the Quartus II software, you can run Tcl commands or create and run Tcl scripts with the Quartus II executables to do perform the following functions in a Quartus II project. The Tcl API functions include the following categories:

- Project & assignment functions
- Device functions
- Advanced device functions
- Flow functions
- Timing functions
- Advanced timing functions
- Simulator functions
- Report functions
- Timing report functions
- Back-annotate functions
- LogicLock functions
- Chip Editor functions
- Miscellaneous functions

There are several ways to use Tcl scripts in the Quartus II software. You can create a Tcl script by using commands from the Quartus II API for Tcl. You should save a Tcl script as a Tcl Script File (.tcl).

On the Edit menu, the Templates command in the Quartus II Text Editor allows you to insert Tcl templates and Quartus II Tcl templates (for Quartus II commands) into a text file to create Tcl scripts. Commands used in the Quartus II Tcl templates use the same syntax as the Tcl API commands.

If you want to use an existing project as a baseline for another project, click Generate Tcl File for Project on the Project menu to generate a Tcl Script File for the project. After editing this generated script to target your new project, run the script to apply all assignments from the previous project to the new project.

You can run Tcl scripts from the system command prompt with the quartus_sh executable, from the Quartus II Tcl Console window, or from the Tcl Scripts dialog box by clicking Tcl Scripts on the Tools menu.
Getting Help On Tcl Commands

The Quartus II software includes a Quartus II Command-Line and Tcl API Help browser, which is a Tcl- and Tk-based GUI that lets you browse the command-line and Tcl API help. To use this help, type the following command at the command prompt:

```
quartus_sh --qhelp
```

You can also view TCL API Help in the Quartus II Help that is available in the graphical user interface. Refer to “About Tcl Scripting” and “API Functions for Tcl” in Quartus II Help for more information.

Figure 12 shows an example of a Tcl script.

**Figure 12. Example of a Tcl Script (Part 1 of 2)**

```tcl
# Since ::quartus::report is not pre-loaded
# by quartus_sh, load this package now
# before using the report Tcl API
load_package report

# Since ::quartus::flow is not pre-loaded
# by quartus_sh, load this package now
# before using the flow Tcl API
# Type "help -pkg flow" to view information
# about the package
load_package flow

#------ Get Actual Fmax data from the Report File ------#
proc get_fmax_from_report {} {
#-----------------------------------------------#
    global project_name

    # Load the project report database
    load_report $project_name

    # Get the actual Fmax
    set actual_fmax [get_timing_analysis_summary_results -clock_setup
                     clock -actual]

    # Now unload the project report database
    unload_report

    return $actual_fmax
}
```
#------ Set the project name to chiptrip ------#
set project_name chiptrip

#------ Create or open project ------#
if {project_exists $project_name} {

#------ Project already exists -- open project ------#
    project_open $project_name
} else {

#------ Project does not exist -- create new project ------#
    project_new $project_name
}

#------ Fmax requirement: 155.55MHz ------#
set required_fmax 155.55MHz

#------ Make a clock assignment with the Fmax requirement ------#
create_base_clock clock -fmax $required_fmax

#------ Make global assignments ------#
set_global_assignment -name family STRATIX
set_global_assignment -name device EP1S10F484C5
set_global_assignment -name tsu_requirement 7.55ns

#------ Make instance assignments ------#
# The following is the same as doing:
# "set_instance_assignment -name location -to clock Pin_M20"
set_location_assignment -to clock Pin_M20

#------ Compile using ::quartus::flow ------#
execute_flow -compile

#------ Report Fmax from report ------#
set actual_fmax [get_fmax_from_report]
puts ""
puts "-----------------------------------------------------"
puts "Required Fmax: $required_fmax Actual Fmax: $actual_fmax"
puts "-----------------------------------------------------"
Creating Makefile Scripts

The Quartus II software supports makefile scripts that use the Quartus II executables, which allow you to integrate your scripts with a wide variety of scripting languages. Figure 13 shows an excerpt from a standard makefile script.

Figure 13. Excerpt from Makefile Script (Part 1 of 3)

```
# Project Configuration:

PROJECT = chiptrip
SOURCE_FILES = auto_max.v chiptrip.v speed_ch.v tick_cnt.v time_cnt.v
ASSIGNMENT_FILES = chiptrip.qpf chiptrip.qsf

# Main Targets

all: smart.log $(PROJECT).asm.rpt $(PROJECT).tan.rpt

clean:
```
Figure 13. Excerpt from Makefile Script (Part 2 of 3)

map: smart.log $(PROJECT).map.rpt
fit: smart.log $(PROJECT).fit.rpt
asm: smart.log $(PROJECT).asm.rpt
tan: smart.log $(PROJECT).tan.rpt
smart: smart.log

# Executable Configuration
MAP_ARGS = --family=Stratix
FIT_ARGS = --part=EP1S20F484C6
ASM_ARGS =
TAN_ARGS =

# Target implementations
STAMP = echo done >

$(PROJECT).map.rpt: map.chg $(SOURCE_FILES)
quartus_map $(MAP_ARGS) $(PROJECT)
$(STAMP) fit.chg

$(PROJECT).fit.rpt: fit.chg $(PROJECT).map.rpt
quartus_fit $(FIT_ARGS) $(PROJECT)
$(STAMP) asm.chg
$(STAMP) tan.chg

$(PROJECT).asm.rpt: asm.chg $(PROJECT).fit.rpt
quartus_asm $(ASM_ARGS) $(PROJECT)

$(PROJECT).tan.rpt: tan.chg $(PROJECT).fit.rpt
quartus_tan $(TAN_ARGS) $(PROJECT)

smart.log: $(ASSIGNMENT_FILES)
quartus_sh --determine_smart_action $(PROJECT) > smart.log

# Project initialization
$(ASSIGNMENT_FILES):
quartus_sh --prepare $(PROJECT)
When you are creating a new design, it is important to consider the design methodologies the Quartus II software offers, including top-down or bottom-up incremental compilation design flows, and block-based design flows. You can use these design flows with or without EDA design entry and synthesis tools.
Top-Down versus Bottom-Up Design Methodologies

The Quartus II software supports both top-down and bottom-up compilation flows. With top-down compilation, one designer or project lead compiles the entire design in the software. Different designers or IP providers can design and verify different parts of the design, and the project lead can add design entities to the project as they are completed. However, the project lead compiles and optimizes the top-level project as a whole. Completed parts of the design can have fitting results and performance fixed as other parts of the design are changing.

Bottom-up design flows allow individual designers to complete the optimization of their design in separate projects and then integrate each lower-level project into one top-level project. Incremental compilation provides export and import features to enable this design methodology.

As a designer of lower-level blocks, you can export the optimized netlist for their design, along with a set of assignments, such as LogicLock regions. Then the project lead imports each design block as a design partition in a top-level project. In this case, the project lead must provide guidance to designers of lower-level blocks to ensure that each partition uses the appropriate device resources.

It is important to realize that with the full incremental compilation flow, if you have traditionally relied on a bottom-up approach for the sole reason of performance preservation you can now employ a top-down approach to achieve the same goal. This ability is important for two reasons. First, a top-down flow is generally simpler to perform than its bottom-up counterpart. For example, the need to import and export lower-level designs is eliminated. Second, a top-down approach provides the design software with information about the entire design so it can perform global optimizations. In a bottom-up design methodology, you must perform resource balancing and time-budgeting because the software does not have any information about the other partitions in the top-level design when it compiles individual lower-level partitions.
**Top-Down Incremental Compilation Flow**

Incremental compilation allows you to preserve design performance and save compilation time by reusing previous compilation results and ensuring that only the parts of the design that have been modified are recompiled. The top-down incremental compilation flow can help you to improve timing by allowing you to change the placement of only the critical elements of the design while processing the other design partitions, or allowing you to specify the placement only for designated portions of the design so that the Compiler can automatically optimize the rest of the design.

In the incremental compilation flow, you assign an instance of a design entity to a design partition. You then assign the partitions to a physical location on the device by using the Timing Closure floorplan and the LogicLock feature, and perform a full compilation of the design. During compilation, the Compiler saves synthesis and fitting results in the project database. After the first compilation, if you make additional changes to the design, only the partitions that have changed require recompilation.

When you are finished making design changes you can perform only incremental synthesis, which can reduce compilation time, or a full incremental compilation, which can preserve performance in addition to significantly reducing compilation time. In either case, the Quartus II software merges all partitions together for the chosen task.

Because incremental compilation prevents the Compiler from optimizing across design partition boundaries, the Compiler may not be able to perform as many optimizations for area and timing as would be possible with regular compilation. To obtain best results for area and timing, register the inputs and outputs of design partitions, try to keep the number of design partitions to a reasonable amount, avoid having too many critical paths that go beyond partition boundaries, and avoid having partitions that are too small, such as smaller than 1000 logic elements or Adaptive Logic Modules (ALMs).

For more information on assigning partitions and other stages of the incremental compilation flow, see the following sections:

- “Assigning Design Partitions” on page 70 in Chapter 3, “Constraint Entry.”
- “Performing Incremental Synthesis” on page 94 in Chapter 4, “Synthesis.”
- “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”
“Using LogicLock Regions in Top-Down Incremental Compilation Flows” on page 126 in Chapter 6, “Block-Based Design.”

“Using Incremental Compilation to Achieve Timing Closure” on page 178 in Chapter 9, “Timing Closure.”

“Using the SignalTap II Logic Analyzer with Incremental Compilation” on page 207 in Chapter 12, “Debugging.”

**Bottom-Up Incremental Compilation Flow**

In the bottom-up incremental compilation design flow, you can design and optimize each module independently, integrate all optimized modules in a top-level design, and then verify the overall design. Each module has a separate netlist, which can then be incorporated after synthesis and optimization into the top-level design. Each module in the top-level design does not affect the performance of the other modules. The general block-based design flow concepts can be used in modular, hierarchical, incremental, and team-based design flows.

You can use EDA design entry and synthesis tools in the block-based design flow to design and synthesize individual modules, and then incorporate the modules into a top-level design in the Quartus II software, or completely design and synthesize a block-based design in EDA design entry and synthesis tools. For more information on the block-based design flow, refer to “Chapter 6: Block-Based Design” on page 120.
<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Quartus II incremental compilation and incremental synthesis</td>
<td>Quartus II Incremental Compilation chapter in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>“About Incremental Compilation” and “About Incremental Synthesis” in Quartus II Help</td>
</tr>
</tbody>
</table>
Chapter Two
Design Entry

What's in Chapter 2:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>43</td>
</tr>
<tr>
<td>Creating a Project</td>
<td>44</td>
</tr>
<tr>
<td>Creating a Design</td>
<td>52</td>
</tr>
<tr>
<td>Using Altera Megafunctions</td>
<td>56</td>
</tr>
</tbody>
</table>
Introduction

A Quartus® II project includes all of the design files, software source files, and other related files necessary for the eventual realization of a design in a programmable logic device. You can use the Quartus II Block Editor, Text Editor, MegaWizard® Plug-In Manager, and EDA design entry tools to create designs that include Altera® megafuctions, library of parameterized modules (LPM) functions, and intellectual property (IP) functions. Figure 1 shows the design entry flow.

**Figure 1. Design Entry Flow**

The Quartus II software also supports system-level design entry flows with the Altera SOPC Builder and DSP Builder software. For more information about these methods, refer to “Chapter 15: System-Level Design” on page 233.
Creating a Project

You can create a new project by clicking New Project Wizard on the File menu or running the `quartus_map` executable. When creating a new project, you specify the working directory for the project, assign the project name, and designate the name of the top-level design entity. You can also specify which design files, other source files, user libraries, and EDA tools you want to use in the project, as well as the target device. Table 1 lists the project and settings files for a Quartus II project.

Table 1. Quartus II Project Files

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quartus II Project File (.qpf)</td>
<td>Specifies the version of the Quartus II software used to create the project and the revisions associated with the project.</td>
</tr>
<tr>
<td>Quartus II Settings File (.qsf)</td>
<td>Contains all revision-wide or individual assignments you made with the Assignment Editor, Floorplan Editor, Settings dialog box, Tcl scripts, or Quartus II executables. There is one QSF for each revision of the project.</td>
</tr>
<tr>
<td>Synopsys Design Constraints File (.sdc)</td>
<td>Contains design constraints and timing assignments in the industry-standard Synopsys Design Constraints format. The constraints in a Synopsys Design Constraints File are described using the Tcl tool command language and follow Tcl syntax rules.</td>
</tr>
<tr>
<td>Quartus II Workspace File (.qws)</td>
<td>Contains user preferences and other information such as the position of the windows, the open files and their positions in the windows.</td>
</tr>
<tr>
<td>Quartus II Default Settings File (.qdf)</td>
<td>Located in the <code>&lt;Quartus II system directory&gt;\win</code> directory and contains all the global default project settings. These settings are overridden by the settings in the QSF.</td>
</tr>
</tbody>
</table>

Once you have created a project, you can add and remove design files and other files from the project on the Files page of the Settings dialog box. During Analysis & Synthesis, the Quartus II software processes the files in the order they appear in the Files page.
You can also copy an entire project to a new directory by clicking **Copy Project** on the Project menu. This command causes the Quartus II software to copy the project design database files, design files, settings files, and report files to a new directory and then open the project in the new directory. If the new directory does not exist, the Quartus II software will create it.

The Project Navigator displays information related to the current revision and provides a graphical representation of the project hierarchy, files, and design units, and shortcuts to various menu commands. You can also customize the information shown in the Project Navigator by right clicking the information and clicking the **Customize Columns** command.

**Figure 2. Project Navigator Window**

The Project Navigator also allows you to assign design partitions. For more information, see “Assigning Design Partitions” on page 70.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating and working with Quartus II projects</td>
<td>“About the Project Navigator,” in Quartus II Help</td>
</tr>
<tr>
<td>Design Entry module in the Quartus II tutorial</td>
<td></td>
</tr>
<tr>
<td>Managing Quartus II projects</td>
<td><em>Quartus II Project Management</em> chapter in volume 2 of the <em>Quartus II Handbook</em></td>
</tr>
</tbody>
</table>
Using Revisions

You can use revisions to specify, save, and use different groups of settings and assignments for the design files in a design. Revisions allow you to compare results using different settings and assignments for the same design files in a design.

When you create a revision, the Quartus II software creates a separate QSF, which contains all the settings and assignments related to that revision, and places it in the top-level directory for the design. You can create a revision for any entity in a design. You can view the top-level entity for the any revision in the Revisions dialog box or the current top-level design entity in the General page of the Settings dialog box (Assignments menu).

The Revisions dialog box (Project menu) allows you to view all the revisions for the current project, create a revision for a specific design entity, delete a revision, or set a particular revision as the current revision for compilation, simulation, or timing analysis. The information in the Revisions dialog box shows the top-level design entity for a particular revision and the family and device selected for the revision. A check mark icon indicates the current revision. With the Create Revision dialog box, you can create a new revision (based on an existing revision), enter a description for the revision, copy the database used to create the revision, and set a revision as the current revision. You can also select which columns appear in the Revisions dialog box (Figure 3).
Creating a revision does not affect the source design files for the project. You can create a revision, set it as the current revision for the design, and then make assignments and settings for the entity. This feature allows you to create different settings and assignments for the same design entity and save those settings as different revisions for comparison. Each revision has a corresponding report file that you can open to view and compare the results of the effects of settings and assignments changes against other revisions. You can also use the Compare Revisions dialog box, which is available from the Revisions dialog box, to compare the results of compilations with different revisions. The Compare Revisions dialog box has a Results tab and an Assignments tab. By default, the comparison shows all revisions for the project, but you can also customize the comparison by selecting which revisions you want to display and adjusting the order. You can also export a Comma-Separated Values File (.csv) from the comparison. Figure 4 shows the Results tab of the Compare Revisions dialog box, which allows you to compare the results of each revision.
### Figure 4. Results Tab of Compare Revisions Dialog Box

![Compare Revisions Dialog Box](image)

<table>
<thead>
<tr>
<th>Analysis &amp; Synthesis</th>
<th>D/current/Quartus Revision 1</th>
<th>D/current/Quartus Revision 2</th>
<th>D/current/Quartus Revision 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 5** shows the Assignments tab of the Compare Revisions dialog box, which allows you to compare the assignment settings for each revision.
Figure 5. Assignments Tab of Compare Revisions Dialog Box

For Information About | Refer To
---|---
Using revisions | Quartus II Project Management chapter in volume 2 of the Quartus II Handbook
Creating and using revisions | “About Revisions” and “About Project Management” in Quartus II Help
Using Version-Compatible Databases

The Quartus II software allows you to export version-compatible database files for use in a later version of the Quartus II software, eliminating the need for a full compilation of the design in the later version of the Quartus II software. You can export a database at any stage in the design flow, after running Analysis & Synthesis or the quartus_map executable.

You can use this feature to create and optimize a design and then preserve the database for timing analysis in a future version of the Quartus II software to ensure that the design still meets the timing requirements with updated timing models.

To export a database for use in a future version of the Quartus II software, you can use the Export Database command on the Project menu to select the directory to export the database. The Quartus II software exports the design database. You can then use the Import Database command on the Project menu in a future version of the Quartus II software to select the project folder, import the design database, and perform timing analysis to verify the timing requirements of the design.

You can also use the quartus_cdb command-line executable to export or import design databases. Version-compatible databases are available in version 4.1 or later versions of the Quartus II software.

Using the quartus_cdb executable

You can import or export version-compatible databases by using the quartus_cdb executable.

To use the quartus_cdb executable to import or export a database, type one of the following commands at a command prompt:

```
quartus_cdb <project> -c <revision> --import_database=<project directory>
quartus_cdb <project> -c <revision> --export_database=<project directory>
```

If you want to get help on the quartus_cdb executable, type one of the following commands at the command prompt:

```
quartus_cdb -h
quartus_cdb --help
quartus_cdb --help=<topic name>
```
Converting MAX+PLUS II Projects

The Convert MAX+PLUS II Project command on the File menu allows you to select an existing MAX+PLUS II project’s Assignment & Configuration File (.acf) or design file and convert it into a new Quartus II project that contains all supported assignments and constraints from the original MAX+PLUS II project. The Convert MAX+PLUS II Project command automatically imports the MAX+PLUS II assignments and constraints, creates new project files, and opens the new Quartus II project. Figure 6 shows the Convert MAX+PLUS II Project dialog box.

Figure 6. Convert MAX+PLUS II Project Dialog Box

For Information About Refer To
Using version-compatible databases Quartus II Project Management chapter in volume 2 of the Quartus II Handbook

“About Project Management” in Quartus II Help

For Information About Refer To
Converting MAX+PLUS II projects Quartus II Design Flow for MAX+PLUS II Users chapter in volume 1 of the Quartus II Handbook
Creating a Design

You can create a design in the Quartus II Block Editor to create an HDL design. You can also create a design in the AHDL, Verilog HDL, or VHDL design languages with the Quartus II Text Editor.

The Quartus II software also supports designs created from EDIF Input Files (.edf) or Verilog Quartus Mapping Files (.vqm) generated by EDA design entry and synthesis tools. You can also create Verilog HDL or VHDL designs in EDA design entry tools, and either generate EDIF Input Files and VQM Files, or use the Verilog HDL or VHDL design files directly in Quartus II projects. For more information on using EDA synthesis tools to generate EDIF Input Files or VQM Files, see “Using Other EDA Synthesis Tools” on page 80 in Chapter 4, “Synthesis.”

You can use the design file types listed in Table 2 to create a design in the Quartus II software or in EDA design entry tools.

Table 2. Supported Design File Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Design File</td>
<td>A schematic design file created with the Quartus II Block Editor.</td>
<td>.bdf</td>
</tr>
<tr>
<td>EDIF Input File</td>
<td>An EDIF version 2 0 0 netlist file, generated by any standard EDIF netlist writer.</td>
<td>.edf, .edif</td>
</tr>
<tr>
<td>Graphic Design File</td>
<td>A schematic design file created with the MAX+PLUS II Graphic Editor.</td>
<td>.gdf</td>
</tr>
<tr>
<td>Text Design File</td>
<td>A design file written in the Altera Hardware Description Language (AHDL).</td>
<td>.tdf</td>
</tr>
<tr>
<td>Verilog Design File</td>
<td>A design file that contains design logic defined with Verilog HDL.</td>
<td>.v, .vlg, .verilog</td>
</tr>
<tr>
<td>VHDL Design File</td>
<td>A design file that contains design logic defined with VHDL.</td>
<td>.vh, .vhd, .vhdl</td>
</tr>
<tr>
<td>Verilog Quartus Mapping File</td>
<td>A Verilog HDL–format netlist file generated by the Synplicity Synplify software or the Quartus II software.</td>
<td>.vqm</td>
</tr>
</tbody>
</table>
Using the Quartus II Block Editor

The Block Editor allows you to enter and edit graphic design information in the form of schematics and block diagrams. The Quartus II Block Editor reads and edits Block Design Files and MAX+PLUS II Graphic Design Files. You can open Graphic Design Files in the Quartus II software and save them as Block Design Files. The Block Editor is similar to the Graphic Editor from the MAX+PLUS II software.

Each Block Design File contains blocks and symbols that represent logic in the design. The Block Editor incorporates the design logic represented by each block diagram, schematic, or symbol into the project.

You can create new design files from blocks in a Block Design File, update the design files when you modify the blocks and the symbols, and generate Block Symbol Files (.bsf), AHDL Include Files (.inc), and HDL files from Block Design Files. You can also analyze the Block Design Files for errors before compilation. The Block Editor also provides a set of tools that help you connect blocks and primitives in a Block Design File, including bus and node connections and signal name mapping.

You can change the Block Editor to display options, such as guidelines and grid spacing, rubberbanding, colors and screen elements, zoom, and different block and primitive properties to suit your preferences.

You can use the following features of the Block Editor to assist in creating a Block Design File in the Quartus II software:

- **Instantiate Altera-provided megafuntions**: The MegaWizard Plug-In Manager on the Tools menu allows you to create or modify design files that contain custom variations of megafuntions. These custom megafuntion variations are based on Altera-provided megafuntions, including LPM functions. Megafuntions are represented by blocks in Block Design Files. See “Using the MegaWizard Plug-In Manager” on page 58.

- **Insert block and primitive symbols**: Block diagrams use rectangular-shaped symbols, called blocks, to represent design entities and the corresponding assigned signals, and are useful in top-down design. Blocks are connected by conduits that represent the flow of the corresponding signals. You can use block diagrams exclusively to represent your design, or you can combine them with schematic elements.
The Quartus II software provides symbols for a variety of logic functions—including primitives, library of parameterized modules (LPM) functions, and other megafunctions—that you can use in the Block Editor.

**Create files from blocks or Block Design Files:** To facilitate hierarchical projects, you can use the **Create/Update** command on the File menu in the Block Editor to create other Block Design Files, AHDL Include Files, Verilog HDL and VHDL design files, and Quartus II Block Symbol Files from blocks within a Block Design File. You can also create Verilog Design Files, VHDL Design Files, and Block Symbol Files from a Block Design File itself.

### Using the Quartus II Text Editor

The Quartus II Text Editor is a flexible tool for entering text-based designs in the AHDL, VHDL, and Verilog HDL languages, and the Tcl scripting language. You can also use the Text Editor to enter, edit, and view other ASCII text files, including those created for or by the Quartus II software.

The Text Editor also allows you to insert a template for any AHDL statement or section, Tcl command, or supported VHDL or Verilog HDL construct into the current file. AHDL, VHDL, and Verilog HDL templates provide an easy way for you to enter HDL syntax, increasing the speed and accuracy of design entry. You can also get context-sensitive help on all AHDL elements, keywords, and statements, as well as on megafunctions and primitives.

### Using the Quartus II Symbol Editor

The Symbol Editor allows you to view and edit predefined symbols that represent macrofunctions, megafunctions, primitives, or design files. Each Symbol Editor file represents one symbol. For each symbol file, you can choose from libraries containing Altera megafunctions and LPM functions. You can customize these Block Symbol Files and then add the symbols to schematics created with the Block Editor. The Symbol Editor reads and edits Block Symbol Files and MAX+PLUS II Symbol Files (.sym) and saves both types of files as Block Symbol Files.
CHAPTER 2: DESIGN ENTRY
CREATING A DESIGN

INTRODUCTION TO QUARTUS II

Using Verilog HDL, VHDL & AHDL

You can use the Quartus II Text Editor or another text editor to create Text Design Files, Verilog Design Files, and VHDL Design Files, and combine them with other types of design files in a hierarchical design.

Verilog Design Files and VHDL Design Files can contain any combination of Quartus II–supported constructs. They can also contain Altera-provided logic functions, including primitives and megafunctions, and user-defined logic functions.

In the Text Editor, you use the Create/Update command on the File menu to create a Block Symbol File from the current Verilog HDL or VHDL design file and then incorporate it into a Block Design File. Similarly, you can create an AHDL Include File that represents a Verilog HDL or VHDL design file and incorporate it into an Text Design File or another Verilog HDL or VHDL design file.

For VHDL designs, you can specify the name of a VHDL library for a design in the Properties dialog box that is available from the Files page of the Settings dialog box on the Assignments menu or from the Files tab of the Project Navigator.

For more information on using the Verilog HDL and VHDL languages in the Quartus II software, see “Using Quartus II Verilog HDL & VHDL Integrated Synthesis” on page 77 in Chapter 4, “Synthesis.”

AHDL is a high-level, modular language that is completely integrated into the Quartus II system. AHDL supports Boolean equation, state machine, conditional, and decode logic. AHDL also allows you to create and use parameterized functions, and includes full support for LPM functions. AHDL is especially well suited for designing complex combinational logic, group operations, state machines, truth tables, and parameterized logic.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Quartus II Block Editor and Symbol Editor</td>
<td>“About Design Entry” in Quartus II Help</td>
</tr>
<tr>
<td>Using the Quartus II Text Editor</td>
<td>“About the Text Editor” in Quartus II Help</td>
</tr>
<tr>
<td>Creating designs in the Quartus II software</td>
<td>Design Entry module in the Quartus II Tutorial</td>
</tr>
</tbody>
</table>
Using Altera Megafunctions

Altera megafunctions are complex or high-level building blocks that can be used together with gate and flipflop primitives in Quartus II design files. The parameterizable megafunctions and LPM functions provided by Altera are optimized for Altera device architectures. You must use megafunctions to access some Altera device-specific features, such as memory, DSP blocks, LVDS drivers, PLLs, and SERDES and DDIO circuitry.

You can use the MegaWizard Plug-In Manager on the Tools menu to create Altera megafunctions, LPM functions, and IP functions for use in designs in the Quartus II software and EDA design entry and synthesis tools. Table 3 shows the types of Altera-provided megafunctions and LPM functions that you can create with the MegaWizard Plug-In Manager.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arithmetic Components</td>
<td>Includes accumulators, adders, multipliers, and LPM arithmetic functions.</td>
</tr>
<tr>
<td>Gates</td>
<td>Includes multiplexers and LPM gate functions.</td>
</tr>
<tr>
<td>I/O Components</td>
<td>Includes Clock Data Recovery (CDR), phase-locked loop (PLL), double data rate (DDR), gigabit transceiver block (GXB), LVDS receiver and transmitter, PLL reconfiguration, and remote update megafunctions.</td>
</tr>
<tr>
<td>Memory Compiler</td>
<td>Includes the FIFO Partitioner, RAM, and ROM megafunctions.</td>
</tr>
<tr>
<td>Storage Components</td>
<td>Memory and shift register megafunctions, and LPM memory functions.</td>
</tr>
</tbody>
</table>

To save valuable design time, Altera recommends using megafunctions instead of coding your own logic. Additionally, these functions can offer more efficient logic synthesis and device implementation. It is easy to scale megafunctions to different sizes by simply setting parameters. Altera also provides AHDL Include Files and VHDL Component Declarations for both Altera-provided megafunctions and LPM functions.
ALTERA CORPORATION

INTRODUCTION TO QUARTUS II

CHAPTER 2: DESIGN ENTRY
USING ALTERA MEGAFUNCTIONS

Using Intellectual Property (IP) Megafunctions

Altera provides several methods for obtaining both Altera Megafuction Partners Program (AMPP™) and MegaCore® megafunctions, functions that are rigorously tested and optimized for the highest performance in Altera device-specific architectures. You can use these parameterized blocks of intellectual property to reduce design and test time. MegaCore and AMPP megafuctions include megafuctions for embedded processors, interfaces and peripherals, digital signal processing (DSP), and communications applications.

Altera provides the following programs, features, and functions to assist you in using IP functions in the Quartus II software and EDA design entry tools:

- **AMPP Program**: The AMPP program offers support to third-party vendors to create and distribute megafuctions for use with the Quartus II software. AMPP partners offer a large selection of off-the-shelf megafuctions that are optimized for Altera devices.

  Evaluation periods for AMPP functions are determined by the individual vendors. You can download and evaluate AMPP functions through the IP MegaStore™ on the Altera web site at www.altera.com/ipmegastore.

- **MegaCore Functions**: MegaCore functions are pre-designed, optimized, and verified design files for complex system-level functions, and are fully parameterizable using the MegaWizard Plug-In Manager and IP Toolbench. IP Toolbench is a toolbar that you can use to quickly and easily view documentation, specify parameters, set up other EDA tools, and generate all the files necessary for integrating a parameterized MegaCore function into your design.

---

| For Information About Using the MegaWizard Plug-In Manager | Refer To “About the MegaWizard Plug-In Manager” in Quartus II Help Design Entry module in the Quartus II Tutorial |

F0X3
For Information About Refer To
Using the MegaWizard Plug-In Manager “About the MegaWizard Plug-In Manager” in Quartus II Help
Design Entry module in the Quartus II Tutorial
You can install MegaCore functions from the MegaCore IP Library CD-ROM either during or after installation of the Quartus II software. You can also download individual IP MegaCore functions from the Altera website, via the IP MegaStore, and install them separately. You can also access MegaCore functions though the MegaWizard Portal Extension to the MegaWizard Plug-In Manager.

- **OpenCore Evaluation Feature**: The OpenCore® evaluation feature allows you to evaluate AMPP functions before purchase. You can use the OpenCore feature to compile, simulate, and verify the performance of a design, but it does not support programming file generation.

- **OpenCore Plus Hardware Evaluation Feature**: The free OpenCore Plus hardware evaluation feature allows you to simulate the behavior of a MegaCore function within your system, verify the functionality of the design, and evaluate its size and speed quickly and easily. In addition, the Quartus II software generates time-limited programming files for designs containing MegaCore functions, allowing you to program devices and verify your design in hardware before purchasing a license for the IP megafunction.

When the OpenCore Plus hardware feature is turned on in the Compilation Process page of the Settings dialog box on the Assignments menu, the Quartus II software inserts a small amount of control logic in your design. This logic can have an adverse effect on fitting, especially with small devices. You can turn off the OpenCore Plus hardware evaluation feature to direct the Quartus II software to omit the additional logic.

**Using the MegaWizard Plug-In Manager**

The MegaWizard Plug-In Manager helps you create or modify design files that contain custom megafuction variations, which you can then instantiate in a design file. These custom megafuction variations are based on Altera-provided megafuctions, including LPM, MegaCore, and AMPP functions. The MegaWizard Plug-In Manager runs a wizard that helps you easily specify options for the custom megafuction variations. The wizard allows you to set values for parameters and optional ports. You can open the MegaWizard Plug-In Manager from the Tools menu or from within a Block...
Design File, or you can run it as a stand-alone utility. Table 4 lists the files generated by the MegaWizard Plug-In Manager for each custom megafuntion variation you generate.

**Table 4. Files Generated by the MegaWizard Plug-In Manager**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;output file&gt;.bsf</td>
<td>Symbol for the megafunction used in the Block Editor.</td>
</tr>
<tr>
<td>&lt;output file&gt;.cmp</td>
<td>Component Declaration File.</td>
</tr>
<tr>
<td>&lt;output file&gt;.inc</td>
<td>AHDL Include File for the module in the megafunction wrapper file.</td>
</tr>
<tr>
<td>&lt;output file&gt;.tdf</td>
<td>Megafunction wrapper file for instantiation in an AHDL design.</td>
</tr>
<tr>
<td>&lt;output file&gt;.vhd</td>
<td>Megafunction wrapper file for instantiation in a VHDL design.</td>
</tr>
<tr>
<td>&lt;output file&gt;.v</td>
<td>Megafunction wrapper file for instantiation in a Verilog HDL design.</td>
</tr>
<tr>
<td>&lt;output file&gt;_bb.v</td>
<td>Hollow-body or black box declaration of the module in the megafunction wrapper file used in Verilog HDL designs to specify port directions when using EDA synthesis tools.</td>
</tr>
<tr>
<td>&lt;output file&gt;_inst.tdf</td>
<td>Sample AHDL instantiation of the subdesign in the megafunction wrapper file.</td>
</tr>
<tr>
<td>&lt;output file&gt;_inst.vhd</td>
<td>Sample VHDL instantiation of the entity in the megafunction wrapper file.</td>
</tr>
<tr>
<td>&lt;output file&gt;_inst.v</td>
<td>Sample Verilog HDL instantiation of the module in the megafunction wrapper file.</td>
</tr>
</tbody>
</table>

Using the Stand-Alone MegaWizard Plug-In Manager

You can use the **MegaWizard Plug-In Manager** from outside the Quartus II software by typing the following command at a command prompt:

```
qmegawiz
```
Instantiating Megafunctions in the Quartus II Software

You can instantiate Altera megafunctions and LPM functions in the Quartus II software through direct instantiation in the Block Editor, through instantiation in HDL code (either by instantiating through the port and parameter definition or by using the MegaWizard Plug-In Manager to parameterize the megafunction and create a wrapper file), or through inference.

Altera recommends that you use the MegaWizard Plug-In Manager to instantiate megafunctions and create custom megafunction variations. The wizard provides a graphical interface for customizing and parameterizing megafunctions, and ensures that you set all megafunction parameters correctly.

Instantiation in Verilog HDL & VHDL

You can use the MegaWizard Plug-In Manager to create a megafunction or a custom megafunction variation. The MegaWizard Plug-In Manager then creates a Verilog HDL or VHDL wrapper file that contains an instance of the megafunction, which you can then use in your design. For VHDL megafucntions, the MegaWizard Plug-In Manager also creates a Component Declaration File.

Using the Port & Parameter Definition

You can instantiate the megafunction directly in your Verilog HDL or VHDL design by calling the function like any other module or component. In VHDL, you also must use a Component Declaration.

Inferring Megafunctions

Quartus II Analysis & Synthesis automatically recognizes certain types of HDL code and infers the appropriate megafunction. The Quartus II software uses inference because Altera megafunctions are optimized for Altera devices, and performance may be better than standard HDL code. For some architecture-specific features, such as RAM and DSP blocks, you must use Altera megafunctions.
The Quartus II software maps the following logic to megafunctions during synthesis:

- Counters
- Adders/Subtractors
- Multipliers
- Multiply-accumulators and multiply-adders
- RAM
- Shift registers

**Instantiating Megafunctions in EDA Tools**

You can use Altera-provided megafunctions, LPM functions, and IP functions in EDA design entry and synthesis tools. You can instantiate megafunctions in EDA tools by creating a black box for the function, by inference, or by using the clear box methodology.

**Using the Black Box Methodology**

You can use the MegaWizard Plug-In Manager to generate Verilog HDL or VHDL wrapper files for megafunctions. For Verilog HDL designs, the MegaWizard Plug-In Manager also generates a Verilog Design File that contains a hollow-body declaration of the module, used to specify port directions.

The Verilog HDL or VHDL wrapper file contains the ports and parameters for the megafuction, which you can use to instantiate the megafunction in the top-level design file as well as a sample instantiation file and then direct the EDA tool to treat the megafuction as a black box during synthesis.

The following steps describe the basic flow for using the MegaWizard Plug-In Manager to create a black box for an Altera megafuction or LPM function in EDA design entry and synthesis tools:

1. Use the MegaWizard Plug-In Manager to create and parameterize the megafunction or LPM function.

2. Use the black box file or component declaration (along with the sample instantiation file) generated by the MegaWizard Plug-In Manager to instantiate the function in the EDA synthesis tool.
3. Perform synthesis and optimization of the design in the EDA synthesis tool. The EDA synthesis tool treats the megafuction as a black box during synthesis.

**Instantiation by Inference**

EDA synthesis tools automatically recognize certain types of HDL code and infer the appropriate megafuction. You can directly instantiate memory blocks (RAM and ROM), DSP blocks, shift registers, and some arithmetic components in Verilog HDL or VHDL code. The EDA tool then maps the logic to the appropriate Altera megafuction during synthesis.

**Using the Clear Box Methodology**

In the black box flow, an EDA synthesis tool treats Altera megafunctions and LPM functions as black boxes. As a result, the EDA synthesis tool cannot fully synthesize and optimize designs with Altera megafunctions, because the tool does not have a full model or timing information for the function. Using the clear box flow, you can use the MegaWizard Plug-In Manager to create a fully synthesizeable Altera megafuction or LPM function for use with EDA synthesis tools.

The following steps describe the basic flow for using clear box megafunctions with EDA synthesis tools:

1. Use the MegaWizard Plug-In Manager to create and parameterize the megafuction or LPM function. Make sure you turn on Generate clear box netlist file instead of a default wrapper file (for use with supported EDA syntesis tools only) in the MegaWizard Plug-In Manager.

2. Use the Verilog or VHDL design file generated by the MegaWizard Plug-In Manager to instantiate the function in the EDA synthesis tool.

3. Perform synthesis and optimization of the design in the EDA synthesis tool.

Use of the clear box methodology generally results in slower simulation times in EDA simulation tools (but not the Quartus II Simulator), due to the level of detail (timing information and device resources used) that is included with a clear box megafuction or LPM function. In addition,
specific device details are included in the clear box megafunction or LPM function, so that to use a different device for the design, the clear box function needs to be regenerated for the new device.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of ports and parameters for a megafunction</td>
<td>If you are using an IP function, refer to the IP documentation. For Altera megafunctions, refer to Quartus II Help.</td>
</tr>
<tr>
<td>Using Altera-provided megafunctions and LPM functions in EDA tools</td>
<td>“Overview: Creating &amp; Instantiating Altera-Provided Functions in Other EDA Tools” in Quartus II Help</td>
</tr>
<tr>
<td></td>
<td><em>Synplicity Synplify and Synplify Pro Support</em> chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td></td>
<td><em>Mentor Graphics LeonardoSpectrum Support</em> chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td></td>
<td><em>Mentor Graphics Precision RTL Synthesis Support</em> chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td></td>
<td><em>Synopsys Design Compiler FPGA Support</em> chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td>Using Altera-provided megafunctions and LPM functions in the Quartus II software</td>
<td>Design Entry module in the Quartus II Tutorial</td>
</tr>
<tr>
<td>Using the <strong>MegaWizard Plug-In Manager</strong> and Altera-provided megafunctions and LPM functions</td>
<td>“About the MegaWizard Plug-In Manager” in Quartus II Help</td>
</tr>
<tr>
<td>MegaCore functions and OpenCore Plus hardware evaluation feature</td>
<td><em>Application Note 343 (OpenCore Evaluation of AMPP Megafunctions)</em> on the Altera web site</td>
</tr>
<tr>
<td></td>
<td><em>Application Note 320 (OpenCore Plus Evaluation of Megafunctions)</em> on the Altera web site</td>
</tr>
<tr>
<td></td>
<td><em>Using IP Functional Simulation Models to Verify Your System Design</em> white paper on the Altera web site</td>
</tr>
</tbody>
</table>
Chapter Three

Constraint Entry

What’s in Chapter 3:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>65</td>
</tr>
<tr>
<td>Using the Assignment Editor</td>
<td>66</td>
</tr>
<tr>
<td>Using the Pin Planner</td>
<td>67</td>
</tr>
<tr>
<td>The Settings Dialog Box</td>
<td>69</td>
</tr>
<tr>
<td>Assigning Design Partitions</td>
<td>70</td>
</tr>
<tr>
<td>Importing Assignments</td>
<td>73</td>
</tr>
<tr>
<td>Verifying Pin Assignments</td>
<td>74</td>
</tr>
</tbody>
</table>
Introduction

Once you have created a project and your design, you can use the Assignment Editor, Settings dialog box, TimeQuest analyzer, Pin Planner, Design Partitions window, and Timing Closure floorplan to specify initial design constraints, such as pin assignments, device options, logic options, and timing constraints. You can import assignments by clicking Import Assignments on the Assignments menu and export assignments by clicking Export on the File menu. The Quartus II software also provides the Timing wizard to assist in specifying initial classic timing constraints. You can also import assignments from other EDA synthesis tools using Tcl commands or scripts. Figure 1 shows the constraint and assignment entry flow.

Figure 1. Constraint & Assignment Entry Flow
Using the Assignment Editor

The Assignment Editor is the interface for creating and editing node and entity-level assignments in the Quartus II software. Assignments allow you to specify various options and settings for the logic in your design, including location, I/O standard, timing, logic option, parameter, simulation, and pin assignments. You can enable or disable individual assignments, and you can also add comments to an assignment.

You can use the assignment editor to make classic-format timing assignments. For Synopsys Design Constraints, you must use the TimeQuest timing analyzer.

The following steps illustrate the basic flow for using the Assignment Editor to make assignments:

1. Open the Assignment Editor.
2. Select the appropriate category assignment in the Category bar.
3. Specify the appropriate node or entity in the Node Filter bar, or use the Node Finder dialog box to find a specific node or entity.
4. In the spreadsheet that displays the assignments for the current design, add the appropriate assignment information.

The spreadsheet in the Assignment Editor provides applicable drop-down lists or allows you to type assignment information. As you add, edit, and remove assignments, the corresponding Tcl command appears in the Messages window.

To export the data from the Assignment Editor to a Tcl Script File (.tcl) or a Comma-Separated Value File (.csv) click Export on the File menu. To import assignments data from a Comma-Separated Value File or text file, click Import Assignments on the Assignments menu. For more information about importing assignments, see “Importing Assignments” on page 73.

When creating and editing assignments, the Quartus II software dynamically validates the assignment information where possible. If an assignment or assignment value is illegal, the Quartus II software does not add or update the value, and instead reverts to the current value or does not accept the value. When you view all assignments, the Assignment Editor shows all assignments created for the current project that are valid for the
current device, but when you view individual assignment categories, the Assignment Editor displays only the assignments that are related to the specific category selected.

**Figure 2. The Quartus II Assignment Editor**

The Pin Planner, which is available from the Assignments menu, is a visual tool that allows you to make assignments to pins and groups of pins. It includes a package view of the device with different colors and symbols that represent the different types of pins and additional symbols that represent I/O banks. The symbols used in the Pin Planner are very similar to the symbols used in device family data sheets. It also includes tables of pins and groups. **Figure 3** shows the Pin Planner window.

---

**Using the Pin Planner**

The Pin Planner, which is available from the Assignments menu, is a visual tool that allows you to make assignments to pins and groups of pins. It includes a package view of the device with different colors and symbols that represent the different types of pins and additional symbols that represent I/O banks. The symbols used in the Pin Planner are very similar to the symbols used in device family data sheets. It also includes tables of pins and groups. **Figure 3** shows the Pin Planner window.
By default, the Pin Planner a Group list, an All Pins list, and a package view diagram of the device. You can make pin assignments by dragging pins from the Groups list and All Pins list to available pin or I/O bank locations in the package diagram. In the All Pins list, you can filter the node names, change the I/O standards, and specify options for reserved pins. You can also filter the All Pins list to display only unassigned pins, so you can change the node name and direction for user-added nodes. You can also specify options for reserved pins.

You can also display the properties and available resources for the selected pin, and can display a legend that explains the different colors and symbols that are used in the Pin Planner.

For Information About Refer To

Using the Pin Planner to assign pins I/O Management chapter in Volume 2 of the Quartus II Handbook
The Settings Dialog Box

Click **Settings** on the Assignments menu to use the **Settings** dialog box to specify assignments and options for your project. You can set general project-wide options and synthesis, fitting, simulation, and timing analysis options.

You can perform the following types of tasks in the **Settings** dialog box:

- **Modify project settings**: specify and view the current top-level entity for project and revision information; add and remove files from the project; specify custom user libraries; specify device options for package, pin count, and speed grade; and specify migration devices.

- **Specify EDA tool settings**: specify EDA tools for design entry/synthesis, simulation, timing analysis, board-level verification, formal verification, physical synthesis, and related tool options.

- **Specify Analysis & Synthesis settings**: project-wide settings for Analysis & Synthesis, Verilog HDL and VHDL input settings, default design parameters, and synthesis netlist optimizations options.

- **Specify compilation process settings**: options for smart compilation, preserving node names, running the Assembler during compilation, incremental compilation or incremental synthesis, saving node-level netlists, exporting version-compatible databases, displaying entity names, and enabling or disabling the OpenCore® Plus evaluation feature. Also provides options for generating an early timing estimate.

- **Specify Fitter settings**: timing-driven compilation options, Fitter effort, project-wide Fitter logic options assignments, and physical synthesis netlist optimizations.

- **Specify timing analysis settings for the Classic Timing Analyzer**: default frequencies for the project or define individual clock settings, delay requirements and path-cutting options, and timing analysis reporting options.

- **Specify Simulator settings**: mode (functional or timing), source vector file, simulation period, and simulation detection options.
Specify PowerPlay Power Analyzer settings: input file type, output file type, and default toggle rates, as well as operating conditions such as junction temperature, cooling solution requirements, and device characteristics.

Specify Design Assistant, SignalTap II, and SignalProbe settings: turn on the Design Assistant and select rules; enable the SignalTap® II Logic Analyzer and specify a SignalTap II File (.stp) name; specify options for automatically routing SignalProbe™ and specify signals and modifying fitting results for the SignalProbe feature.

| For Information About Assigning project-wide settings with the Settings dialog box | Refer To “About Working with Assignments in the Assignment Editor” in Quartus II Help |

Assigning Design Partitions

If you want to use the incremental compilation or incremental synthesis features, you can designate separate hierarchical sections of your design as design partitions on which you can perform Analysis & Synthesis or a full compilation incrementally, without affecting the rest of the project. For more information about incremental compilation and incremental synthesis, see the following sections:

- “Performing Incremental Synthesis” on page 94 in Chapter 4, “Synthesis.”
- “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”

You can assign partitions in your design for use with incremental synthesis or full incremental compilation. Both the Project Navigator and the Design Partitions window allow you to assign design partitions.
Assigning Design Partitions in the Project Navigator

To specify a selected instance of an entity as a design partition in the Hierarchy tab of the Project Navigator, right-click the entity and click Set as Design Partition. When you specify the first partition for the project, you are asked whether you want to use incremental synthesis only or full incremental compilation, or whether you want to leave this feature disabled.

To make a LogicLock™ assignment for a partition, drag the partition from the Project Navigator window directly to the LogicLock Regions window or to a LogicLock region in the Timing Closure floorplan.

Assigning Design Partitions with the Design Partitions Window

To specify an entity as a design partition, on the Assignments menu click Design Partitions Window. Figure 4 shows the Design Partitions window.

**Figure 4. Design Partitions Window**

In the Design Partitions window, you can specify which of the following incremental compilation modes to use:

- Incremental Synthesis only
- Full Incremental Compilation
- Off
Right-click the partition and click **Rename** if you want to use a name other than the full hierarchy path name. To generate an incremental compilation Tcl script, right-click the partition and click **Generate Incremental Compilation Tcl Script**.

If your **Incremental Compilation Mode** is **Full Incremental Design**, the Design Partitions window also displays the **Netlist Type** column and allows you to specify one of the following options for **Netlist Type**:

- **Source File** directs the Compiler to compile from source design files  
- **Post-Synthesis** preserves synthesis results for the partition (this is the default option for new partitions)  
- **Post-Fit** preserves placement results for the partition  
- **Empty** skips compilation for the partition

You can specify the netlist type by selecting the type from the list in the **Netlist Type** column or by right-clicking the partition and clicking **Properties**.

If you want to make a LogicLock assignment for a partition, you can drag the partition from the Design Partitions window directly to the LogicLock Regions window or to a LogicLock region in the Timing Closure floorplan.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning design partitions and using incremental compilation</td>
<td>Quartus II Incremental Compilation chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
</tbody>
</table>
Importing Assignments

To import assignments into a project in the Quartus II software, click **Import Assignments** on the Assignments menu.

The **Import Assignments** dialog box allows you to specify the file that contains the assignments to import and the specific types of assignments (Assignment Categories) to import into the QSF for the current project revision. Click **Advanced** in the **Import Assignments** dialog box to specify the nature of the assignments to import, specify global or instance-level assignments to import, and specify how the assignments affect the current design. Use this dialog box to import settings files, Comma Seperated Value Files, and FPGA Xchange Files (.fx), and can create a backup of the current QSF for the design before importing assignments (**Figure 5**).

**Figure 5. Import Assignments Dialog Box**

You can use this command to import a MAX+PLUS II Assignment & Configuration File, which contains MAX+PLUS II project assignments and settings, into your Quartus II project. You can also use this command to import settings and assignments from other projects created in the Quartus II software into your current project. For example, you can use this command to import pin assignments from a previous Quartus II project into the current Quartus II project.

For more information on using the **Import Assignments** command to import LogicLock region assignments, refer to “Exporting & Importing Partitions for Bottom-Up Design Flows” on page 127 in Chapter 6, “Block-Based Design.”
Verifying Pin Assignments

To verify pin location, I/O bank, and I/O standard assignments, on the Processing menu point to **Start**, and then click **Start I/O Assignment Analysis**. You can use this command at any stage of the design process to verify the accuracy of the assignments, allowing you to create your final pin-out faster. You do not need design files to use this command, and can verify pin-outs before design compilation.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing Assignments</td>
<td>“Importing and Exporting Assignments” in Quartus II Help</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing Assignments</td>
<td>I/O Management chapter in Volume 2 of the Quartus II Handbook</td>
</tr>
</tbody>
</table>
What's in Chapter 4:

- Introduction 76
- Using Quartus II Verilog HDL & VHDL Integrated Synthesis 77
- Using Other EDA Synthesis Tools 80
- Controlling Analysis & Synthesis 83
- Using the Design Assistant to Check Design Reliability 87
- Analyzing Synthesis Results with the RTL Viewer 89
- Analyzing Synthesis Results with the Technology Map Viewer 92
- Performing Incremental Synthesis 94
Introduction

You can use the Analysis & Synthesis module of the Compiler to analyze your design files and create the project database. Analysis & Synthesis uses Quartus II Integrated Synthesis to synthesize your Verilog Design Files (.v) or VHDL Design Files (.vhd). If you prefer, you can use other EDA synthesis tools to synthesize your Verilog HDL or VHDL design files, and then generate an EDIF netlist file (.edf) or a Verilog Quartus Mapping File (.vqm) that can be used with the Quartus II software. Figure 1 shows the synthesis design flow.

Figure 1. Synthesis Design Flow

You can start a full compilation in the Quartus II software, which includes the Analysis & Synthesis module, or you can start Analysis & Synthesis separately. The Quartus II software also allows you to perform an Analysis & Elaboration to check a design for syntax and semantic errors without performing a complete Analysis & Synthesis. You can also use the Analyze Current File command on the Processing menu to check a single design file for syntax errors.

For more information about starting a full compilation or starting Compiler modules individually, refer to “Graphical User Interface Design Flow” on page 11 and “Command-Line Design Flow” on page 23 in Chapter 1, “Design Flow.”
Using the quartus_map executable

You can also run Analysis & Synthesis separately at the command prompt or in a script that contains the `quartus_map` executable. The `quartus_map` executable creates a new project if one does not already exist.

The `quartus_map` executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the `quartus_map` executable, type one of the following commands at the command prompt:

```
quartus_map -h
quartus_map --help
quartus_map --help=<topic name>
```

Using Quartus II Verilog HDL & VHDL Integrated Synthesis

You can use Analysis & Synthesis to analyze and synthesize Verilog HDL and VHDL designs. Analysis & Synthesis includes Quartus II Integrated Synthesis, which fully supports the Verilog HDL and VHDL languages and provides options to control the synthesis process.

Analysis & Synthesis supports the Verilog-1995 (IEEE Std. 1364-1995) and Verilog-2001 (IEEE Std. 1364-2001) standards, a subset of features of the SystemVerilog-2005 (IEEE Std. 1800-2005) standard, and also supports the VHDL 1987 (IEEE Std. 1076-1987) and 1993 (IEEE Std. 1076-1993) standards. You can select which standard to use; Analysis & Synthesis uses Verilog-2001 and VHDL 1993 by default. If you are using another EDA synthesis tool, you can also specify a Library Mapping File (.lmf) that the Quartus II software should use to map non–Quartus II functions to Quartus II functions. You can specify these and other options in the Verilog HDL Input and VHDL Input pages, which are under Analysis & Synthesis Settings in the Settings dialog box (Assignments menu). These pages are shown in Figure 2.
Most Verilog HDL and VHDL designs will compile successfully with both Quartus II Integrated Synthesis and in other EDA synthesis tools. If your design instantiates Altera megafunctions, library of parameterized modules (LPM) functions, or intellectual property (IP) megafunctions in a third-party EDA tool, you need to use a hollow-body or black box file. When you are
Chapter 4: Synthesis
Using Quartus II Verilog HDL & VHDL Integrated Synthesis

instantiating megafunctions for Quartus II Integrated Synthesis, however, you can instantiate the megafunction directly without using a black box file. For more information about instantiating megafunctions, refer to “Instantiating Megafunctions in the Quartus II Software” on page 60 and “Instantiating Megafunctions in EDA Tools” on page 61 in Chapter 2, “Design Entry.”

Add the design files when creating a project with the New Project Wizard, or in the Files page of the Settings dialog box, or, if you create the files in the Quartus II Text Editor, you are prompted to add the file to the current project when you save it. When you add files to the project, you should make sure you add them in the order you want Integrated Synthesis to process them. In addition, if your design is coded in VHDL, specify the VHDL library for the design in the Properties dialog box that is available from the Files page. If you do not specify a VHDL library, Analysis & Synthesis will compile VHDL entities into the work library. For more information about adding files to a project, refer to “Creating a Design” on page 52 in Chapter 2, “Design Entry.”

Analysis & Synthesis builds a single project database that integrates all the design files in a design entity or project hierarchy. The Quartus II software uses this database for the remainder of project processing. Other Compiler modules update the database until it contains the fully optimized project. In the beginning, the database contains only the original netlists; at the end, it contains a fully optimized, fitted project, which is used to create one or more files for timing simulation, timing analysis, and device programming.

As it creates the database, the Analysis stage of Analysis & Synthesis examines the logical completeness and consistency of the project, and checks for boundary connectivity and syntax errors. Analysis & Synthesis also synthesizes and performs technology mapping on the logic in the design entity or project’s files. It infers flipflops, latches, and state machines from Verilog HDL and VHDL. It creates state assignments for state machines and makes choices that will minimize the number of resources used. In addition, it replaces operators such as + or - with modules from the Altera library of parameterized modules (LPM) functions, which are optimized for Altera devices.

Analysis & Synthesis uses several algorithms to minimize gate count, remove redundant logic, and utilize the device architecture as efficiently as possible. You can customize synthesis by using logic option assignments. Analysis & Synthesis also applies logic synthesis techniques to help implement timing requirements for a project and optimize the design to meet these requirements.
The Messages window and the Messages section of the Report window display any messages Analysis & Synthesis generates. The Status window displays the time spent processing in Analysis & Synthesis during project compilation.

### Using Other EDA Synthesis Tools

You can use other EDA synthesis tools to synthesize your Verilog HDL or VHDL designs, and then generate EDIF netlist files or VQM Files that can be used with the Quartus II software.

Altera provides libraries for use with many EDA synthesis tools. Altera also provides NativeLink® support for many tools. NativeLink technology facilitates the seamless transfer of information between the Quartus II software and other EDA tools and allows you to run EDA tools automatically from within the Quartus II graphical user interface.

If you have created assignments or constraints using other EDA tools, you can use Tcl commands or scripts to import those constraints into the Quartus II software with your design files. Many EDA tools generate an assignment Tcl script automatically. Table 1 lists the Quartus II–supported EDA synthesis software.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verilog HDL constructs supported in the Quartus II software</td>
<td>“Quartus II Verilog HDL Support” in Quartus II Help</td>
</tr>
<tr>
<td>VHDL constructs supported in the Quartus II software</td>
<td>“Quartus II VHDL Support” in Quartus II Help</td>
</tr>
<tr>
<td>Using Quartus II Integrated Synthesis</td>
<td><em>Quartus II Integrated Synthesis</em> chapter in volume 1 of the <em>Quartus II Handbook</em></td>
</tr>
</tbody>
</table>
Table 1. Quartus II–Supported EDA Synthesis Tools

<table>
<thead>
<tr>
<th>Synthesis Tool Name</th>
<th>EDIF Netlist File (.edf)</th>
<th>Verilog Quartus Mapping File (.vqm)</th>
<th>NativeLink Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentor Graphics LeonardoSpectrum</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Mentor Graphics Precision RTL Synthesis</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Synopsys Design Compiler</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synopsys Design Compiler FPGA</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synopsys FPGA Compiler II</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Synplicity Synplify</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Synplicity Synplify Pro</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

In the Design Entry & Synthesis page under EDA Tool Settings in the Settings dialog box, you can specify EDA synthesis tools, and whether an EDA tool that has NativeLink support should be run automatically as part of full compilation. The Design Entry & Synthesis page also allows you to specify other options for EDA synthesis tools (Figure 3).
To run an EDA synthesis tool listed in the **Design Entry & Synthesis** page from within the Quartus II software, on the Processing menu, click **Start**, and then click **Start EDA Synthesis**. Many EDA tools also allow you to run the Quartus II software from within the EDA tool’s graphical user interface. Refer to your EDA tool documentation for more information.
Controlling Analysis & Synthesis

You can use the following options and features to control Quartus II Analysis & Synthesis:

- Compiler directives and attributes
- Quartus II logic options
- Quartus II synthesis netlist optimization options

**Using Compiler Directives and Attributes**

The Quartus II software supports compiler directives, also called pragmas. You can include compiler directives, such as `translate_on` and `translate_off`, in Verilog HDL or VHDL code as comments. Synthesis tools use parse these HDL comments to drive the synthesis process in a particular manner. Other tools, such as simulators, ignore these directives and treat them as comments.
You can also specify attributes, which are sometimes known as pragmas or directives, that drive the synthesis process for a specific design element. Some attributes are also available as Quartus II logic options.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Compiler directives and attributes</td>
<td>“Verilog HDL Language Directives &amp; Attributes” and “VHDL Language Directives &amp; Attributes” in Quartus II Help</td>
</tr>
<tr>
<td>Using Compiler directives and attributes with Quartus II Integrated Synthesis</td>
<td>Quartus II Integrated Synthesis chapter in volume 1 of the Quartus II Handbook</td>
</tr>
</tbody>
</table>

**Using Quartus II Logic Options**

Quartus II logic options allow you to set attributes without editing the source code. You can assign individual Quartus II logic options in the Assignment Editor, and can specify global Analysis & Synthesis logic options for the project in the **Analysis & Synthesis Settings** page of the **Settings** dialog box (Figure 4).
The Quartus II logic options that are available on the Analysis & Synthesis Settings page allow you to specify that the Compiler should optimize for speed or area, or perform a “balanced” optimization, which attempts to achieve the best combination of speed and area. It also provides many other options, such as options that control the logic level for power-up, the removal of duplicate or redundant logic, the replacement of appropriate logic with DSP Blocks, RAM, ROM, open-drain pins, the encoding style for state machines, the number of logic elements required to implement multiplexers, and many other options that affect Analysis & Synthesis.
Using Quartus II Synthesis Netlist Optimization Options

Quartus II synthesis optimization options allow you to set options for optimizing the netlist during synthesis for many of the Altera device families. These optimization options are in addition to the optimization that occurs during a standard compilation, and occur during the Analysis & Synthesis stage of a full compilation. These optimizations make changes to your synthesis netlist that are generally beneficial for area and speed. The Synthesis Netlist Optimizations page under Analysis & Synthesis Settings in the Settings dialog box allows you to specify netlist optimization options, which include the following synthesis optimization options:

- Perform WYSIWYG primitive resynthesis
- Perform gate-level register retiming
- Allow register retiming to trade off Tsu/Tco with Fmax

For more information about synthesis netlist optimization options, refer to “Using Netlist Optimizations to Achieve Timing Closure” on page 173 in Chapter 9, “Timing Closure.”

---

For Information About | Refer To
---|---
Using Quartus II synthesis and netlist optimization options | Netlist Optimizations & Physical Synthesis and Design Optimization for Altera Devices chapters in volume 2 of the Quartus II Handbook
Using the Design Assistant to Check Design Reliability

The Quartus II Design Assistant allows you to check the reliability of your design, based on a set of design rules. The Design Assistant is especially useful for checking the reliability of a design before migrating it for HardCopy™ devices. The Design Assistant page of the Settings dialog box allows you to specify which design reliability guidelines you want to use when checking your design (Figure 5).

Figure 5. Design Assistant Page of Settings Dialog Box
Using the quartus_drc executable

You can also run the Design Assistant separately at the command prompt or in a script by using the `quartus_drc` executable. You must run the Quartus II Fitter executable `quartus_fit` before running the Design Assistant.

The `quartus_drc` executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the `quartus_drc` executable, type one of the following commands at the command prompt:

```
quartus_drc -h
quartus_drc -help
quartus_drc --help=<topic name>
```

You can also improve design optimization by following good synchronous design practices and by following Quartus II coding style guidelines.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Quartus II Design Assistant</td>
<td>“Analyzing Designs with the Design Assistant” and “About the Design Assistant” in Quartus II Help</td>
</tr>
<tr>
<td>Using Quartus II synthesis options, following synchronous design practices, and following coding style guidelines</td>
<td>Design Recommendations for Altera Devices, Recommended HDL Coding Styles and Quartus II Integrated Synthesis chapters in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>“AHDL, VHDL, and Verilog HDL Style Guide” in Quartus II Help</td>
</tr>
</tbody>
</table>
Analyzing Synthesis Results With the RTL Viewer and State Machine Viewer

The Quartus II RTL Viewer and State Machine Viewer provide graphical representations of your design. To run either of these viewers for a Quartus II project, you must first, on the Processing menu, click Start, and then click Start Analysis & Elaboration. You may also perform Analysis & Synthesis or perform a full compilation, because those processes include the Analysis & Elaboration stage of the compilation flow.

The RTL Viewer

To display the RTL Viewer window, on the Tools menu, point to Netlist viewers, and then click RTL Viewer. In addition to the schematic view, the RTL Viewer has a hierarchy list that lists the instances, primitives, pins, and nets for the entire design netlist (Figure 6).

Figure 6. RTL Viewer Window
The RTL viewer displays the Analysis & Elaboration results for Verilog HDL or VHDL designs, and AHDL Text Design Files (.tdf), Block Design Files (.bdf), Graphic Design Files (.gdf). For VQM Files or EDIF netlist files that were generated from other EDA synthesis tools, the RTL Viewer displays the hierarchy for the atom representations of WYSIWYG primitives.

You can select one or more items in the hierarchy list to highlight in the schematic view. The RTL Viewer allows you to adjust the view or focus by zooming in and out to see different levels of detail, searching through the RTL Viewer for a specific name, moving up or down in the hierarchy, or going to the source that feeds the selected net. If you want to adjust the fan-in or fan-out display, you can expand it or collapse it. You can use the tooltips to see node and source information for individual items. You can also select a node in the RTL Viewer and locate it in the design file, the Timing Closure floorplan, Assignment Editor, Chip Editor, Resource Property Editor, or Technology Map Viewer, depending on which locations are available for that node.

If a design is large, the RTL Viewer partitions it into multiple pages for display. The RTL/Technology Map Viewer page of the Options dialog box allows you to specify options that control how much of the design the RTL Viewer displays on each page. You can navigate through pages in the RTL Viewer by clicking the Next Page and Previous Page buttons or by clicking Go To on the Edit menu.

The Filter command allows you to filter the view to show the sources, and destinations of the selected node(s) or net(s). You can also filter the view to show the paths and nodes between two selected nodes. Each filter you choose creates a new filtered page in the RTL Viewer. Navigate through the filtered pages and the original page of the design with the Forward and Back buttons.

**The State Machine Viewer**

The State Machine Viewer allows you to view state machine diagrams for the relevant logic in your design. If your project has a state machine, on the Tools menu, point to Netlist Viewers, and then click State Machine Viewer. You can also display the State Machine Viewer by double-clicking on an instance symbol in the RTL Viewer Window (Figure 7).
The State Machine Viewer includes a schematic view and a transition table (Figure 8).

**Figure 7. State Machine Instance in RTL Viewer Window**

**Figure 8. State Machine Viewer Window**

Double-clicking on a state machine instance symbol in the RTL Viewer opens the State Machine Viewer window.
When you select a cell in transition table, the corresponding state or transition is highlighted in the schematic view. Likewise, when you select a state or transition in the schematic view, the corresponding cell is highlighted in the transition table. The schematic view allows you to zoom in and out, scroll up and down, and highlight fan-in and fan-out. In the transition table, you can copy selected cells or the entire table to any text editor. You can also align and sort data that appears in the table columns.

You can print RTL views, including State Machine views. If you want to export a copy of an RTL view or State Machine view, you can export a copy of the whole image or part of the image in JPEG File Interchange Format File (.jpg) or Bitmap File (.bmp) format. You can also save a copy to the Clipboard to be saved in other graphics or drawing programs as a Graphics Interchange Format File (.gif), JPEG File, or Bitmap File; or to be pasted in a Microsoft Word document file as an Enhanced Metafile (.emf).

If you decide to make changes to your design after viewing it with the RTL Viewer, you should perform Analysis & Elaboration again so you can analyze the updated design in the RTL Viewer.

---

### For Information About

<table>
<thead>
<tr>
<th>Using the Quartus II RTL Viewer</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Analyzing Designs with the Quartus II Netlist Viewers chapter in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>“About the Netlist Viewers” in Quartus II Help</td>
</tr>
</tbody>
</table>

---

### Analyzing Synthesis Results with the Technology Map Viewer

The Quartus II Technology Map Viewer provides a low-level, or atom-level, technology-specific schematic representation of a design. To run the Technology Map Viewer for a Quartus II project, you must first perform Analysis & Synthesis or perform a full compilation. After you have successfully performed Analysis & Synthesis, you can display the Technology Map Viewer window by pointing to Netlist Viewers on the Tools menu, and then clicking Technology Map Viewer. The Technology
Map Viewer includes a schematic view, and also includes a hierarchy list, which lists the instances, primitives, pins, and nets for the entire design netlist (Figure 9).

**Figure 9. Technology Map Viewer Window**

In the Technology Map Viewer, you can select one or more items in the hierarchy list to highlight in the schematic view. The Technology Map Viewer allows you to navigate the view in much the same way as the RTL Viewer; see “Analyzing Synthesis Results With the RTL Viewer and State Machine Viewer” on page 89. The tooltips in the Technology Map Viewer display equation information as well as node and source information.
After performing timing analysis or performing a full compilation that includes timing analysis, you can also use the Technology Map Viewer to view the nodes that make up the timing path, including information about total delay and individual node delay. See “Viewing Timing Delays with the Technology Map Viewer” on page 161 in Chapter 8, “Timing Analysis.”

### Performing Incremental Synthesis

Incremental synthesis is part of the top-down and bottom-up incremental compilation flows. It allows you to specify entities in your design as design partitions on which you can perform Analysis & Synthesis incrementally, without affecting the rest of the project. For more information in the incremental compilation design flow, refer to “Top-Down versus Bottom-Up Design Methodologies” on page 38 in Chapter 1, “Design Flow.”

You can perform an incremental synthesis only, or you can perform a full incremental compilation. For more information about performing a full incremental compilation, refer to “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”

Incremental synthesis ensures that only updated sections of a design are resynthesized when the design is compiled, which reduces synthesis time and run-time memory usage. You can change and resynthesize a section of a design without affecting other sections of a design, which means that node names are maintained for all registered and combinational nodes in unchanged sections. After you have performed Analysis & Synthesis successfully on the project and all of its partitions, the individual partitions must be merged together so that it can be compiled again as a complete project.

Incremental Synthesis may be useful if you want to work on partitions of your design in stages. Incremental Synthesis may not be useful in projects that need to have optimizations across hierarchical boundaries.
The following steps describe the basic flow for setting up a design for incremental synthesis:

1. Perform Analysis & Elaboration.

2. Specify one or more entities of the project as partitions. Refer to “Assigning Design Partitions” on page 70 in Chapter 3, “Constraint Entry.”

3. Make sure **Incremental Synthesis only** is selected for **Incremental compilation** in the **Design Partitions** window or in the **Compiler Process Settings** page of the **Settings** dialog box.

4. Compile the project in one of the following ways:

   ✓ Perform a full compilation on the project. After the initial compilation, if you make additional changes to the project, you should recompile the project. When you recompile the project, the software synthesizes each changed partition separately and then automatically merges the partitions to create a flattened netlist.

   ✓ If you are running Compiler modules individually, perform Analysis & Synthesis to synthesize each partition incrementally. When you are ready to merge the partitions back into the complete project, on the Processing menu point to **Start**, and then click **Start Partition Merge** to create a complete project database before running the Fitter and other Compiler modules.

---

**For Information About**

**Refer To**

Using the Quartus II Incremental Synthesis feature

Quartus II Incremental Compilation and Quartus II Integrated Synthesis chapters in volume 1 of the Quartus II Handbook

“About Incremental Synthesis” in Quartus II Help
Chapter Five
Place & Route

What’s in Chapter 5:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>97</td>
</tr>
<tr>
<td>Performing a Full Incremental Compilation</td>
<td>99</td>
</tr>
<tr>
<td>Analyzing Fitting Results</td>
<td>100</td>
</tr>
<tr>
<td>Optimizing the Fit</td>
<td>107</td>
</tr>
<tr>
<td>Preserving Assignments through Back-Annotation</td>
<td>117</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II Fitter places and routes your design, which is also referred to as “fitting” in the Quartus II software. Using the database that has been created by Analysis & Synthesis, the Fitter matches the logic and timing requirements of the project with the available resources of a device. It assigns each logic function to the best logic cell location for routing and timing, and selects appropriate interconnection paths and pin assignments. Figure 1 shows the place and route design flow.

Figure 1. Place and Route Design Flow

If you have made resource assignments in your design, the Fitter attempts to match those resource assignments with the resources on the device, tries to meet any other constraints you may have set, and then attempts to optimize the remaining logic in the design. If you have not set any constraints on the design, the Fitter automatically optimizes it. If it cannot find a fit, the Fitter terminates compilation and issues an error message.

In the Compilation Process Settings page of the Settings dialog box, you can specify whether you want to use a normal compilation or smart compilation. (On the Assignments menu, click Settings to display the Settings dialog box.) With a “smart” compilation, the Compiler creates a detailed database that can help future compilations run faster, but may consume extra disk space. During a recompilation after a smart compilation, the Compiler evaluates the changes made to the current design since the last compilation and then runs only the Compiler modules that are required to process those changes. If you make any changes to the logic of a design, the Compiler uses all modules during processing. This option is similar to the MAX+PLUS® II Smart Recompile command.
You can start a full compilation in the Quartus II software, which includes the Fitter module, or you can start the Fitter separately. You must run Analysis & Synthesis successfully before starting the Fitter separately. For information about performing a full compilation, refer to “Graphical User Interface Design Flow” on page 11 in Chapter 1, “Design Flow.”

Using the quartus_fit executable

You can also run the Fitter separately at the command prompt or in a script by using the quartus_fit executable. You must run the Analysis & Synthesis executable quartus_map before running the Fitter.

The quartus_fit executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the quartus_fit executable, type one of the following commands at the command prompt:

```
quartus_fit -h
quartus_fit -help
quartus_fit --help=⟨topic name⟩
```

The Status window records the time spent processing in the Fitter during project compilation, as well as the processing time for any other modules you may have been running (Figure 2).

**Figure 2. Status Window**
Performing a Full Incremental Compilation

You can perform a full incremental compilation to preserve design performance and save compilation time by reusing previous compilation results and ensuring that only the parts of the design that have been modified need to be recompiled. Performing a full incremental compilation is part of the top-down incremental compilation flow. For more information, refer to “Top-Down Incremental Compilation Flow” on page 39 in Chapter 1, “Design Flow.”

You can perform an incremental synthesis only, or you can perform a full incremental compilation. For more information about performing only an incremental synthesis, refer to “Performing Incremental Synthesis” on page 94 in Chapter 4, “Synthesis.”

The following steps describe the basic flow for performing a full incremental compilation:

1. Perform Analysis & Elaboration.

2. Specify one or more entities of the project as partitions. Refer to “Assigning Design Partitions” on page 70 in Chapter 3, “Constraint Entry.”

3. Select Full Incremental compilation as the Incremental compilation mode.

4. Set the appropriate Netlist Type for the partitions. To preserve compilation and placement results, set the Netlist Type for the partitions to Post-Fit.

5. Assign each partition to a physical location on the device by using the Timing Closure Floorplan and LogicLock assignments. Refer to “Using LogicLock Regions in Top-Down Incremental Compilation Flows” on page 126 in Chapter 6, “Block-Based Design.”

6. Perform a setup compilation, which is a full compilation of the design.

7. Make changes to the design or design settings, as needed.

8. Compile again. Only the partitions that have changed will be compiled.
Analyzing Fitting Results

The Quartus II software offers several tools to help you analyze the results of compilation and fitting. The Messages window and Report window provide fitting results information. The Timing Closure floorplan and Chip Editor allow you to view fitting results and make adjustments, if necessary. In addition, the Design Assistant helps you check the reliability of a design based on a set of design rules.

Using the Messages Window to View Fitting Results

The Processing tab of the Messages window and the Messages section of the Report window or Report File display the messages generated from the most recent compilation or simulation. Figure 3 shows the Messages window.
In the Messages window, you can right-click a message and click Help to get Help on a particular message.

By default, all message types are displayed in the Processing tab of the Messages window. If you want to filter the messages that appear in the Messages window, you can set options in the Filtering tab under Messages in the Options dialog box that control the display of warning messages, critical warning messages, information messages, and extra information messages. The Colors tab allows you to customize the colors for each type of message. The Messages tab of the Options dialog box allows you to specify options for displaying separate optional tabs that display the the Processing tab’s messages by type: Extra Info, Info, Warning, Critical Warning, and Error. Right-clicking messages in the Messages window also provides commands that allow you to filter messages and display optional message tabs.
Using the Report Window or Report File to View Fitting Results

The Report window contains many sections that can help you analyze the way the Fitter performed place and route for your design. It includes several sections that show resource usage. It also lists error messages that were generated by the Fitter, as well as messages for any other module you were running.

By default, the Report window opens automatically when you run the Fitter or any other compilation or simulation module; however, you can specify that it should not open automatically by turning off Automatically open the Report window before starting a processing task if the appropriate Tool window is not already open in the Processing page of the Options dialog box. Also, if the Compiler Tool window is open, the Report window does not open automatically, but clicking on the Report File icon for each module displays the report for that module. When the Fitter is processing the design, the Report window continuously updates with new information. If you stop the Fitter, the Report window contains only the information created prior to the point at which you stopped the Fitter (Figure 4).
**Figure 4. Fitter Section of the Report Window**

The Quartus II software automatically generates text and HTML versions of the Report window, depending on which options you specify in the **Processing** page of the **Options** dialog box.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Window sections</td>
<td>&quot;List of Compilation and Simulation Reports&quot; in Quartus II Help</td>
</tr>
<tr>
<td>Using the Report Window</td>
<td>&quot;Navigating the Report Window&quot; in Quartus II Help</td>
</tr>
<tr>
<td>Viewing the compilation report</td>
<td>Compilation module of the Quartus II Tutorial</td>
</tr>
</tbody>
</table>
Using the Timing Closure Floorplan to Analyze Results

After you run the Fitter, the Timing Closure Floorplan displays the results of placement and routing. In addition, you can back-annotate the fitting results to preserve the resource assignments made during the last compilation. The editable Timing Closure floorplan allows you to view logic placement made by the Fitter and/or user assignments, make LogicLock™ region assignments, and view routing congestion (Figure 5).
Resource usage in the Timing Closure floorplan is color coded. Different colors represent different resources, such as unassigned and assigned pins and logic cells, unrouted items, MegaLAB™ structures, columns, and row FastTrack® fan-outs. The Timing Closure floorplan also provides different floorplan views that show the pins and interior structure of the device.
To edit assignments in the Timing Closure floorplan, you can click a resource assignment and drag it to a new location. While dragging a resource in the Timing Closure floorplan, you can use rubberbanding to display a visual representation of the number of routing resources affected by the move.

You can view the routing congestion in a design, view routing delay information for paths, and view connection counts to specific nodes. The Timing Closure floorplan also allows you to view the node fan-out and node fan-in for specific structures, or view the paths between specific nodes. If necessary, you can change or delete resource assignments. For more information on using the Timing Closure floorplan, refer to “Using the Timing Closure Floorplan” on page 168 in Chapter 9, “Timing Closure.”

If you want to view more fitting details and make additional fitting adjustments, the Chip Editor reveals additional details about design placement and routing that are not visible in the Timing Closure floorplan, and allows you to make changes by using the Resource Property Editor and Chip Editor. For more information, refer to “Chapter 13: Engineering Change Management” on page 217.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing assignment and routing information in the Timing Closure floorplan</td>
<td>“Working with Assignments in the Timing Closure Floorplan” and “Viewing Routing Information in the Timing Closure Floorplan” in Quartus II Help</td>
</tr>
<tr>
<td>Viewing the fit in the Timing Closure floorplan</td>
<td><em>Timing Closure Floorplan</em> chapter in volume 2 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td></td>
<td>Compile module of the Quartus II Tutorial</td>
</tr>
<tr>
<td>Viewing the fit in the Chip Editor</td>
<td><em>Design Analysis and Engineering Change Management with Chip Editor</em> chapter in volume 3 of the <em>Quartus II Handbook</em></td>
</tr>
</tbody>
</table>
Using the Design Assistant to Check Design Reliability

The Quartus II Design Assistant allows you to check the reliability of your design, based on a set of design rules, to determine whether there are any issues that may affect fitting or design optimization. The Design Assistant page of the Settings dialog box allows you to specify which design reliability guidelines to use when checking your design. For more information, refer to “Using the Design Assistant to Check Design Reliability” on page 87 in Chapter 4, “Synthesis.”

Optimizing the Fit

Once you have run the Fitter and have analyzed the results, you can try several options to optimize the fit:

- Using location assignments
- Setting options that control place and route
- Using the Resource Optimization Advisor
- Using the Design Space Explorer

Using Location Assignments

You can assign logic to physical resources on the device, such as a pin, logic cell, or Logic Array Block (LAB), by using the Timing Closure floorplan or the Assignment Editor in order to control place and route. You may want to use the Timing Closure floorplan to edit assignments because it gives you a graphical view of the device and its features. If you want to create several new location assignments at once, on the Assignments menu click Assignment Editor. In addition to using the Timing Closure floorplan or Assignment Editor to create assignments, you can also use Tcl commands. If you want to specify global assignments for the project, you can use the Settings dialog box. For more information about specifying initial design constraints, refer to “Chapter 3: Constraint Entry” on page 64.

Once you create an assignment, you can edit it in the Assignment Editor or the Timing Closure floorplan. After compilation, you can use the Timing Closure floorplan to edit existing resource assignments to pins, logic cells, rows, columns, regions, MegaLAB structures, and LABs. You can use the
Timing Closure floorplan, the LogicLock Regions window, or the LogicLock Region Properties dialog box to assign nodes or entities to LogicLock regions.

The Timing Closure floorplan provides different views of the device and helps you make precise assignments to specific locations. You can also view equations and routing information, and demote assignments by dragging and dropping assignments to various regions in the Regions window. If your design has too many constraints that prevent it from fitting in the device, you may also be able to optimize fitting by removing some of the location assignments and allowing the Fitter to place the logic.

**Setting Options that Control Place & Route**

You can set several options that control the Fitter and may affect place and route:

- Fitter options
- Fitting optimization and physical synthesis options
- Individual and global logic options that affect fitting

**Setting Fitter Options**

The Fitter Settings page of the Settings dialog box allows you to specify options that control timing-driven compilation and compilation speed. You can specify whether the Fitter should try to use registers in I/O cells (rather than registers in regular logic cells) to meet timing requirements and assignments that relate to I/O pins. You can direct the Fitter to consider only slow-corner timing delays when optimizing the design, or to consider fast-corner timing delays as well as slow-corner timing delays when optimizing the design to meet timing requirements at both corners. You can specify whether you want the Fitter to use standard fitting, which works hardest to meet your $f_{\text{MAX}}$ timing requirements, to use the fast fit feature, which improves the compilation speed but may reduce the $f_{\text{MAX}}$, or to use the auto fit feature, which reduces Fitter effort after meeting timing requirements and may decrease compilation time. The Fitter Settings page also allows to you specify that you want to limit Fitter effort to only one attempt, which may also reduce the $f_{\text{MAX}}$. 
Setting Physical Synthesis Optimization Options

The Quartus II software allows you to set options for performing physical synthesis to optimize the netlist during fitting. You specify physical synthesis optimization options in the Physical Synthesis Optimizations page under Fitter Settings in the Settings dialog box.

Physical synthesis optimization options include the following options:

- Perform physical synthesis for combinational logic
- Physical synthesis for registers:
  - Perform register duplication
  - Perform register retiming
- Physical synthesis effort:
  - Normal (default effort level; average of 2 to 3 compile times)
  - Extra (more compile time than Normal; should improve performance gains)
  - Fast (less compile time than Normal; may reduce performance gains)

For more information about physical synthesis options, refer to “Using Netlist Optimizations to Achieve Timing Closure” on page 173 in Chapter 9, “Timing Closure.”

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Quartus II physical synthesis optimizations</td>
<td>Netlist Optimizations &amp; Physical Synthesis chapter in volume 2 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Using Quartus II Fitter optimization options</td>
<td>“About Synthesis” in Quartus II Help</td>
</tr>
</tbody>
</table>

Setting Individual Logic Options that Affect Fitting

Quartus II logic options allow you to set attributes without editing the source code. You can specify Quartus II logic options for individual nodes and entities in the Assignment Editor and can specify global default logic options in More Fitter Settings dialog box, which is available by clicking More Settings in the Fitter Settings page of the Settings dialog box. For
example, you can use logic options to specify that the signal should be available throughout the device on a global routing path, specify that the Fitter should create parallel expander chains automatically, specify that the Fitter should automatically combine a register with a combinational function in the same logic cell, also known as “register packing,” or limit the length of carry chains, cascade chains, and parallel expander chains.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Quartus II logic options to control place and route</td>
<td>“Logic Options” and “Working with Assignments in the Assignment Editor” in Quartus II Help</td>
</tr>
</tbody>
</table>

### Using the Resource Optimization Advisor

The Resource Optimization Advisor offers recommendations for optimizing your design for resource usage in the following areas:

- logic element usage
- memory block usage
- DSP block usage
- I/O usage
- routing resource usage

If you have an open project, you can view the Resource Optimization Advisor by clicking **Resource Optimization Advisor** on the Tools menu. If the project has not been compiled yet, the Resource Optimization Advisor provides only general recommendations for optimizing resource usage. If the project has been compiled, however, the Resource Optimization Advisor can provide specific recommendations for the project, based on the project information and current settings. Figure 6 shows the Resource Optimization Advisor.
The first page of the Resource Optimization Advisor summarizes the resource usage after compilation, and indicates possible problem areas. The left pane of the Resource Optimization Advisor shows a hierarchical list of problems and recommendations, with icons that indicate whether the recommendation might be appropriate for the current design and target device family, or whether the current design already has the recommended setting. When you click on a recommendation in the hierarchical list, the right pane provides a detailed description of the recommendation, a summary, the current global settings, and one or more recommended actions, as shown in Figure 7.
If the recommended action involves changing a Quartus II setting, the right pane of the Resource Optimization Advisor may include a link to the appropriate dialog box, page, or feature in the Quartus II software or may include a button that provides more information about the design. It may also include links to Quartus II Help or other documentation on the Altera web site.
If you want to print the current recommendation, right-click in the right pane and click **Print Recommendation**; or, if you want to print all recommendations, right-click in the left pane and click **Print All Recommendations**.

If you want to view recommendations for improving timing results, you can use the Timing Optimization Advisor. See “Using the Timing Optimization Advisor” on page 172 in Chapter 9, “Timing Closure.”

**Using the Design Space Explorer**

Another way to control Quartus II fitting is to use the Design Space Explorer (DSE), which can help you optimize your design. The DSE interface allows you to explore a range of Quartus II options and settings automatically to determine which settings should be used to obtain the best possible result for the project. You can start DSE from the command prompt with the **quartus_sh** executable, or you can start it from the Windows Start menu with the **Quartus II <version number> Design Space Explorer** command (for example, the **Quartus II 6.0 Design Space Explorer** command). To start Design Space Explorer from within the Quartus II software interface, on the Tools menu click **Launch Design Space Explorer**.

You can specify the effort level that DSE puts into determining the optimal settings for the current project. The DSE interface also allows you to specify optimization goals and allowable compilation time. **Figure 8** shows the **Settings** tab for the Design Space Explorer.
DSE provides several exploration modes, which are listed under Exploration Settings in the DSE window:

- **Search for Best Area**
- **Search for Best Performance** (allows you to specify an effort level)
- **Advanced Search**

Selecting the **Advanced Search** option enables the **Advanced** tab, which allows you to specify additional options for exploration space, optimization goal, and search method. Figure 9 shows the **Advanced** tab.
After you have specified your exploration settings, you can use the **Explore Space** command on the Processing menu to start the exploration. You can see the results of the exploration on the **Explore** tab. **Figure 10** shows the **Explore** tab. To view the exploration results in a text file form, on the Processing menu, click **View Last DSE Report for Project**.
Figure 10. Explore Tab of Design Space Explorer

Running the Design Space Explorer

You can run DSE in graphical user interface mode by typing the following command at a command prompt:

```
quartus_sh --dse
```

You can run DSE in command-line mode by typing the following command at a command prompt, along with any additional DSE options:

```
quartus_sh --dse -nogui <project name> [-c <revision name>]
```

For help on DSE options, type `quartus_sh --help=dse` at command prompt, or, on the help menu, click Show Documentation.
Many of the Exploration Space modes allow you to specify the degree of effort you want DSE to spend in fitting the design; however, increasing the effort level usually increases the compilation time. Custom exploration mode allows you to specify various parameters, options, and modes and then explore their effects on your design.

The Signature modes allow you to explore the effect of a single parameter on your design and its trade-offs for $f_{\text{MAX}}$, slack, compile time, and area. In the Signature modes, DSE tests the effects of a single parameter over multiple seeds, and then reports the average of the values so you can evaluate how that parameter interacts in the space of your design.

DSE also provides a list of Optimization Goal options, which allow you to specify whether DSE should optimize for area, speed, or for negative slack and failing paths.

In addition, you can specify Search Method options, which provide additional control over how much time and effort DSE should spend on the search.

After you have completed a design exploration with DSE, you can create a new revision from a DSE point. You can then close DSE and open the project with the new revision from within the Quartus II software.

### Preserving Assignments through Back-Annotation

You can preserve resource assignments from the last compilation by back-annotating assignments to any device resource. You can back-annotate all the resource assignments in a project; you can also back-annotate the size and location of LogicLock regions. To specify assignments to back-annotate click Back-Annnotate Assignments on the Assignments menu.
The Back-Annotate Assignments dialog box allows you to select the type of back-annotation: Default type or Advanced type (Figure 11).

**Figure 11. Back-Annotate Assignments Dialog Box**

The Back-Annotate Assignments dialog box (Default type) allows you to “demote” pin and/or logic cell assignments to less restrictive location assignments so that you can allow the Fitter more freedom in rearranging assignments. The Back-Annotate Assignments (Advanced type) dialog box allows you to do everything that the Default back-annotation type allows you to do, as well as back-annotate LogicLock regions, and optionally the nodes and routing within them. The Advanced back-annotation type also
provides many options for filtering based on region, path, resource type, and so on, and allows you to use wildcards. You should use only one type of back-annotation or the other, but not both. If you are not sure which type to use, Altera recommends that you use the Advanced back-annotation type for most situations because it offers more options, especially if you are using LogicLock regions.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back-annotating location assignments</td>
<td>“About Back-Annotations Assignments” in Quartus II Help</td>
</tr>
<tr>
<td>Back-annotating LogicLock region assignments</td>
<td>“Back-Annotations a LogicLock Region” in Quartus II Help</td>
</tr>
<tr>
<td>Back-annotating LogicLock placement</td>
<td>LogicLock module of the Quartus II Tutorial</td>
</tr>
</tbody>
</table>
What’s in Chapter 6:

Introduction 121
Quartus II Block-Based Design Flow 121
Using LogicLock Regions 122
Using LogicLock Regions in Top-Down Incremental Compilation Flows 126
Exporting & Importing Partitions for Bottom-Up Design Flows 127
Introduction

The Quartus® II Incremental Compilation feature and LogicLock™ regions feature enable enables a block-based design flow by allowing you to create modular designs, designing and optimizing each module separately before incorporating it into the top-level design. Incorporating each module into the top-level design does not affect the performance of the lower level modules, as long as each module has registered inputs and outputs.

LogicLock regions are flexible, reusable constraints that increase your ability to guide logic placement on the target device. You can define any arbitrary rectangular region of physical resources on the target device as a LogicLock region. Assigning nodes or entities to a LogicLock region directs the Fitter to place those nodes or entities inside the region during fitting.

LogicLock regions support team-oriented, block-based design by enabling you to optimize logic blocks individually, and then import them and their placement constraints into a larger design. The LogicLock methodology also promotes module reuse, because modules can be developed separately and then constrained to LogicLock regions to be used in other designs with no loss in performance, allowing you to leverage resources and shorten design cycles.

The LogicLock feature also allows you to assign design partitions to physical locations in the device as part of a top-down or bottom-up incremental compilation flow.

Quartus II Block-Based Design Flow

In traditional top-down design flows, there is only one netlist for the design. In a top-down design flow, individual modules of the design can have different performance from the overall design when implemented on their own. In bottom-up block-based design flows, there are separate netlists for each module. This allows designers to create block-based designs, where each module is optimized independently and then incorporated into the top-level design. You can use block-based design in the following flows:
Modular design flow: In the modular design flow, you divide a design into a top-level design that instantiates separate submodules. You can develop each module separately and then incorporate each module into the top-level design. Placement is determined manually by you or by the Quartus II software.

Incremental compilation flow: In the incremental compilation flow, you create and optimize a system, and then add future modules with little or no effect on the performance of the original system.

Team-based design flow: In the team-based design flow, you partition a design into separate modules, and instantiate and connect the modules in a top-level design. Other team members then separately develop the lower-level modules, creating separate projects for each module, and using the assignments developed for the top-level design. Once the lower-level modules are complete, they are imported into the top-level design, which then undergoes final compilation and verification.

In all three design flows, you can preserve performance at all levels of development by partitioning designs into functional blocks, organized according to the physical structure of the circuit or by critical paths.

Using LogicLock Regions

A LogicLock region is defined by its size (height and width) and location on the device. You can specify the size and location of a region, or direct the Quartus II software to create them automatically. Table 1 lists the major properties of LogicLock regions that you can specify in the Quartus II software.
Table 1. LogicLock Region Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Values</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Floating or Locked</td>
<td>Floating regions allow the Quartus II software to determine the region's location on the device. Locked regions have a user-defined location. Locked regions are shown in the floorplan with a solid boundary and floating regions shown by a dashed boundary in the floorplan. A locked region must have a fixed size.</td>
</tr>
<tr>
<td>Size</td>
<td>Auto or Fixed</td>
<td>Auto-sized regions allow the Quartus II software to determine the appropriate size of a region given its contents. Fixed regions have a user-defined shape and size.</td>
</tr>
<tr>
<td>Reserved</td>
<td>On or Off</td>
<td>The reserved property allows you to define whether the Quartus II software can use the resources within a region for entities that are not assigned to the region. If the reserved property is on, only items assigned to the region can be placed within its boundaries.</td>
</tr>
<tr>
<td>Soft</td>
<td>On or Off</td>
<td>Soft regions give more deference to timing requirements, and allow some entities to leave a region if it improves the performance of the overall design. Hard regions do not allow the Quartus II software to place contents outside the boundaries of the region.</td>
</tr>
<tr>
<td>Origin</td>
<td>Any Floorplan Location</td>
<td>The origin defines the placement of the LogicLock region in the floorplan.</td>
</tr>
</tbody>
</table>

With the LogicLock design flow, you can define a hierarchy for a group of regions by declaring parent and child regions. The Quartus II software places child regions completely within the boundaries of a parent region. You can lock a child module relative to its parent region without constraining the parent region to a locked location on the device.

You can create and modify LogicLock regions by using the Timing Closure floorplan, the LogicLock Regions Window command (Assignments menu), the Hierarchy tab of the Project Navigator, or by using Tcl scripts. All LogicLock attributes and constraint information (clock settings, pin assignments, and relative placement information) are stored in the Quartus II Settings File (.qsf) for the project.
You can use the Timing Closure floorplan to create and edit LogicLock region assignments. You can draw LogicLock regions in the Timing Closure floorplan with the Create New Region button and then drag and drop nodes from the floorplan view, the Node Finder, or the Hierarchy tab of the Project Navigator.

After you have created a LogicLock region, you can use the LogicLock Regions window to view all of the LogicLock regions in your design, including size, state, width, height, and origin. You can also edit and add new LogicLock regions. *(Figure 1).*

**Figure 1. LogicLock Regions Window**

You can also use the LogicLock Regions Properties dialog box to edit existing LogicLock regions, open the Back-Annotate Assignments dialog box to back-annotate all nodes in a LogicLock region, view information on the LogicLock regions in the design, and determine which regions contain illegal assignments.

In addition, you can add path-based assignments (based on source and destination nodes), wildcard assignments, and Fitter priority for path-based and wildcard assignments to LogicLock regions. Setting the priority allows you to specify the order in which the Quartus II software resolves conflicting path-based and wildcard assignments. You can open the Priority dialog box from the LogicLock Region Properties dialog box. *(Figure 2).*
After you have performed analysis and elaboration or a full compilation, the Quartus II software displays the hierarchy of the design in the **Hierarchy** tab of the Project Navigator. You can click any of the design entities in this view and create new LogicLock regions from them, or drag them into an existing LogicLock region in the Timing Closure floorplan.

Altera also provides LogicLock Tcl commands to assign LogicLock region content at the command line or in the Quartus II Tcl Console window. You can use the provided Tcl commands to create floating and auto-size LogicLock regions, add a node or a hierarchy to a region, preserve the hierarchy boundary, back-annotate placement results, import and export regions, and save intermediate synthesis results.
Using LogicLock Regions in Top-Down Incremental Compilation Flows

If you are planning to perform a full incremental compilation, it is important to assign design partitions to physical locations on the device. You can assign design partitions to LogicLock regions by dragging a design partition from the Hierarchy tab of the Project Navigator window, the Design Partitions window, or the Node Finder and dropping it directly in the LogicLock Regions window or to a LogicLock region in the Timing Closure floorplan.

Altera recommends that you create one LogicLock region for each partition in your design. The best performance can generally be achieved when these regions are all fixed-size, fixed-location regions. Ideally, you should assign the LogicLock regions manually to specific physical locations in the device by using the Timing Closure floorplan; however, you can also allow the Quartus II software to assign LogicLock regions to physical locations somewhat automatically by setting the LogicLock region Size option to Auto and the State option to Floating. If the partition has many memory or DSP blocks, it is recommended you exclude them from the LogicLock region. After the initial compilation, you should back-annotate the LogicLock region properties (not the nodes) to ensure that all the LogicLock regions have a fixed size and a fixed location. This process will create initial floorplan assignments that can be modified more easily, as needed.
After the initial or setup compilation, Altera recommends that you set the Size to Fixed in order to yield better f\text{MAX} results. If device utilization is low, increasing the size of the LogicLock region may allow the Fitter additional flexibility in placement and may produce better final results.

When you perform an incremental compilation, the fitting and synthesis results and settings for design partitions are saved in the project database.

For more information about assigning design partitions, refer to “Assigning Design Partitions” on page 70 in Chapter 3, “Constraint Entry.” For more information about incremental compilation, refer to “Top-Down Incremental Compilation Flow” on page 39 in Chapter 1, “Design Flow.” and “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”

### Exporting & Importing Partitions for Bottom-Up Design Flows

The bottom-up flow refers to the design methodology in which a project is first divided into smaller sub-designs that are implemented as separate projects, potentially by different designers. The compilation results of these lower-level projects are then exported and given to the designer (or the project lead) who is responsible for importing them into the top-level project to obtain a fully functional design. There are at least two benefits associated with a bottom-up design flow:

- It facilitates team-based development
- It permits the reuse of compilation results from another project, with the ultimate goals of performance preservation and compilation time reduction
Preparing the Top-Level Design for a Bottom-Up Incremental Compilation Methodology

To set up your design for bottom-up incremental compilation, use the following general steps:

1. Create a top-level project. The top-level design file must include the top-level entity that instantiates all the lower-level subdesign that you plan to compile in separate Quartus II projects and import as separate design partitions.

2. In your top-level project, include a wrapper design file for each subdesign partition that defines at least the port interface of the subdesign.

3. Create all global assignments, including the device assignment, pin location assignments, and timing assignments, so that the final design meets its requirements.

4. Set up the top-level design with design partitions, turn on incremental compilation, and create a design floorplan using LogicLock assignments.

Exporting a Partition to be Used in a Top-Level Project

When your subdesign partition is ready to be incorporated into the top-level design, in the subdesign project, on the Project menu, click Export Project as Design Partition. In the Export file box of the Export Project as Design Partition dialog box, type the name of the Quartus II Exported Partition file (.qxp). By default, the directory path and file name are the same as the current project.

Under Netlist to export, select either Post-fit netlist or Post-synthesis netlist. To automatically create a new version of the Quartus II Exported Partition file after each subsequent compilation, turn on Always perform exportation following compilation. Click OK. The Quartus II software creates the Quartus II Exported Partition File in the specified directory.
**Importing a Lower-Level Partition Into the Top-Level Project**

You must import the design netlist from the Quartus II Exported Partition File and add it to the database for the top-level project. Importing also filters the assignments from the subdesign and creates the appropriate assignments in the top-level project.

To import a subdesign partition into a top-level design, in the top-level project, on the Project menu, click **Import Design Partition**. Alternately, right-click on the partition that you want to import in the Design Partitions window and click **Import Design Partition**, this opens the **Import Design Partition** dialog box.

Under Partition(s), click browse to select the desired partition. To browse for a partition, highlight the partition name in the **Select Partition(s)** dialog box and use the appropriate buttons to select or deselect the desired partition(s).

Under Import file, type the name of the Quartus II Exported Partition File or browse for the file that you want to import into the selected partition. In the **Import Design Partition** dialog box, click **OK** to start importation. The specified Quartus II Exported Partition File is imported into the database for the current top-level project.

**For Information About**

<table>
<thead>
<tr>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing and exporting designs as Quartus II Exported Partition Files and back-annotating assignments</td>
</tr>
<tr>
<td>“About Incremental Compilation” and “Using the Team-Based Bottom-Up Design Flow” in Quartus II Help</td>
</tr>
</tbody>
</table>
Introduction

You can perform functional and timing simulation of your design by using EDA simulation tools or the Quartus® II Simulator.

The Quartus II software provides the following features for performing simulation of designs in EDA simulation tools:

- NativeLink® integration with EDA simulation tools
- Generation of output netlist files
- Functional and timing simulation libraries
- Generation of test bench template and memory initialization files
- Generation of Signal Activity Files (.saf) for power analysis

Figure 1 shows the simulation flow with EDA simulation tools and the Quartus II Simulator.

Figure 1. Simulation Flow
Simulating Designs with EDA Tools

The EDA Netlist Writer module of the Quartus II software generates VHDL Output Files (.vho) and Verilog Output Files (.vo) for performing functional or timing simulation and Standard Delay Format Output Files (.sdo) that are required for performing timing simulation with EDA simulation tools. The Quartus II software generates SDF Output Files in Standard Delay Format version 2.1. The EDA Netlist Writer places simulation output files in a tool-specific directory under the current project directory.

In addition, the Quartus II software offers seamless integration for timing simulation with EDA simulation tools through the NativeLink feature. The NativeLink feature allows the Quartus II software to pass information to EDA simulation tools, and includes the ability to launch EDA simulation tools from within the Quartus II software.

Table 1 lists the EDA simulation tools that are supported by the Quartus II software and indicates which tools support the NativeLink feature.

<table>
<thead>
<tr>
<th>Simulation Tool Name</th>
<th>NativeLink Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadence Verilog-XL</td>
<td></td>
</tr>
<tr>
<td>Cadence NC-Verilog</td>
<td>✓</td>
</tr>
<tr>
<td>Cadence NC-VHDL</td>
<td>✓</td>
</tr>
<tr>
<td>Mentor Graphics® ModelSim®</td>
<td>✓</td>
</tr>
<tr>
<td>Mentor Graphics ModelSim-Altera</td>
<td>✓</td>
</tr>
<tr>
<td>Synopsys Scirocco</td>
<td>✓</td>
</tr>
<tr>
<td>Synopsys VCS MX</td>
<td>✓</td>
</tr>
<tr>
<td>Synopsys VCS</td>
<td>✓</td>
</tr>
<tr>
<td>Synopsys VSS</td>
<td></td>
</tr>
</tbody>
</table>

The Mentor Graphics ModelSim-Altera software is included in Altera® design software subscriptions for functional simulation and HDL test bench support.
Specifying EDA Simulation Tool Settings

You can select an EDA simulation tool in the New Project Wizard on the File menu when you create a new project, or in the Simulation page that is under EDA Tool Settings in the Settings dialog box on the Assignments menu. The Simulation page allows you to select a simulation tool and specify options for the generation of Verilog and VHDL output files and the corresponding SDF Output File, and, for power analysis, a Signal Activity File. Figure 2 shows the Simulation page of the Settings dialog box.

Figure 2. EDA Tool Simulation Page in Settings Dialog Box
Generating Simulation Output Files

You can run the EDA Netlist Writer module to generate Verilog Output Files and VHDL Output Files by specifying EDA tool settings and compiling the design. If you have already compiled a design in the Quartus II software, you can specify different simulation output settings in the Quartus II software (for example, a different simulation tool) and then regenerate the Verilog Output Files or VHDL Output Files with Start EDA Netlist Writer command Processing menu. If you are using the NativeLink feature, you can also run a simulation after an initial compilation with the Run EDA Simulation Tool command on the Tools menu.

Using the quartus_eda executable

You can also run the EDA Netlist Writer separately at the command prompt or in a script by using the quartus_eda executable.

The quartus_eda executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the quartus_eda executable, type one of the following commands at the command prompt:

quartus_eda -h
quartus_eda --help
quartus_eda --help=<topic name>

The Quartus II software also allows you to generate the following types of output files for use in performing functional and timing simulation in EDA simulation tools:

- **Power Estimation Data**: You can use EDA simulation tools to perform a simulation that includes power estimation data. You can direct the Quartus II software to include power estimation data for the design in the Verilog HDL or VHDL output file. The EDA simulation tool generates a Power Input File (.pwf) that you can use in the Quartus II software to estimate the power consumption of a design.

- **Test Bench Files**: You can create Verilog Test Bench Files (.vt) and VHDL Test Bench Files (.vht) for use with EDA simulation tools from a Vector Waveform File (.vwf) in the Quartus II Waveform Editor, using the Export command on the File menu. Verilog HDL and VHDL Test Bench Files are test bench template files that contain an instantiation of
the top-level design file and test vectors from the Vector Waveform File. You can also generate self-checking test bench files if you specify the expected values in the Vector Waveform File.

- **Memory Initialization Files**: You can use the Quartus II Memory Editor to enter the initial contents of a memory block, for example, content-addressable memory (CAM), RAM, or ROM, in a Memory Initialization File (.mif) or a Hexadecimal (Intel-Format) File (.hex). You can then export the memory contents as a RAM Initialization File (.rif) for use in functional simulation with EDA simulation tools.

- **Signal Activity Files**: You can create Signal Activity Files for use with the PowerPlay Power Analyzer. A Signal Activity File contains toggle rate and static probability data for a design. You can specify a limit for the signal activity period, and can also specify that glitch filtering can be performed.

## EDA Simulation Flow

Using the NativeLink feature, you can direct the Quartus II software to compile a design, generate the appropriate output files, and then automatically perform the simulation using EDA simulation tools. Alternatively, you can run EDA simulation tools manually before compilation (functional simulation) or after compilation (timing simulation) in the Quartus II software.

## EDA Tool Functional Simulation Flow

You can perform a functional simulation at any point in your design flow. The following steps describe the basic flow needed to perform a functional simulation of a design using an EDA simulation tool. Refer to Quartus II Help for more information on specific EDA simulation tools. To perform a functional simulation using EDA simulation tools:

1. If you have not already done so, set up the project in the EDA simulation tool.
2. Create a working library.
3. Compile the appropriate functional simulation libraries with the EDA simulation tool.
4. Compile the design files and test bench files with the EDA simulation tool.

5. Perform the simulation with the EDA simulation tool.

**NativeLink Simulation Flow**

You can use the NativeLink feature to perform the steps to setup and run an EDA simulation tool automatically from within the Quartus II software. The following steps describe the basic flow for using EDA simulation tools with the NativeLink feature:

1. Specify EDA tool settings in the Quartus II software, either in the Settings dialog box on the Assignments menu, or during project setup, with the New Project Wizard on the File menu.

2. Turn on Run this tool automatically after compilation when specifying EDA tool settings.

3. Compile the design in the Quartus II software. The Quartus II software performs the compilation, generates the Verilog HDL or VHDL output files and corresponding SDF Output Files (if you are performing a timing simulation), and launches the simulation tool. The Quartus II software directs the simulation tool to create a working library; compile or map to the appropriate libraries, design files, and test bench files; set up the simulation environment; and run the simulation.

**Manual Timing Simulation Flow**

If you want more control over the simulation, you can generate the Verilog HDL or VHDL output files and corresponding SDF Output File in the Quartus II software, and then manually launch the simulation tool to perform the simulation. The following steps describe the basic flow needed to perform a timing simulation of a Quartus II design using an EDA simulation tool. Refer to Quartus II Help for more information on specific EDA simulation tools.

1. Specify EDA tool settings in the Quartus II software, either in the Settings dialog box on the Assignments menu, or during project setup, with the New Project Wizard on the File menu.
2. Compile the design in the Quartus II software to generate the output netlist files. The Quartus II software places the files in a tool-specific directory.

3. Launch the EDA simulation tool.

4. Set up the project and a working directory with the EDA simulation tool.

5. Compile or map to the timing simulation libraries, and compile the design and test bench files with the EDA simulation tool.

6. Perform the simulation with the EDA simulation tool.

Simulation Libraries

Altera provides functional simulation libraries for designs that contain Altera-specific components, and atom-based timing simulation libraries for designs compiled in the Quartus II software. You can use these libraries to perform functional or timing simulation of any design with Altera-specific components in EDA simulation tools that are supported by the Quartus II software. Additionally, Altera provides pre-compiled functional and timing simulation libraries for simulation in the ModelSim-Altera software.

Altera provides functional simulation libraries for designs that use Altera megafunctions and standard library of parameterized modules (LPM) functions. Altera also provides pre-compiled versions of the altera_mf and 220model libraries for simulation in the ModelSim software. Table 2 shows the functional simulation libraries for use with EDA simulation tools.

Table 2. Functional Simulation Libraries  (Part 1 of 2)

<table>
<thead>
<tr>
<th>Library Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>220model.v</td>
<td>Simulation models for LPM functions (version 2 2 0)</td>
</tr>
<tr>
<td>220model.vhd</td>
<td></td>
</tr>
<tr>
<td>220model_87.vhd</td>
<td></td>
</tr>
<tr>
<td>220pack.vhd</td>
<td>VHDL Component Declarations for 220model.vhd</td>
</tr>
<tr>
<td>altera_mf.v</td>
<td>Simulation models and VHDL Component Declarations</td>
</tr>
<tr>
<td>altera_mf.vhd</td>
<td>for Altera-specific megafunctions</td>
</tr>
<tr>
<td>altera_mf_87.vhd</td>
<td></td>
</tr>
<tr>
<td>altera_mf_components.vhd</td>
<td></td>
</tr>
</tbody>
</table>
In the Quartus II software, the information for specific device architecture entities and Altera-specific megafunctions is located in post-routing atom-based timing simulation libraries. The timing simulation library files differ based on device family and whether you are using Verilog Output Files or VHDL Output Files. For VHDL designs, Altera provides VHDL Component Declaration files for designs with Altera-specific megafunctions.

In the Quartus II software, the information for specific device architecture entities and Altera-specific megafunctions is located in post-routing atom-based timing simulation libraries. The timing simulation library files differ based on device family and whether you are using Verilog Output Files or VHDL Output Files. For VHDL designs, Altera provides VHDL Component Declaration files for designs with Altera-specific megafunctions.

### Table 2. Functional Simulation Libraries  (Part 2 of 2)

<table>
<thead>
<tr>
<th>Library Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sgate.v</td>
<td>Simulation models for Altera-specific megafunctions and Intellectual Property functions</td>
</tr>
<tr>
<td>sgate.vhd</td>
<td></td>
</tr>
<tr>
<td>sgate_pack.vhd</td>
<td></td>
</tr>
<tr>
<td>stratixgx_mf.v</td>
<td>Libraries that contain simulation models for Stratix GX designs that contain the altgxb megafunction.</td>
</tr>
<tr>
<td>stratixgx_mf.vhd</td>
<td></td>
</tr>
</tbody>
</table>

For Verilog designs, you must compile the **220model.v** and **sgate.v** simulation model libraries (in that order) before compiling this library.

For VHDL designs, you must compile the **220pack.vhd**, **220model.vhd**, **sgate_pack.vhd**, and **sgate.vhd** simulation model libraries (in that order) before compiling these libraries.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timing Simulation libraries</td>
<td>&quot;Altera Postrouting Libraries&quot; in Quartus II Help</td>
</tr>
<tr>
<td>Functional Simulation libraries</td>
<td>&quot;Altera Functional Simulation Libraries&quot; in Quartus II Help</td>
</tr>
<tr>
<td>Performing simulation using the ModelSim or ModelSim-Altera software</td>
<td>Mentor Graphics ModelSim Support chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Performing simulation with the VCS software</td>
<td>Synopsys VCS Support chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Performing simulation with the NC-Sim software</td>
<td>Cadence NC-Sim Support chapter in volume 3 of the Quartus II Handbook</td>
</tr>
</tbody>
</table>
Simulating Designs with the Quartus II Simulator

You can use the Quartus II Simulator to simulate any design. Depending on the type of information you need, you can perform a functional simulation to test the logical operation of your design, a timing simulation to test both the logical operation and the worst-case timing for the design in the target device, or a timing simulation using the Fast Timing model to simulate the fastest possible conditions with the fastest device speed grade.

The Quartus II software allows you to simulate an entire design, or to simulate any part of a design. You can designate any design entity in a project as the top-level design entity and simulate the top-level entity and all of its subordinate design entities.

You can specify the type of simulation that should be performed, the time period covered by the simulation, the source of vector stimuli, and other simulation options in the Simulator Settings page of the Settings dialog box on the Assignments menu or in the Simulator Tool window on the Tools menu. Figure 3 shows the Simulator Settings page.
Before starting a simulation, you must generate the appropriate simulation netlist by either compiling the design for timing simulation or clicking the Generate Functional Simulation Netlist command on the Processing menu for functional simulation. In addition, you must create and specify a vector source file as the source of simulation input vectors. The Simulator uses the input vectors contained in the vector source file to simulate the output signals that a programmed device would produce under the same conditions.

The following steps describe the basic flow for performing either a functional or timing simulation in the Quartus II software:

1. Specify Simulator settings.
2. If you are performing a functional simulation, click the **Generate Functional Simulation Netlist** command on the Processing menu. If you are performing a timing simulation, compile the design.

3. Create and specify a vector source file.

4. Run the simulation by pointing to **Start** on the Processing menu and clicking **Start Simulation**.

The Status window shows the progress of a simulation and the processing time. The **Summary** report section in the Report window shows the simulation results.

---

**Creating Waveform Files**

The Quartus II Waveform Editor allows you to create and edit input vectors for simulation in waveform or text format. Using the Waveform Editor, you can add input vectors to the waveform file that describe the behavior of the logic in your design (Figure 4).
The Quartus II software supports waveform files in the Vector Waveform File (.vwf), Vector Table Output File (.tbl), Vector File (.vec), and Simulator Channel File (.scf) formats. You cannot edit a Simulator Channel File or Vector File in the Waveform Editor, but you can save it as a Vector Waveform File.

Using the Simulator Tool

You can also use the Simulator Tool command (Tools menu) to set Simulator settings, as well as start or stop the Simulator and open the simulation waveform for the current project. The Simulator Tool window is similar in purpose to the MAX+PLUS II Simulator. To perform a simulation, you must first generate a simulation netlist by using the Generate Functional Simulation Netlist button in the Simulator Tool for functional simulation or by compiling the design if you are performing a timing simulation. 

Figure 5 shows the Simulator Tool window.
Figure 5. Simulator Tool Window
Chapter Eight
Timing Analysis

What's in Chapter 8:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>145</td>
</tr>
<tr>
<td>Classic Timing Analyzer</td>
<td>149</td>
</tr>
<tr>
<td>Performing an Early Timing Estimate</td>
<td>156</td>
</tr>
<tr>
<td>Performing Timing Analysis with EDA Tools</td>
<td>163</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II TimeQuest Timing Analyzer and Classic Timing Analyzer allow you to analyze the performance of all logic in your design and help to guide the Fitter to meet timing requirements. You can use the information generated by the timing analyzers to analyze, debug, and validate the timing performance of your design. You can also perform timing analysis with fast timing models, to verify timing under best-case (fastest delays of the fastest speed grade) conditions. Figure 1 shows the timing analysis flow when using the Classic Timing Analyzer.

Figure 1. Classic Timing Analysis Flow
Choosing the TimeQuest or Classic Timing Analyzer

The TimeQuest analyzer provides powerful timing analysis features. This section describes the differences between the TimeQuest analyzer and the Classic Timing Analyzer, and the process you should follow decide whether to use or switch to the TimeQuest analyzer.

The TimeQuest analyzer uses industry-standard Synopsis Design Constraint (SDC) terminology for constraining designs and performing reporting. There are a number of specific applications that are easier to constrain accurately when you use the TimeQuest timing analyzer instead of the Classic timing analyzer. An example includes designs that have multiplexed clocks, regardless of whether they are switched on or off chip. Designs with source-synchronous interfaces, such as DDR memory interfaces, are much simpler to constrain and analyze with the TimeQuest timing analyzer. Additionally, you should evaluate the TimeQuest timing analyzer if you are more familiar with Synopsis Design Constraint terminology than Altera-specific Quartus Settings File timing assignments.

The TimeQuest and Classic timing analyzers have a number of different features and perform some analyses differently. Some limitations might make the TimeQuest timing analyzer unsuitable for your use.

TimeQuest Timing Analysis

This section explains how to direct the fitter to use the TimeQuest analyzer, how to constrain your design, and how to use the TimeQuest GUI.

Running the TimeQuest Timing Analyzer

The Quartus II software uses the Classic timing analyzer by default when performing a full compilation. To use the TimeQuest timing analyzer instead, click Settings on the Assignments menu. In the Timing Analysis Processing page of the Settings dialog box, turn on Use TimeQuest Timing Analyzer during compilation.
Using the TimeQuest GUI

The TimeQuest timing analyzer provides an intuitive and easy-to-use GUI that allows you to constrain and analyze designs efficiently. The GUI is divided into the following four panes:

- View pane
- Tasks pane
- Console
- Report pane

Each pane provides features that enhance the productivity of performing static timing analysis in the TimeQuest analyzer (Figure 2).

**Figure 2. TimeQuest Timing Analyzer Window**

The following section describes the TimeQuest analyzer in detail.
Tasks Pane

The Tasks pane provides easy access to commonly performed tasks such as netlist and report generation. Each command found in the Tasks pane has an equivalent Tcl command, which you can specify and view in the Console.

Console Pane

The Console pane displays messages and a console window for the TimeQuest analyzer. The Console pane has two tabs: The Console tab and the History tab. All information and warning messages appear in the Console tab. All executed Synopsys Design Constraints files and Tcl commands are recorded in the History tab. You can rerun a command in the History tab after the timing netlist has been updated by right-clicking the command you want to repeat, and clicking Rerun.

Report Pane

The Report pane lists the reports you generate from the Tasks pane and those that are generated by any custom report commands. Once you select a report from the Report pane, the report appears in the View pane. If a report is out-of-date with respect to the current constraints, a “?” icon is shown next to the report.

You can use the Write SDC File command to save the current constraints to a Synopsys Design Constraints File (.sdc).

View Pane

The View pane displays timing analysis results, including any summary reports, custom reports, or histograms. Figure 3 shows the View pane when you select the Summary (Setup) report in the Report pane.

Figure 3. Summary (Setup) Report in the View Pane

<table>
<thead>
<tr>
<th>Summary (Setup)</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Clock</td>
<td>Slack</td>
</tr>
<tr>
<td>1 clk1</td>
<td>2.192</td>
<td>0.000</td>
</tr>
<tr>
<td>2 clk2</td>
<td>-0.835</td>
<td>-11.582</td>
</tr>
</tbody>
</table>
The TimeQuest analyzer reports results only when requested. You can customize each report on demand to display specific timing information.

**Classic Timing Analyzer**

The Classic timing analyzer automatically performs timing analysis on your design following a full compilation. The following guidelines describe some of the tasks that you can accomplish with the Classic timing analyzer:

- Perform the timing analysis during a full compilation or separately after an initial compilation.
- Perform an early timing estimate after a partial compilation, before fitting is complete.
- View the timing results with the Report window and the Timing Closure floorplan.

**Specifying Classic Timing Requirements**

Timing requirements allow you to specify the desired speed performance for the entire project, for specific design entities, or for individual entities, nodes, and pins.

You can use the **Timing** wizard to help you to create initial project-wide timing settings. Once you have specified initial timing settings, you can modify settings either in the **Timing** wizard again, or with the **Timing Requirements & Options** page of the **Settings** dialog box. Figure 4 shows the **Timing Requirements & Options** page.
After specifying project-wide timing assignments and/or individual timing assignments, you can run a timing analysis by compiling the design, or by running the Classic Timing Analyzer separately after an initial compilation.

By default, the classic timing analyzer calculates and reports the $f_{\text{MAX}}$ of every register-to-register delay, the $t_{SU}$ and $t_H$ of every input register, the $t_{CO}$ of every output register, the $t_{PD}$ between all pin-to-pin paths, hold times, minimum $t_{CO}$, and minimum $t_{PD}$ of the current design entity. Slack times are reported when constraints are provided or when defaults are applicable.
Specify I/O timing requirements with the **Input Maximum Delay**, **Input Minimum Delay**, **Output Maximum Delay**, or **Output Minimum Delay** assignments to specify delays based on external device timing, or with the traditional tsu requirement, tco requirement, and/or th requirement timing assignments. Both types of I/O timing requirements ultimately produce similar results through different methods.

Using the **Settings** dialog box or the **Timing** wizard, you can specify the following timing requirements and other options:

- Overall frequency requirement for the project, or settings for individual clock signals
- Delay requirements, minimum delay requirements, and path-cutting options
- Reporting options, including the number of source and destination registers and exclude paths
- Timing-driven compilation options
- Options for setup (recovery) and hold (removal) checks on timing paths that have an asynchronous clear, preset, or load signal.

### Specifying Project-Wide Classic Timing Settings

Project-wide timing settings include maximum frequency, setup time, hold time, clock-to-output delay and pin-to-pin delay, and minimum timing requirements. You can also set project-wide clock settings and multiple clock domains, and path-cutting options.

#### Table 1. Project-Wide Timing Settings (Part 1 of 2)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_{MAX}$ (maximum frequency)</td>
<td>The maximum clock frequency that can be achieved without violating internal setup ($t_{SU}$) and hold ($t_{H}$) time requirements.</td>
</tr>
<tr>
<td>$t_{SU}$ (clock setup time)</td>
<td>The length of time for which data that feeds a register via its data or enable input(s) must be present at an input pin before the clock signal that clocks the register is asserted at the clock pin.</td>
</tr>
<tr>
<td>$t_{H}$ (clock hold time)</td>
<td>The length of time for which data that feeds a register via its data or enable input(s) must be retained at an input pin after the clock signal that clocks the register is asserted at the clock pin.</td>
</tr>
</tbody>
</table>
Specifying Individual Timing Assignments

You can make individual timing assignments to individual entities, nodes, and pins with the Assignment Editor. Individual timing assignments override project-wide requirements (if they are more stringent). The Assignment Editor supports point-to-point timing assignments, wildcards to identify specific nodes when making assignments, and time group assignments to make individual assignments to groups of nodes.

The timing requirements that you enter for pins and nodes are saved in the Quartus II Settings File (.qsf) for the top-level entity in the current hierarchy.

You can make the following types of individual timing assignments in the Timing Analyzer:

- **Individual clock settings**: allow you to perform an accurate multiclock timing analysis by defining the timing requirements and relationship of all clock signals in the design. The Timing Analyzer supports both single-clock and multiclock frequency analysis.

- **Clock uncertainty assignments**: allow you to specify the expected clock setup or hold uncertainty (jitter) that should be used when performing setup and hold checks. The Timing Analyzer subtracts the

### Table 1. Project-Wide Timing Settings (Part 2 of 2)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$t_{CO}$ (clock-to-output delay)</td>
<td>The time required to obtain a valid output at an output pin that is fed by a register after a clock signal transition on an input pin that clocks the register.</td>
</tr>
<tr>
<td>$t_{PD}$ (pin to pin delay)</td>
<td>The time required for a signal from an input pin to propagate through combinational logic and appear at an external output pin.</td>
</tr>
<tr>
<td>minimum $t_{CO}$ (clock-to-output delay)</td>
<td>The minimum time required to obtain a valid output at an output pin that is fed by a register after a clock signal transition on an input pin that clocks the register. This time always represents an external pin-to-pin delay.</td>
</tr>
<tr>
<td>minimum $t_{PD}$ (clock-to-output delay)</td>
<td>Specifies the minimum acceptable pin-to-pin delay, that is, the time required for a signal from an input pin to propagate through combinational logic and appear at an external output pin.</td>
</tr>
</tbody>
</table>
specified setup uncertainty from the data required time when calculating setup checks and adds the specified hold uncertainty to the data required time when calculating hold checks.

- **Clock latency assignments**: allow you to specify additional early or late clock delays as latencies. Latencies affect clock skew, which is different from offsets, which affect the setup relationship. The clock latency represents the external delay from a virtual (ideal) clock through either the shortest path or the longest path. For setup analysis, the Classic Timing Analyzer uses the late latency value for each source and the early latency value for each destination register, and for hold analysis, the Timing Analyzer uses the early latency value for each source and the late latency value for each destination register.

- **Multicycle paths**: paths between registers that require more than one clock cycle to become stable. You can set multicycle paths to instruct the Timing Analyzer to relax its measurements and avoid incorrect setup or hold time violations.

- **Cut paths**: by default, the Quartus II software will cut paths between unrelated clock domains when there are no timing requirements set or only the default required fMAX clock setting is used. The Quartus II software will also cut paths between unrelated clock domains if individual clock assignments are set but there is no defined relationship between the clock assignments. You can also define cut paths for specific paths in the design.

- **Maximum delay requirements**: requirements for input or output maximum delay, or maximum timing requirements for tSU, tH, tPD, and tCO on specific nodes in the design. You can make these assignments to specific nodes or groups to override project-wide maximum timing requirements.

- **Minimum delay requirements**: requirements for input or output minimum delay, or minimum timing requirements for tH, tPD, and tCO for specific nodes or groups. You can make these assignments to specific nodes or groups to override project-wide minimum timing requirements.

- **Maximum skew requirements**: timing requirements for maximum clock and data arrival skew for specific nodes or groups.

- **Time group assignments**: advanced timing assignments that you can define in the 'Time Groups' dialog box on the Assignments menu. You can also use the Tcl API in the Quartus II Tcl Console, or one of the
Quartus II executables that support Tcl. Members of a defined time group can include regular node names, wildcards, and/or other time group names. Conversely, you can exclude specific nodes, wildcards, and/or other time group names from a time group. The groups can then be used in the From or To field of most timing assignments.

**Performing a Classic Timing Analysis**

Once you have specified timing settings and assignments, you can run the Classic Timing Analyzer by performing a full compilation.

To rerun timing analysis separately after compilation, on the Processing menu point to Start, and then click **Start Timing Analyzer**. To run a timing analysis with fast timing models, on the Processing Menu, click Start then click **Start Timing Analyzer (Fast Timing Model)**, or use the **Timing Analyzer Tool** command from the Processing menu.

You can also generate data for an early timing estimate before fitting is complete with the **Start Early Timing Estimate** command. See “Performing an Early Timing Estimate” on page 156 for more information.

The Timing Analyzer Tool window provides an alternative interface for controlling the Timing Analyzer. This interface is similar to the Timing Analyzer interface in the MAX+PLUS II software. You can use the Timing Analyzer Tool window to start and stop the Timing Analyzer, quickly view summary timing analysis results, or to access detailed timing analysis results in the Compilation Report. You can click **List Paths** to display propagation delays for the selected path (Figure 5).


Figure 5. Timing Analyzer Tool

Using the quartus_tan executable

You can also run the Classic Timing Analyzer separately at the command prompt or in a script by using the quartus_tan executable. You must run the Quartus II Fitter executable quartus_fit before running the Timing Analyzer.

The quartus_tan executable creates a separate text-based report file that can be viewed with any text editor.

You can also launch the quartus_tan Tcl scripting shell, to run timing-related Tcl commands, by typing the following command at a command prompt:

quartus_tan -s

If you want to get help on the quartus_tan executable, type one of the following commands at the command prompt:

quartus_tan --h
quartus_tan --help
quartus_tan --help=<topic name>
Performing an Early Timing Estimate

To generate data for an early timing estimate, on the Processing menu, point to **Start**, and then click **Start Early Timing Estimate**. You can specify options for early timing estimation in the **Early Timing Estimate** page under **Compilation Process Settings** in the **Settings** dialog box on the Assignments menu. You can select from one of the following options for **Early timing estimate mode**:

- **Realistic**
- **Optimistic**
- **Pessimistic**

Figure 6 shows the **Early Timing Estimate** page.
When you use the **Start Early Timing Estimate** command, the Compiler performs a complete Analysis & Synthesis but stops before fitting is complete. You can then review the early timing estimates in the Timing Analyzer reports, just as you would view regular timing analysis results; however, all early timing estimates are preliminary. For more information on viewing timing results in the Report window, see the next section, "Classic Timing Analysis Reporting".

![Figure 6. Early Timing Estimate Page in the Settings Dialog Box](image)
Classic Timing Analysis Reporting

After you run a timing analysis, you can view the timing analysis results or early timing estimates in the Timing Analyzer folder of the Compilation Report. You can then list the timing paths to validate circuit performance, determine critical speed paths and paths that limit the design’s performance, and make additional timing assignments.

To view information on the critical paths in the design and view routing congestion, on the Project menu, click Timing Closure floorplan. For more information on using the Timing Closure floorplan to view critical paths and routing congestion, refer to “Using the Timing Closure Floorplan” on page 168 in Chapter 9, “Timing Closure.”

If you are familiar with MAX+PLUS® II timing reporting, you can find timing information, such as the delay information from the MAX+PLUS II Delay Matrix, in the Timing Analyzer sections of the Compilation Report and in the Custom Delays tab of the Timing Analyzer Tool window.

When you run the Classic Timing Analyzer, the Timing Analysis sections in the Report window list the following types of information for timing analysis:

- Settings for timing requirements
- Timing information for clock setup and clock hold; $t_{SU}$, $t_H$, $t_{PD}$, and $t_{CO}$; and minimum $t_{PD}$ and $t_{CO}$
- Slack and minimum slack
- Source and destination clock names
- Source and destination node names
- Required and actual point-to-point times
- Maximum clock arrival skew
- Maximum data arrival skew
- Actual $f_{MAX}$
- Any timing assignments ignored during timing analysis
- Any messages generated by the classic analyzer

Figure 7 shows the report window.
Making Assignments & Viewing Delay Paths

You can access the **Locate in Assignment Editor**, **List Paths**, and **Locate in Timing Closure Floorplan** commands directly from the Timing Analyzer reports to make individual timing assignments and view delay path information. In addition, you can use the `list_path` Tcl command to list delay path information.

You can use the **Locate in Assignment Editor** command to open the Assignment Editor and make an individual timing assignment on any path in a Timing Analyzer report. This feature allows you to easily make point-to-point assignments on paths.

The following steps describe the basic flow for making individual timing assignments in the Assignment Editor:

1. In the **Category** bar, click **Timing** to indicate the category of assignment you wish to make.
2. Click the To cell in the spreadsheet and use the Node Finder to find a node, or type a node name, wildcard character, and/or time group name that identifies the destination node you want to assign.

3. Click the From cell in the spreadsheet and use the Node Finder to find a node, or type a node name, wildcard character, and/or time group name that identifies the source node you want to assign, if applicable.

4. In the spreadsheet, double-click the Assignment Name cell and select the timing assignment you wish to make.

5. Double-click the Value cell and type or select the appropriate assignment value.

You can also use the Locate in Timing Closure Floorplan command to locate a path in the Timing Closure floorplan, which allows you to take advantage of the Timing Closure floorplan features to make assignments to a specific path. For more information on using the Timing Closure floorplan, refer to “Using the Timing Closure Floorplan” on page 168 in Chapter 9, “Timing Closure.”

To display the intermediate delays of any path in a Timing Analyzer report panel, right-click the path information and then click List Paths. The List Paths command allows you to find pin-to-pin, register-to-register, and clock-to-output-pin delay paths, and display information about any delay path in the design that appears in the Report Window (Figure 8).

Figure 8. Output from List Paths Command
The `list_path` Tcl command, which you can use in the `quartus_tan` module and the Quartus II Tcl Console, allows you to specify any point-to-point path and view the delay information. You can specify the number of paths to report, the type of path (including minimum timing paths), and use wildcards to identify source and destination nodes. This option reports information in the same manner as the `List Paths` command (Figure 9).

**Figure 9. Sample Output from list_path Command**

<table>
<thead>
<tr>
<th>Path Number: 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path from source pin 1 to destination pin 2 through register auto_max:auto</td>
</tr>
</tbody>
</table>

+ Longest clock path from clock to source register is 2.793 ns
  1: + 1k(0,000 ns) + Cell(0,019 ns) = 0.019 ns; Loc = Pin2; CLK Mode = 'clock'
  2: + 1k(1,339 ns) + Cell(0,019 ns) = 2.791 ns; Loc = LC_KSL_1Y1; RES Mode = `auto_max:auto|street_map| 01`
  Total cell delay = 1.113 ns
  Total interconnect delay = 1.683 ns

+ Micro clock to output delay of source is 0.156 ns
+ Longerest register to pin delay is 5.914 ns
  1: + 1k(0,000 ns) + Cell(0,000 ns) = 0.000 ns; Loc = LC_KSL_1Y1; RES Mode = `auto_max:auto|street_map| 01`
  2: + 1k(0,718 ns) + Cell(0,075 ns) = 0.793 ns; Loc = LC_KSL_1Y1; RES Mode = `auto_max:auto|street_map| 01`
  3: + 1k(0,518 ns) + Cell(0,366 ns) = 1.875 ns; Loc = LC_KSL_1Y1; RES Mode = `auto_max:auto|street_map| 01`
  4: + 1k(1,350 ns) + Cell(2,088 ns) = 5.914 ns; Loc = Pin1; PIN Node = 'gtl'
  Total cell delay = 5.350 ns
  Total interconnect delay = 2.554 ns

---

**Viewing Timing Delays with the Technology Map Viewer**

The Quartus II Technology Map Viewer provides a low-level, or atom-level, technology-specific schematic representation a design. The Technology Map Viewer includes a schematic view, and also includes a hierarchy list, which lists the instances, primitives, pins, and nets for the entire design netlist.

After performing timing analysis or performing a full compilation that includes timing analysis, you can use the Technology Map Viewer to view the nodes that make up a timing path, including information about total delay and individual node delay (Figure 10).

You can display the Technology Map Viewer after performing a timing analysis with the following methods:

- On the Tools menu, click **Technology Map Viewer**.
- Right-click path information in a Timing Analyzer report, and then click **Locate in Technology Map Viewer**
Select the path in the Messages window then select the Technology Map Viewer from the Location list (after using the List Paths command).

**Figure 10. Technology Map View Window—Delay Information**

For Information About

Refer To

Using the Quartus II Technology Map Viewer

Analyzing Designs with the Quartus II RTL Viewer and Technology Map Viewer chapter in volume 1 of the Quartus II Handbook
Performing Timing Analysis with EDA Tools

The Quartus II software supports timing analysis and minimum timing analysis with the Synopsys PrimeTime software on UNIX workstations and board-level timing analysis with the Mentor Graphics® Tau board-level verification tools.

To generate the necessary output files for performing timing analysis in EDA timing analysis tools, specify the appropriate timing analysis tool in the Timing Analysis and Board-Level pages under EDA Tool Settings in the Settings dialog box or when creating a project, and then perform a full compilation. Figure 11 shows the Timing Analysis page under EDA Tool Settings.
You can also generate the files by pointing to Start on the Processing menu, and then clicking Start EDA Netlist Writer after an initial compilation. If you are using the NativeLink® feature, you can also run a timing analysis after an initial compilation by clicking Run EDA Timing Analysis Tool on the Tools menu.
Using the quartus_edu executable

You can also run the EDA Netlist Writer to generate the necessary output files separately at the command prompt or in a script by using the quartus_edu executable. You must run the Quartus II Fitter executable quartus_fit before running the EDA Netlist Writer.

The quartus_edu executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the quartus_edu executable, type one of the following commands at the command prompt:

quartus_edu -h
quartus_edu -help
quartus_edu --help=<topic name>

Using the PrimeTime Software

The Quartus II software generates a Verilog Output File or VHDL Output File, a Standard Delay Format Output File (.sdo) that contains timing delay information, and a Tcl Script File that sets up the PrimeTime environment. If you are performing a minimum timing analysis, the Quartus II software uses the minimum delay information generated by the Timing Analyzer in the SDF Output File for the design.

With the NativeLink feature, you can specify that the Quartus II software launches the PrimeTime software in either command-line or GUI mode. You can also specify a Synopsys Design Constraints File that contains timing assignments for use in the PrimeTime software.

The following steps describe the basic flow to manually use the PrimeTime software to perform timing analysis on a design after compilation in the Quartus II software:

1. Specify EDA tool settings, either in the Settings dialog box on the Assignments menu, or during project setup, with the New Project Wizard, on the File menu.

2. Compile your design in the Quartus II software to generate the output netlist files. The Quartus II software places the files in a tool-specific directory.

3. Source the Quartus II-generated Tcl Script File (.tcl) to set up the PrimeTime environment.
4. Perform timing analysis in the PrimeTime software.

**Using the Tau Software**

The Quartus II software generates STAMP model files that can be imported into the Tau software to perform board-level timing verification.

The following steps describe the basic flow for generating STAMP model files:

1. Specify EDA tool settings, either in the **Settings** dialog box on the Assignments menu, or during project setup, using the **New Project Wizard** on the File menu.

2. Compile the design in the Quartus II software to generate the STAMP model files. The Quartus II software places the files in a tool-specific directory.

3. Use the STAMP model files in the Tau software to perform board-level timing verification.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Synopsys PrimeTime software with the Quartus II software</td>
<td>Synopsys PrimeTime Support chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Using the Mentor Graphics Tau software with the Quartus II software</td>
<td>“Overview: Using the Tau Software with the Quartus II Software” in Quartus II Help</td>
</tr>
</tbody>
</table>
Chapter Nine
Timing Closure

What’s in Chapter 9:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>168</td>
</tr>
<tr>
<td>Using the Timing Closure Floorplan</td>
<td>168</td>
</tr>
<tr>
<td>Using the Timing Optimization Advisor</td>
<td>172</td>
</tr>
<tr>
<td>Using Netlist Optimizations to Achieve Timing Closure</td>
<td>173</td>
</tr>
<tr>
<td>Using LogicLock Regions to Achieve Timing Closure</td>
<td>175</td>
</tr>
<tr>
<td>Using the Design Space Explorer to Achieve Timing Closure</td>
<td>178</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II software offers a fully integrated timing closure flow that allows you to meet your timing goals by controlling the synthesis and place and route of a design. Using the timing closure flow results in faster timing closure for complex designs, reduced optimization iterations, and automatic balancing of multiple design constraints.

The timing closure flow allows you to perform an initial compilation, view design results, and perform further design optimization efficiently. You can use the Timing Closure floorplan to analyze the design and make assignments, use the Timing Optimization Advisor to view recommendations for optimizing your design for timing, use netlist optimizations on the design after synthesis and during place and route, use LogicLock™ region assignments, and use the Design Space Explorer to further optimize the design. Figure 1 shows the timing closure flow.

Figure 1. Timing Closure Flow

Using the Timing Closure Floorplan

You can use the Timing Closure floorplan to view logic placement made by the Fitter, view user assignments and LogicLock region assignments, and routing information for a design. You can use this information to identify critical paths in the design and make timing assignments, location assignments, and LogicLock region assignments to achieve timing closure.
You can customize the way the Timing Closure floorplan displays information using options available from the View menu. You can show the device by package pins and their function; by interior MegaLAB™ structures, LABs, and cells; by regions of the chip; and by the name and location of selected signals.

You can also use the **Field View** command on the View menu to display the major classifications of device resources in a high-level outline view in the Timing Closure floorplan. Assignments are represented in the Field view by colored areas that indicate the amount of user-assigned, Fitter-placed, and unassigned logic per structure in the device. You can use the information in the Field view to make assignments to achieve timing closure on a design.

### Viewing Assignments & Routing

The Timing Closure floorplan can simultaneously show user assignments and Fitter location assignments. User assignments are all the location and LogicLock region assignments you have made in the design. Fitter assignments are the locations where the Quartus II software placed all nodes after the last compilation. You can show user assignments and Fitter assignments with the **Assignments** command on the View menu.

The Timing Closure Floorplan allows you to show the device resources and the corresponding routing information for all design logic. Using the **Routing** command on the View menu, you can select device resources and view the following types of routing information:

- **Paths between nodes**: display the connection between selected logic cells, I/O cells, embedded cells, and pins that feed one another.

- **Node fan-in and fan-out**: display node fan-in and fan-out routing information for selected embedded cells, logic cells, I/O cells, and pins.

- **Routing delays**: display routing delays to or from specific logic cells, I/O cells, embedded cells, or pins; between selected nodes; or along one or more critical paths.

- **Connection counts**: show or hide the number of connections to a selected object, from a selected object, or between selected objects.

- **Physical timing estimates**: displays the approximate delay from one physical resource to another physical resource. Once you select a physical resource, the delay is represented graphically by the shade of
potential destination resources (the darker the resource, the longer the delay) and the delay to a destination resource is shown numerically by placing the mouse over another physical resource.

- Routing congestion: displays a graphical representation of the routing congestion in a design. The darker the shading, the greater the routing resource utilization. You can select a routing resource and then specify the congestion threshold (displayed as red areas in the device) for the resource.

- Critical paths: displays the critical paths in a design, including path edges and routing delays. The default critical path view shows the register-to-register paths. You can also view all the combinational nodes for the worst-case path between the source and destination nodes. You can specify criteria for filtering which critical paths are displayed by specifying the clock domain, source and destination node names, the number of critical paths to display, and slack.

You can also view the routing information for LogicLock regions in the design, including connectivity and intra-region delay. LogicLock region connectivity displays the connectivity between entities assigned to LogicLock regions in the design and intra-region delay displays the maximum time delay between source and destination paths in a LogicLock region, including its child regions.

The Equations window displays routing and equation information for pin, I/O cell, logic cell, and embedded cell assignments. When you turn on Equations from the View menu, the Equations window is displayed at the bottom of the Timing Closure floorplan window as shown in Figure 2.

**Figure 2. Equations Window**
By selecting one or more logic cell, embedded cell, and/or pin assignments in the floorplan, you can display their equations, fan-in, and fan-out in the **Equations** list and expand or collapse the terms. The **Fan-In** list displays all nodes that feed the selected logic cell, embedded cell, and/or pin assignments. The **Fan-Out** list displays all nodes that are fed by the selected logic cell, embedded cell, and/or pin assignments.

### Making Assignments

To facilitate achieving timing closure, the Timing Closure floorplan allows you to make or change location assignments directly in the floorplan. You can create and assign nodes or entities to custom regions and to LogicLock regions in the Timing Closure floorplan, and you can also edit existing assignments to pins, logic cells, rows, columns, regions, MegaLAB structures, and LABs. You can also locate any node (or set of nodes) to the Assignment Editor and make assignments there.

You can edit assignments in the Timing Closure floorplan in the following ways:

- Cut, copy, and paste node and pin assignments.
- Launch the Assignment Editor to make assignments.
- Use the Node Finder to help make assignments.
- Create and assign logic to LogicLock regions.
- Drag and drop nodes and entities from the **Hierarchy** tab of the Project Navigator, LogicLock regions, and the Timing Closure floorplan to other areas of the floorplan.

Before making assignments, you can preserve resource assignments from the current compilation by back-annotating assignments to pins, logic cells, rows, columns, regions, LABs, MegaLAB structures, and LogicLock regions with the **Back-Annotate Assignments** command on the Assignments menu. For more information on using the **Back-Annotate Assignments** command, see “Preserving Assignments through Back-Annotation” on page 117 in Chapter 5, “Place & Route.”

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing assignments and routing in the Timing Closure floorplan</td>
<td><em>Timing Closure Floorplan</em> chapter in volume 2 of the <em>Quartus II Handbook</em></td>
</tr>
<tr>
<td></td>
<td>“Viewing Routing Information in the Timing Closure Floorplan” in Quartus II Help</td>
</tr>
</tbody>
</table>
Using the Timing Optimization Advisor

The Timing Optimization Advisor offers recommendations for optimizing your design for timing in the following areas:

- Maximum frequency ($f_{\text{MAX}}$)
- Setup timing ($t_{\text{SU}}$)
- Clock-to-output ($t_{\text{CO}}$)
- Propagation delay ($t_{\text{PD}}$)

If you have an open project, you can view the Timing Optimization Advisor by choosing **Timing Optimization Advisor** on the Tools menu. If the project has not been compiled yet, the Timing Optimization Advisor provides only general recommendations for optimizing for timing. If the project has been compiled, however, the Timing Optimization Advisor can provide specific timing recommendations for the project, based on the project information and current settings. Figure 3 shows the Timing Optimization Advisor.

**Figure 3. Timing Optimization Advisor Initial Page**
The Timing Optimization Advisor features are very similar to the Resource Optimization Advisor; for more information, refer to “Using the Resource Optimization Advisor” on page 110 in Chapter 5, “Place & Route.”

Using Netlist Optimizations to Achieve Timing Closure

The Quartus II software includes netlist optimization options to further optimize your design during synthesis and during place and route. Netlist optimizations are push-button features that offer improvements to $f_{\text{MAX}}$ results by making modifications to the netlist to improve performance. These options can be applied regardless of the synthesis tool used. Depending on your design, some options may have more of an effect than others.

You can specify synthesis and physical synthesis netlist optimizations in the Synthesis Netlist Optimizations and Physical Synthesis Optimizations pages of the Settings dialog box (Assignments menu). See Figure 4 on page 174.

Netlist optimizations for synthesis include the following options:

- **Perform WYSIWYG primitive resynthesis**: Directs the Quartus II software to unmap WYSIWYG primitives during synthesis. When this option is turned on, the Quartus II software unmaps the logic elements in an atom netlist to gates and remaps the gates to Altera® LCELL primitives. This option allows the Quartus II software to use techniques specific to a device architecture during the remapping process and uses the optimization technique (Area, Balanced, or Speed) that you specified in the Analysis & Synthesis Settings page of the Settings dialog box.

- **Perform gate-level register retiming**: Allows registers to be moved across combinational logic to balance timing, but does not change the functionality of the current design. This option moves registers across combinational gates only, and not across user-instantiated logic cells, memory blocks, DSP blocks, or carry or cascade chains, and has the ability to move registers from the inputs of a combinational logic block to the block’s output, potentially combining the registers. It can also create multiple registers at the input of a combinational logic block from a register at the output of a combinational logic block.
Figure 4. Netlist Optimizations

- Allow register retiming to trade off $T_{SU}/T_{CO}$ with $F_{MAX}$: Directs the Quartus II software to move logic across registers that are associated with I/O pins during register retiming to trade off $t_{CO}$ and $t_{SU}$ with $F_{MAX}$. When you turn on this option, register retiming can affect registers that feed and are fed by I/O pins. If you do not turn on this option, register retiming does not touch any registers that are connected to I/O pins.

Netlist optimizations for physical synthesis and fitting include the following options:
Perform physical synthesis for combinational logic: Directs the Quartus II software to try to increase performance by performing physical synthesis optimizations on combinational logic during fitting.

Perform register duplication: Directs the Quartus II software to increase performance by using register duplication to perform physical synthesis optimizations on registers during fitting.

Perform register retiming: Directs the Quartus II software to increase performance by using register retiming to perform physical synthesis optimizations on registers during fitting.

Physical synthesis effort: Specifies the level of effort used by the Quartus II software when performing physical synthesis (Normal, Extra, and Fast).

The Quartus II software cannot perform these netlist optimizations for fitting and physical synthesis on a back-annotated design. In addition, if you use one or more of these netlist optimizations on a design, and then back-annotate the design, you must generate a Verilog Quartus Mapping File (.vqm) if you wish to save the results. The Verilog Quartus Mapping File must be used in place of the original design source code in future compilations.

---

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Achieving timing closure using netlist optimizations</td>
<td>Netlist Optimizations and Physical Synthesis chapter in volume 2 of the Quartus II Handbook</td>
</tr>
</tbody>
</table>

---

Using LogicLock Regions to Achieve Timing Closure

You can use LogicLock regions to achieve timing closure by analyzing the design in the Timing Closure floorplan, and then constraining critical logic in LogicLock regions. LogicLock regions are generally hierarchical, giving you more control over the placement and performance of modules or groups of modules. You can use the LogicLock feature on individual nodes, for instance, by assigning the nodes along the critical path to a LogicLock region.
Successfully improving performance by using LogicLock regions in a design requires a detailed understanding of the design’s critical paths. Once you have implemented LogicLock regions and attained the desired performance, back-annotate the contents of the region to lock the logic placement.

**Soft LogicLock Regions**

LogicLock regions have predefined boundaries and nodes assigned to a particular region always reside within the boundary or LogicLock region size. Soft LogicLock regions can enhance design performance by removing the fixed rectangular boundaries of LogicLock regions. With the soft region property enabled, the Fitter attempts to place as many assigned nodes in the region as close together as possible, and has the added flexibility of moving nodes outside the soft region to meet a design’s performance requirement.

**Path-Based Assignments**

The Quartus II software enables you to assign specific source and destination paths to LogicLock regions, allowing for easy grouping of critical design nodes into a LogicLock region. You can create path-based assignments with the *Paths* dialog box, by dragging and dropping critical paths from the Timing Analyzer reports and the Timing Closure floorplan into LogicLock regions.

The *Paths* dialog box allows you to specify a path by identifying a source and destination node and using wildcards when identifying nodes. You can click *List Nodes* to determine how many nodes will be assigned to the LogicLock region. You open this dialog box by clicking *Add Path* or double-clicking in the *Contents* tab of the *LogicLock Region Properties* dialog box, or by double-clicking on a path in the Timing Closure floorplan. Figure 5 shows the *Paths* dialog box.
Figure 5. Paths Dialog Box

For Information About | Refer To
--- | ---
Achieving timing closure using the LogicLock methodology | Timing Closure Floorplan chapter in volume 2 of the Quartus II Handbook

LogicLock Design Methodology chapter in volume 2 of the Quartus II Handbook
Using the Design Space Explorer to Achieve Timing Closure

You can use the Design Space Explorer (DSE) to optimize your design for timing. The DSE interface allows you to explore a range of Quartus II options and settings automatically to determine which settings should be used to obtain the best possible result for the project. You can specify the level of change you will allow DSE to make, your optimization goals, the target device, and the allowable compilation time.

You can run the Design Space Explorer from the command line with the `quartus_sh` executable, or from the Quartus II GUI with the Launch Design Space Explorer command on the Tools menu, or with the Quartus II `<version number> Design Space Explorer` command from the Windows Start menu. For more information on using the Design Space Explorer, refer to “Using the Design Space Explorer” on page 113 in Chapter 5, “Place & Route.”

Using Incremental Compilation to Achieve Timing Closure

You can use incremental compilation to achieve timing closure by assigning design partitions, compiling the design, and then to changing the placement of only the critical elements of the design while processing the other design partitions.

For more information about incremental compilation, refer to “Top-Down Incremental Compilation Flow” on page 39 in Chapter 1, “Design Flow,” and “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”
<table>
<thead>
<tr>
<th>What's in Chapter 10:</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>180</td>
</tr>
<tr>
<td>Performing Power Analysis with the PowerPlay Power Analyzer</td>
<td>180</td>
</tr>
<tr>
<td>Specifying Power Analyzer Options</td>
<td>182</td>
</tr>
<tr>
<td>Using the PowerPlay Early Power Estimator</td>
<td>184</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II PowerPlay Power Analysis Tools provide an interface that allows you to estimate static and dynamic power consumption throughout the design cycle. The PowerPlay Power Analyzer performs postfitting power analysis and produces a power report that highlights, by block type and entity, the power consumed. The Altera® PowerPlay Early Power Estimator estimates power consumption at other stages of the design process and produces a Microsoft Excel-based spreadsheet with estimate information.

Figure 1. PowerPlay Power Analysis Flow

Performing Power Analysis with the PowerPlay Power Analyzer

You can use the Quartus II PowerPlay Power Analyzer Tool command in the Processing menu after running Analysis & Synthesis and the Fitter successfully. You can specify whether you want to use an input file, such as a Signal Activity File (.saf) generated by the Quartus II Simulator or a Value Change Dump File (.vcd) generated by another EDA simulation tool, to initialize toggle rates and static probabilities during power analysis, and also whether you want the signal activities used during power analysis to be written to an output file. In addition, you can specify entity-based toggle...
rates and static probabilities using user assignments in the Quartus II user interface or in the Quartus II Settings File (.qsf). For some device families, the Quartus II software will fill in any missing signal activity information by analyzing the design topology and function.

You can then start power analysis by clicking **Start** in the Power Analyzer Tool window—a status bar shows the processing time. When power analysis is complete, you can click **Report** to display the Report File (.rpt, .htm) Figure 2 shows the Power Analyzer Tool window.

**Figure 2. PowerPlay Power Analyzer Tool**

![PowerPlay Power Analyzer Tool](image-url)
Specifying Power Analyzer Options

You can specify default settings for power analysis in the PowerPlay Power Analyzer Settings page, which is available from the Settings dialog box on the Assignments menu. You can specify default settings for what type of input file is used, what type of output file is written, and whether the signal activities are written to the report file, as well as settings for default toggle rates. See Figure 3.
CHAPTER 10: POWER ANALYSIS
SPECIFYING POWER ANALYZER OPTIONS

Figure 3. PowerPlay Power Analyzer Settings Page

Depending on the target device family, you can also specify default operating conditions for power analysis. You can specify the junction temperature, cooling solution requirements, and device characteristics in the Operating Conditions page of the Settings dialog box. See Figure 4.
Using the PowerPlay Early Power Estimator

You can calculate a Stratix™, Stratix II, Stratix GX, Cyclone™, or MAX® II device's power using the Altera PowerPlay Early Power Estimator spreadsheet, which you can download from the Power Consumption section of the Altera web site at [http://www.altera.com/support/devices/estimator/pow-powerplay.html](http://www.altera.com/support/devices/estimator/pow-powerplay.html). The PowerPlay Early Power Estimator spreadsheet is
a Microsoft Excel-based spreadsheet that is specific to the current device family. A macro in the spreadsheet calculates the power estimation and then provides a current (ICC) and power (P) estimation in the spreadsheet.

You can use the PowerPlay Early Power Estimator to estimate power at any stage of the design process; however, Altera recommends that you use the PowerPlay Power Analyzer, rather than the PowerPlay Power Estimator, after the design is complete in order to obtain the most accurate power analysis.

If you use the PowerPlay Early Power Estimator before you start your design, you can specify device resources, operating frequency, toggle rates, and other parameters for the PowerPlay Early Power Estimator. If you use it after you have created a design, you can compile the design in the Quartus II software and then use the **Generate Early Power Calculator File** command in the Power menu to generate a power estimation file, which is a text-based file named `<revision name>_early_pwr.txt` that contains power information for the current device and design. You can then import this power estimation file into the PowerPlay Early Power Estimator.

---

### Using Early Power Estimations

Power calculations that are provided by the PowerPlay Early Power Estimator should be used only as an estimation of power, not as a specification. Be sure to verify the actual ICC during device operation, as this measurement is sensitive to the actual device design and the environmental operating conditions.

---

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the PowerPlay Early Estimator</td>
<td><strong>Power Calculator User Guide</strong> on the Altera web site</td>
</tr>
<tr>
<td></td>
<td><strong>PowerPlay Early Power Estimator</strong> chapter in volume 3 of the <strong>Quartus II Handbook</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Application Note 74 (Evaluating Power for Altera Devices)</strong> on the Altera web site</td>
</tr>
<tr>
<td></td>
<td>“About Power Estimation and Analysis” in Quartus II Help</td>
</tr>
<tr>
<td>Information about device requirements</td>
<td>Individual device handbooks or data sheets on the Altera web site</td>
</tr>
</tbody>
</table>
## What's in Chapter 11:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>187</td>
</tr>
<tr>
<td>Programming One or More Devices With the Programmer</td>
<td>191</td>
</tr>
<tr>
<td>Creating Secondary Programming Files</td>
<td>192</td>
</tr>
<tr>
<td>Using the Quartus II Software to Program Via a Remote JTAG Server</td>
<td>199</td>
</tr>
</tbody>
</table>
Introduction

Once you have successfully compiled a project with the Quartus® II software, you can program or configure an Altera® device. The Assembler module of the Quartus II Compiler generates programming files that the Quartus II Programmer can use to program or configure a device with Altera programming hardware. You can also use a stand-alone version of the Quartus II Programmer to program and configure devices. Figure 1 shows the programming design flow.

**Figure 1. Programming Design Flow**

The Assembler automatically converts the Fitter’s device, logic cell, and pin assignments into a programming image for the device, in the form of one or more Programmer Object Files (.pof) or SRAM Object Files (.sof) for the target device.

You can start a full compilation in the Quartus II software, which includes the Assembler module, or you can run the Assembler separately.
You can also run the Assembler separately at the command prompt or in a script by using the `quartus_asm` executable. You must run the Quartus II Fitter executable, `quartus_fit`, successfully before running the Assembler.

The `quartus_asm` executable creates a separate text-based report file that can be viewed with any text editor.

If you want to get help on the `quartus_asm` executable, type one of the following commands at the command prompt:

```
quartus_asm -h
quartus_asm -help
quartus_asm --help=<topic name>
```

You can also direct the Assembler or Programmer to generate programming files in other formats by using one of the following methods:

- **The Device & Pin Options** dialog box, which is available on the Device page of the Settings dialog box (Assignments menu), allows you to specify optional programming file formats, such as Hexadecimal (Intel-Format) Output Files (.hexout), Tabular Text Files (.ttf), Raw Binary Files (.rbf), Jam™ Files (.jam), Jam Byte-Code Files (.jbc), Serial Vector Format Files (.svf), and In System Configuration Files (.isc).

- **The Create JAM, SVF, or ISC File** command under Create/Update on the File menu generates Jam Files, Jam Byte-Code Files, Serial Vector Format Files, or In System Configuration Files.

- **The Create/Update IPS File** command under Create/Update on the File menu displays the ISP CLAMP State Editor dialog box, which allows you to create or update I/O Pin State Files (.ips) that contain pin state information for specific devices used to configure pin states during programming.

- **The Convert Programming Files** command in the File menu combines and converts SRAM Object Files and Programmer Object Files for one or more designs into other secondary programming file formats, such as Raw Programming Data Files (.rpd), HEXOUT Files for EPC16 or SRAM, Programmer Object Files, Programmer Object Files for Local Update or Remote Update, Raw Binary Files, Tabular Text Files, JTAG Indirect Configuration Files (.jic), and Flash Loader Hexadecimal Files (.flhex).
These secondary programming files can be used in embedded processor-type programming environments, and, for some Altera devices, by other programming hardware.

The Programmer uses the Programmer Object Files and SRAM Object Files generated by the Assembler to program or configure all Altera devices supported by the Quartus II software. You use the Programmer with Altera programming hardware, such as the MasterBlaster™, ByteBlasterMV™, ByteBlaster™ II, USB-Blaster™, or EthernetBlaster download cable; or the Altera Programming Unit (APU).

**Using the Stand-Alone Programmer**

If you want to use only the Quartus II Programmer, you can install the stand-alone version of the Quartus II Programmer, `quartus_pgmw`, instead of installing the complete Quartus II software.

The Programmer allows you to create a Chain Description File (`.cdf`) that contains the name and options of devices used for a design. You can also open a MAX+PLUS II JTAG Chain File (`.jcf`) or FLEX Chain File (`.fcf`) and save it in the Quartus II Programmer as a CDF.

For some programming modes that allow programming or configuring multiple devices, the CDF also specifies top-to-bottom order of the SRAM Object Files, Programmer Object Files, Jam Files, Jam Byte-Code Files, and devices used for a design, as well as the order of the devices in the chain. **Figure 2** shows the Programmer window.

**Figure 2. Programmer Window**
The Programmer has four programming modes:

- Passive Serial mode
- JTAG mode
- Active Serial Programming mode
- In-Socket Programming mode

The Passive Serial and JTAG programming modes allow you to program single or multiple devices using a CDF and Altera programming hardware. You can program a single EPCS1 or EPCS4 serial configuration device using Active Serial Programming mode and Altera programming hardware. You can program a single CPLD or configuration device using In-Socket Programming mode with a CDF and Altera programming hardware.

If you want to use programming hardware that is not available on your computer, but is available via a JTAG server, you can also use the Programmer to specify and connect to remote JTAG servers.

### For Information About

<table>
<thead>
<tr>
<th>General programming information</th>
<th>“Programming Files” glossary definition, “Programming Devices” and “About Programming” in Quartus II Help</th>
</tr>
</thead>
</table>

| Using the Programmer            | The Programming module of the Quartus II Tutorial |

### Using the `quartus_pgm` executable

You can also run the Programmer separately at the command prompt or in a script by using the `quartus_pgm` executable. You may need to run the Assembler executable, `quartus_asm`, in order to produce a programming file before running the Programmer.

If you want to get help on the `quartus_pgm` executable, type one of the following commands at the command prompt:

```
quartus_pgm -h
quartus_pgm -help
quartus_pgm --help=<topic name>
```
Programming One or More Devices With the Programmer

The Quartus II Programmer allows you to edit a CDF, which stores device name, device order, and optional programming file name information for a design. You can use a CDF to program or configure a device with one or more SRAM Object Files, Programmer Object Files, or with a single Jam File or Jam Byte-Code File.

The following steps describe the basic flow for programming one or more devices with the Programmer:

1. Connect Altera programming hardware to your system and install any necessary drivers.

2. Perform a full compilation of the design, or at least run the Analysis & Synthesis, Fitter, and Assembler modules of the Compiler. The Assembler automatically creates SRAM Object Files and Programmer Object Files for the design.

3. Open the Programmer to create a new CDF. Each open Programmer window represents one CDF; you can have multiple CDFs open, but you can program using only one CDF at a time.
4. Select a programming hardware setup. The programming hardware setup you select affects the types of programming modes available in the Programmer.

5. Select an appropriate programming mode, such as Passive Serial mode, JTAG mode, Active Serial Programming mode, or In-Socket Programming mode.

6. Depending on the programming mode, you can add, delete, or change the order of programming files and devices in the CDF. You can direct the Programmer to detect Altera-supported devices in a JTAG Chain automatically and add them to the device list of the CDF. You can also add user-defined devices.

7. For non-SRAM, non-volatile devices, such as configuration devices, MAX 3000, and MAX 7000 devices, you can specify additional programming options to query the device, such as Verify, Blank-Check, Examine, Security Bit, and Erase.

8. If the design has ISP CLAMP State assignments, or if an I/O Pin State File exists for the design, turn on ISP CLAMP.

9. Run the Programmer.

Creating Secondary Programming Files

You can also create secondary programming files in other formats, such as Jam Files, Jam Byte-Code Files, Serial Vector Format Files, In System Configuration Files, Raw Binary Files, Tabular Text Files, or I/O Pin State Files for use by other systems, such as embedded processors. Additionally, you can convert SRAM Object Files or Programmer Object Files into other programming file formats, such as Programmer Object Files for Remote Update, Programmer Object Files for Local Update, HEXOUT Files for EPC16, HEXOUT Files for SRAM, or a Raw Programming Data Files, Tabular Text Files, JIC Files, and Flash Loader Hexadecimal Files. You can create these secondary programming files by using the Create JAM, SVF, or ISC File command under Create/Update on the File menu, the Create/Update IPS File under Create/Update on the File menu, and the Convert Programming Files command on the File menu. You can also use the Programming Files tab of the Device & Pin Options dialog box, which is
available from the Device page in the Settings dialog box on the Assignments menu, to specify optional programming file formats for the Assembler to generate during compilation.

Creating Other Programming File Formats

You can use the Create/Update > Create JAM, SVF, or ISC File command in the File menu to create Jam Files, Jam Byte-Code Files, Serial Vector Format Files, or In System Configuration Files. These files can then be used in conjunction with Altera programming hardware or an intelligent host to configure any Altera device supported by the Quartus II software. You can also add Jam Files and Jam Byte-Code Files to CDFs. See Figure 3.

Figure 3. Create JAM, SVF, or ISC File Dialog Box

You can use the Create/Update > Create/Update IPS File command in the File menu to create I/O Pin State Files that describe the ISP CLAMP state for device pins used at the start of programming. The Create/Update > Create/Update IPS File command opens the ISP CLAMP State Editor dialog box, which is shown in Figure 4.
The following steps describe the basic flow for creating Jam Files, Jam Byte-Code Files, Serial Vector Format Files, In System Configuration Files, or I/O Pin State Files:

1. Perform a full compilation of the design, or at least run the Analysis & Synthesis, Fitter, and Assembler modules of the Compiler. The Assembler automatically creates SRAM Object Files and Programmer Object Files for the design.

2. Open the Programmer window to create a new CDF.

3. Specify JTAG mode.

4. Add, delete, or change the order of programming files and devices in the CDF. You can direct the Programmer to detect Altera-supported devices in a JTAG Chain automatically and add them to the device list of the CDF. You can also add user-defined devices.

5. If you want to create Jam Files, Jam Byte-Code Files, Serial Vector Format Files, or In System Configuration Files, choose Create/Update > Create Jam, SVF, or ISC File in the File menu and specify the name and file format of the file you want to create.

6. If you want to create I/O Pin State Files, choose Create/Update > Create/Update IPS File in the File menu, and in the ISP CLAMP State Editor dialog box in the File menu, specify the appropriate ISP CLAMP state pin settings and specify a name for the file.
Converting Programming Files

You can use the **Convert Programming Files** window from the File menu to combine and convert SRAM Object Files or Programmer Object Files for one or more designs into other programming file formats for use with different configuration schemes. For example, you can add a remote update-enabled SOF to a POF for Remote Update, which is used to program a configuration device in remote update configuration mode, or you can convert a Programmer Object File into a HEXOUT File for EPC16 for use by an external host. Or you can convert a POF into a Raw Programming Data File for use with some configuration devices. You can also convert SRAM Object Files or Programmer Object Files into JTAG Indirect Configuration Files, which you can use to program the configuration data for a Cyclone™ device into an EPCS1 or EPCS4 serial configuration device.

You can use the **Convert Programming Files** dialog box to set up output programming files by arranging the chain of SRAM Object Files stored in a HEXOUT File for SRAM, Programmer Object Files, Raw Binary Files, or Tabular Text Files, or by specifying a POF to be stored in a HEXOUT File for EPC16. The settings you specify in the **Convert Programming Files** dialog box are saved to a Conversion Setup File (.cof) that contains information such as device and file names, device order, device properties, and file options. **Figure 5** shows the **Convert Programming Files** dialog box.
For a POF for an EPC4, EPC8, or EPC16 configuration device, you can also specify the following information:

- Establish different configuration bitstreams, which are stored in pages in the configuration memory space.
- Create parallel chains of SRAM Object Files within each page.
- Arrange the order of SRAM Object Files and Hexadecimal (Intel-Format) Files (.hex) stored in flash memory.
- Specify the properties of **SOF Data** items and HEX Files.
- Add or remove **SOF Data** items from the configuration memory space.
- If you wish, create Memory Map Files (.map).

For Programmer Object Files for Local Update and Programmer Object Files for Remote Update, you can specify the following information:
Add or remove remote update enabled Programmer Object Files and remote update enabled SRAM Object Files from the configuration memory space.

Specify the properties of SOF Data items.

Add or remove SOF Data items.

If you wish, create Memory Map Files, and generate remote update difference files and local update difference files.

You can also use the **Convert Programming Files** dialog box to arrange and combine multiple SRAM Object Files into a single Programmer Object Files in Active Serial Configuration mode. The POF can be used to program an EPCS1 or EPCS4 serial configuration device, which can then be used to configure multiple devices through a Cyclone device.

---

### Using the `quartus_cpf` executable

You can also run the Convert Programming Files feature separately at the command prompt or in a script by using the `quartus_cpf` executable. You may need to run the Assembler executable, `quartus_asm`, in order to produce a programming file before running the Programmer.

If you want to get help on the `quartus_cpf` executable, type one of the following commands at the command prompt:

- `quartus_cpf -h`
- `quartus_cpf -help`
- `quartus_cpf --help=<topic name>`

---

The following steps describe the basic flow for converting programming files:

1. Run the Assembler module of the Compiler. The Assembler automatically creates SRAM Object Files and Programmer Object Files for the design.

2. Use the **Convert Programming Files** dialog box and specify the format and name of the programming file you want to create.

3. Specify a configuration mode that is compatible with the configuration memory space of the programming file.

4. Specify appropriate programming options for the programming file type and target device.
5. (Optional) Direct the Programmer to generate a remote update difference file or a local update difference file for a Programmer Object File for Remote Update or a Programmer Object File for Local Update, by selecting the type of difference file.

6. Add or remove SOF Data items and assign them to pages.

7. (Optional) Add, remove, or change the order of SRAM Object Files and Programmer Object Files to be converted for one or more SOF Data item(s) or POF Data item.

8. (Optional) Add a HEX File to a Bottom Boot Data or Main Block Data item for a POF for an EPC4, EPC8, or EPC16 configuration device, and specify additional properties of SOF Data items, POF Data items, and HEX Files.

9. Save the current state of the Input files to convert list and the output programming file settings in a Conversion Setup File.

10. Convert the file. If you want, you can also specify a Memory Map File to be created.

For Information About Refer To

<table>
<thead>
<tr>
<th>In-system programmability and in-circuit reconfigurability</th>
<th>Configuration Handbook on the Altera web site</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Application Note 100 (In-System Programmability Guidelines) on the Altera web site.</td>
</tr>
<tr>
<td></td>
<td>Application Note 95 (In-System Programmability in MAX Devices) on the Altera web site.</td>
</tr>
<tr>
<td></td>
<td>Application Note 122 (Using Jam STAPL for ISP &amp; ICR via an Embedded Processor) on the Altera web site.</td>
</tr>
<tr>
<td></td>
<td>Application Note 298 (Reconfiguring Excalibur Devices under Processor Control) on the Altera web site</td>
</tr>
<tr>
<td>In-system programming</td>
<td>The Programming module of the Quartus II Tutorial</td>
</tr>
</tbody>
</table>

In-system programmability

In-circuit reconfigurability

Configuration Handbook on the Altera web site

Application Note 100 (In-System Programmability Guidelines) on the Altera web site.

Application Note 95 (In-System Programmability in MAX Devices) on the Altera web site.

Application Note 122 (Using Jam STAPL for ISP & ICR via an Embedded Processor) on the Altera web site.

Application Note 298 (Reconfiguring Excalibur Devices under Processor Control) on the Altera web site.

In-system programming

The Programming module of the Quartus II Tutorial
Using the Quartus II Software to Program Via a Remote JTAG Server

In the Hardware Setup dialog box, which is available from the Hardware button in the Programmer window or from the Edit menu, you can add remote JTAG servers that you can connect to, for example, to use programming hardware that is not available on your computer, and configure local JTAG server settings so remote users can connect to your local JTAG server.

You can specify that remote clients should be enabled to connect to the JTAG server in the Configure Local JTAG Server dialog box, which is available from the JTAG Settings tab of the Hardware Setup dialog box.

You can specify the remote server you want to connect to in the Add Server dialog box, which is available from the JTAG Settings tab of the Hardware Setup dialog box. When you connect to a remote server, the programming hardware that is attached to the remote server will be displayed in the Hardware Settings tab.
### What's in Chapter 12:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>201</td>
</tr>
<tr>
<td>Using the SignalTap II Logic Analyzer</td>
<td>202</td>
</tr>
<tr>
<td>Using SignalProbe</td>
<td>212</td>
</tr>
<tr>
<td>Using the In-System Memory Content Editor</td>
<td>214</td>
</tr>
<tr>
<td>Using the RTL Viewer &amp; Technology Map Viewer</td>
<td>216</td>
</tr>
<tr>
<td>Using the Chip Editor</td>
<td>216</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II SignalTap® II Logic Analyzer, the External Logic Analyzer Interface, and the SignalProbe™ feature enable you to analyze internal device nodes and I/O pins while operating in-system and at system speeds. The SignalTap II Logic Analyzer uses an embedded logic analyzer to route the signal data through the JTAG port to either the SignalTap II Logic Analyzer or an external logic analyzer or oscilloscope, based on user-defined trigger conditions. You can also use a stand-alone version of the SignalTap II Logic Analyzer to capture signals. You can use the External Logic Analyzer Interface to connect an off-chip logic analyzer to nodes in the design. The SignalProbe feature uses incremental routing of unused device routing resources to route selected signals to an external logic analyzer or oscilloscope. Figure 1 and Figure 2 show the SignalTap II and SignalProbe debugging flows.

Figure 1. SignalTap II Debugging Flow

[Diagram showing the SignalTap II debugging flow]
**Using the SignalTap II Logic Analyzer**

The SignalTap II Logic Analyzer is a second-generation system-level debugging tool that captures and displays real-time signal behavior, allowing you to observe interactions between hardware and software in system designs. The Quartus II software allows you to select the signals to capture, when signal capture starts, and how many data samples to capture. You can also select whether the data is routed from the device’s memory blocks to the SignalTap II Logic Analyzer via the JTAG port, or to the I/O pins for use by an external logic analyzer or oscilloscope.

You can use a MasterBlaster™, ByteBlasterMV™, ByteBlaster™ II, USB-Blaster™, or EthernetBlaster communications cable to download configuration data to the device. These cables are also used to upload captured signal data from the device’s RAM resources to the Quartus II software. The Quartus II software then displays data acquired by the SignalTap II Logic Analyzer as waveforms.
Setting Up the SignalTap II Logic Analyzer

To use the SignalTap II Logic Analyzer, you must first create a SignalTap II File (.stp), which includes all the configuration settings and displays the captured signals as a waveform. Once you have set up the SignalTap II File, you can compile the design, program the device, and use the logic analyzer to acquire and analyze data.

Each logic analyzer instance is embedded in the logic on the device. The SignalTap II Logic Analyzer supports up to 1,024 channels and 128K samples on a single device.

After compilation, you can run the SignalTap II Logic Analyzer with the Run Analysis command in the Processing menu.

Using the quartus_stp executable

You can also run the SignalTap II Logic Analyzer separately at the command prompt or in a Tcl or command-line script by using the quartus_stp executable. You must run the quartus_stp executable first to set up the SignalTap II File. You can then run the SignalTap II Logic Analyzer after compilation to capture signals.

If you want to get help on the quartus_stp executable, type one of the following commands at the command prompt:

quartus_stp -h
quartus_stp -help
quartus_stp --help=<topic name>

The following steps describe the basic flow to set up an SignalTap II File and acquire signal data:

1. Create a new SignalTap II File.

2. Add instances to the SignalTap II File and nodes to each instance. You can use the SignalTap II filters in the Node Finder to find all pre-synthesis and post-fitting SignalTap II nodes.

3. Assign a clock to each instance.

4. Set other options, such as sample depth and trigger level, and assign signals to the data/trigger input and debug port.
CHAPTER 12: DEBUGGING
USING THE SIGNALTAP II LOGIC ANALYZER

5. If necessary, specify Advanced Trigger conditions.

6. Compile the design.

7. Program the device.

8. Acquire and analyze signal data in the Quartus II software or with an external logic analyzer or oscilloscope.

Figure 3 shows the SignalTap II Logic Analyzer.

Figure 3. The SignalTap II Logic Analyzer

Using the Stand-Alone SignalTap II Logic Analyzer

If you want to use only the SignalTap II Logic Analyzer, you can use the stand-alone graphical user interface version of the SignalTap II Logic Analyzer, `quartus_stpw`. 
You can use the following features to set up the SignalTap II Logic Analyzer:

- **Instance Manager**: The Instance Manager allows you to create and perform SignalTap II logic analysis on multiple embedded instances of the logic analyzer in each device. You can use it to create, delete, rename, and apply settings to separate and unique logic analyzer instances in the SignalTap II File. The Instance Manager displays all instances in the current SignalTap II File, the current status of each associated instance, and the number of logic elements and memory bits used in the associated instance. The Instance Manager helps you to check the amount of resource usage that each logic analyzer requires on the device. You can start multiple logic analyzers at the same time by selecting them and clicking **Run Analysis** on the Processing menu.

- **Triggers**: A trigger is a pattern of logic events defined by logic levels, clock edges, and logical expressions. The SignalTap II Logic Analyzer supports multilevel triggering, multiple trigger positions, multiple segments, and external trigger events. You can set trigger options in the **Signal Configuration** panel in the SignalTap II Logic Analyzer window and specify advanced triggers by selecting **Advanced** in the **Trigger Levels** column in the **Setup** tab of the SignalTap II Logic Analyzer window.

Advanced triggers provide the ability to build flexible, user-defined logic expressions and conditions based on the data values of internal buses or nodes. On the **Advanced Trigger** tab, you can drag and drop symbols from the **Node List** and the **Object Library** to create a logical expression composed of logical, comparison, bitwise, reduction, shift operators, and event counters. Figure 4 shows the **Advanced Trigger** tab of the SignalTap II window.
Figure 4. Advanced Triggers Tab of the SignalTap II Window

You can configure the logic analyzer with up to ten trigger levels, which helps you view only the most significant data. You can specify four separate trigger positions: pre, center, post, and continuous. The trigger position allows you to specify the amount of data that should be acquired before the trigger and the amount that should be acquired after the trigger.

Segmented mode allows you to capture data for periodic events without allocating a large sample depth by segmenting the memory into discrete time periods.

- **Incremental Routing**: The incremental routing feature helps to shorten the debugging process by allowing you to analyze post-fitting nodes without performing a full recompilation.

Before using the SignalTap II incremental routing feature, you must perform a smart compilation by turning on **Automatically turn on smart compilation if conditions exist in which SignalTap II with incremental routing is used**, in the SignalTap II Logic Analyzer page.
of the Settings dialog box on the Assignments menu. Also, you must reserve trigger or data nodes for SignalTap II incremental routing with the Nodes allocated under Data and Trigger before compiling the design. You can find nodes for SignalTap II incremental routing sources by selecting SignalTap II: post-fitting in the Filter list in the Node Finder.

You can use incremental routing when the design does not use incremental compilation mode. If you want to analyze post-fitting nodes without performing a full recompilation when the project uses incremental compilation, you should use SignalTap II incremental compilation instead. For more information, refer to the next section, “Using the SignalTap II Logic Analyzer with Incremental Compilation.”

**Attaching Programming File:** Allows you to have multiple SignalTap II configurations (trigger setups) and the associated programming files in a single SignalTap II File. You can use the SOF Manager to add, rename, or remove SRAM Object Files (.sof), extract SRAM Object Files from the SignalTap II File, or program the device.

---

**Using the SignalTap II Logic Analyzer with Incremental Compilation**

The incremental compilation feature helps to shorten the debugging process time considerably by allowing you to analyze post-fitting nodes incrementally with the SignalTap II Logic Analyzer without performing a full compilation of the design.

Unlike the incremental routing feature, the incremental compilation feature does not require you to perform a smart compilation, and it can be used when the design uses incremental compilation.

The following steps describe the basic flow for performing a SignalTap II logic analysis with incremental compilation:

1. Make sure that the Full incremental compilation option is turned on in the Compilation Process Settings page of the Settings dialog box (Assignments menu).

2. Remove all design partition assignments.
3. Create and open a SignalTap II File.

4. Turn on the **Incremental Compile** option in the SignalTap II Logic Analyzer Instance Manager next to the instance you want to compile incrementally (see Figure 3 on page 204).

When you use incremental compilation, you must use post-fitting SignalTap II nodes; if the nodes are not post-fitting nodes, the SignalTap II Logic Analyzer converts them to post-fitting nodes when you turn on the **Incremental Compile** option.

5. Run the SignalTap II Logic Analyzer. For the instances that are in incremental mode, any changes will be compiled incrementally, without requiring a full project compilation.

For more information about incremental compilation, refer to “Top-Down Incremental Compilation Flow” on page 39 in Chapter 1, “Design Flow,” and “Performing a Full Incremental Compilation” on page 99 in Chapter 5, “Place & Route.”

---

### For Information About

<table>
<thead>
<tr>
<th>Using Quartus II incremental compilation</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quartus II Incremental Compilation chapter in volume 1 of the <em>Quartus II Handbook</em></td>
<td></td>
</tr>
<tr>
<td>“About Incremental Compilation” in Quartus II Help</td>
<td></td>
</tr>
</tbody>
</table>

---

### Analyzing SignalTap II Data

When you use the SignalTap II Logic Analyzer to view the results of a logic analysis, the data is stored in the internal memory on the device and then streamed to the waveform view in the logic analyzer, via the JTAG port.

In the waveform view, you can insert time bars, align node names, and duplicate nodes; create, rename, and ungroup a bus; specify a data format for bus values; and print the waveform data. The data log that is used to create the waveform shows a history of data that is acquired with the SignalTap II Logic Analyzer. The data is organized in a hierarchical manner; logs of captured data with the same trigger are grouped together in **Trigger Sets**. Figure 5 shows the waveform view.
The **Waveform Export** utility allows you to export the acquired data to the following industry-standard formats that can be used by other tools:

- Comma Separated Values File (.csv)
- Table File (.tbl)
- Value Change Dump File (.vcd)
- Vector Waveform File (.vwf)
- Joint Photographic Experts Group File (.jpeg)
- Bitmap File (.bmp)

You can also configure the SignalTap II Logic Analyzer to create mnemonic tables for a group of signals. The mnemonic table feature allows you to assign a predefined name to a set of bit patterns, so that captured data is more meaningful. See Figure 6.
Figure 6. Mnemonic Table Setup Dialog Box

Using an External Logic Analyzer

The Logic Analyzer Interface is logic within the device you use to connect a large set of internal device signals to a small number of output pins for debugging purposes. The Logic Analyzer Interface enables you to connect to and transmit internal signals buried within your FPGA to an external logic analyzer for analysis. The Quartus II Logic Analyzer Interface allows you to debug a large set of internal signals using a small number of output pins. In the Quartus II Logic Analyzer Interface, the internal signals are grouped together, distributed to a user-configurable multiplexer, and then output to
available I/O pins on your FPGA. Instead of having a one-to-one relationship between internal signals to output pins, the Quartus II Logic Analyzer Interface enables you map many internal signals to a smaller number of output pins. The exact number of internal signals that you can map to an output pin varies based on the multiplexer settings in the Quartus II Logic Analyzer Interface.

To create the Quartus II Logic Analyzer Interface for your design, on the File menu, click New. Click the Other Files tab and select Logic Analyzer Interface File. Click OK.

A new Logic Analyzer Interface File (.lai) appears in the Logic Analyzer Interface Editor window (Figure 7).

**Figure 7. Logic Analyzer Interface Editor**

![Logic Analyzer Interface Editor](image)

Edit the Logic Analyzer Interface File to specify the number of pins to use, the number of banks to use, and the capture mode. In the Output/Capture mode list, specify Combinational/Timing or Registered State. In the Clock box, specify the clock signal associated with the design. In the Power-up state list, select Bank 0 or Tri-stated.

To specify the nodes to be observed, in the Setup View pane, select a bank from the list. Click the table of banks to open the Node Finder to find and use any node name in a Quartus II project after you have performed Analysis &
Elaboration. In the Nodes Found list of the Node Finder, select the node names you want to analyze. Click OK. Connect the probe points from your external logic analyzer to the debug header of your device.

To enable the Logic Analyzer Interface for a project, turn on Enable Logic Analyzer Interface on the Logic Analyzer Interface page of the Settings dialog box on the Assignments menu. In the Logic Analyzer Interface file name box, specify the name of the Logic Analyzer Interface File you want to enable. Click OK, and then program the device.

### Using SignalProbe

The SignalProbe feature allows you to route user-specified signals to output pins without affecting the existing fitting in a design, so that you can debug signals without needing to perform another full compilation. Starting with a fully routed design, you can select and route signals for debugging through I/O pins that were either previously reserved or are currently unused.

The SignalProbe feature allows you to specify which signals in the design to debug, perform a SignalProbe compilation that connects those signals to unused or reserved output pins, and then send the signals to an external logic analyzer. You can use the Node Finder when assigning pins to find the available SignalProbe sources. A SignalProbe compilation typically takes approximately 20% to 30% of the time required for a normal compilation.

To use the SignalProbe feature to reserve pins and perform a SignalProbe compilation on a design:

1. Perform a full compilation of the design.
2. Select signals for debugging and the I/O pins to route the signals, and point to Signal Probe Pins in the Tools menu and click SignalProbe Pins. Figure 8 shows the Signal Probe Pins dialog box.
To perform a SignalProbe compilation, on the Processing menu, point to **Start**, and then click **Start SignalProbe Compilation**. A SignalProbe compilation compiles a design without affecting the design’s fit, and routes the SignalProbe signals faster than a normal compilation.

2. **Configure the device with the new programming data to examine the signals.**

You can also use the register pipelining feature to force signal states to output on a clock edge, or to delay a signal output. You can also use register pipelining to synchronize multiple SignalProbe outputs from a bus of signals.

You can also use the SignalProbe feature with Tcl. With Tcl commands, you can add and remove SignalProbe assignments and sources, perform a SignalProbe compilation on a design, and compile routed SignalProbe signals in a full compilation.
Using the In-System Memory Content Editor

The In-System Memory Content Editor allows you to view and modify, at run-time, RAM, ROM, or register content independently of the system clock of a design. A debug node communicates to the In-System Memory Content Editor through a JTAG interface using standard programming hardware.

You can enable RAM and ROM for the In-System Memory Content Editor with MegaWizard® Plug-In Manager on the Tools menu when generating lpm_rom, lpm_ram_dq, altsyncram, and lpm_constant megafunctions or when instantiating these megafunctions directly in the design, with the lpm_hint megafunction parameter.

The In-System Memory Content Editor captures and updates data in the device. You can export or import data in Memory Initialization File (.mif), Hexadecimal (Intel-Format) File (.hex), and RAM Initialization File (.rif) formats. The In-System Memory Content Editor has the following features:

- **Instance Manager**: contains a list of memory instances, including index, instance name, status, data width, data depth, type, and mode. The Instance Manager controls which memory blocks have data that is viewed, offloaded, or updated. Commands from the Instance Manager affect the entire selected memory block.

- **JTAG Chain Configuration**: allows you to select the programming hardware and device to acquire data from or read data to, and to select the SRAM Object File (.sof) for programming.
HEX Editor: used to make edits and save changes to in-system memory at run-time, to display the current data within the memory block, and to update or offload selected sections of a memory block. You can use the Go To command shortcut to automatically go to a specific data address within a specific memory block within a specific instance. Words are displayed with each hexadecimal value separated by a space. Memory addresses are displayed in the left column, and the ASCII values (if the word width is a multiple of 8) in the right column. Each memory instance has a separate pane in the HEX Editor. Figure 9 shows the HEX Editor in the In-System Memory Content Editor window.

Figure 9. In-System Memory Content Editor Window

For Information About | Refer To
--- | ---
Using the In-System Memory Content Editor | In-System Editing of Memory and Constants chapter in volume 3 of the Quartus II Handbook
“About the In-System Memory Content Editor” in Quartus II Help
Using the RTL Viewer & Technology Map Viewer

You can use the RTL Viewer to analyze your design after analysis and elaboration is complete. The RTL Viewer provides a gate-level schematic view of your design and a hierarchy list, which lists the instances, primitives, pins, and nets for the entire design netlist. You can filter the information that appears in the schematic view and navigate through different pages of the design view to examine your design and determine what changes should be made.

The Quartus II Technology Map Viewer provides a low-level, or atom-level, technology-specific schematic representation of a design. The Technology Map Viewer includes a schematic view, and also includes a hierarchy list, which lists the instances, primitives, pins, and nets for the entire design netlist.

For more information on using the RTL Viewer and the Technology Map Viewer, refer to “Analyzing Synthesis Results With the RTL Viewer and State Machine Viewer” and “Analyzing Synthesis Results with the Technology Map Viewer” on pages 89 and 92 in Chapter 4, “Synthesis.”

Using the Chip Editor

You can use the Chip Editor in conjunction with the SignalTap II and SignalProbe debugging tools to speed up design verification and incrementally fix bugs uncovered during design verification. After you run the SignalTap II Logic Analyzer or verify signals with the SignalProbe feature, you can use the Chip Editor to view details of post-compilation placement and routing. You can also use the Resource Property Editor to make post-compilation edits to the properties and parameters of logic cell, I/O element, or PLL atoms, without requiring a full recompilation. For more information on using the Chip Editor, refer to the next chapter, Chapter 13, “Engineering Change Management.”
# Chapter Thirteen

## Engineering Change Management

### What's in Chapter 13:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>218</td>
</tr>
<tr>
<td>Identifying Delays &amp; Critical Paths With the Chip Editor</td>
<td>219</td>
</tr>
<tr>
<td>Editing Atoms in the Chip Editor</td>
<td>221</td>
</tr>
<tr>
<td>Modifying Resource Properties With the Resource Property Editor</td>
<td>222</td>
</tr>
<tr>
<td>Viewing &amp; Managing Changes with the Change Manager</td>
<td>224</td>
</tr>
<tr>
<td>Verifying the Effect of ECO Changes</td>
<td>225</td>
</tr>
</tbody>
</table>
Introduction

The Quartus® II software allows you to make small modifications, often referred to as engineering change orders (ECO), to a design after a full compilation. These ECO changes can be made directly to the design database, rather than to the source code or the Quartus II Settings and Configuration File (.qsf). Making the ECO change to the design database allows you to avoid running a full compilation in order to implement the change. Figure 1 shows the engineering change management design flow.

**Figure 1. Engineering Change Management Design Flow**

The following steps describe the design flow for engineering change management in the Quartus II software.

1. After a full compilation, use the Chip Editor to view design placement and routing details and identify which resources you want to change.

2. Create, move, and/or remove atoms in the Chip Editor.

3. Use the Resource Property Editor to edit internal properties of resources and to edit or remove connections.

4. Repeat steps 2 and 3 until you have finished making all changes.

5. Use the **Check Resource Properties** command on the Edit menu to check the legality of the change for the resource.

6. View the summary and status of your changes in the Change Manager and control which changes to resource properties are implemented and/or saved. You can also add comments to help you reference each change.
7. Use the **Check & Save All Netlist Changes** command on the Processing menu to check the legality of the change for all of the other resources in the netlist.

8. Run the Assembler to generate a new programming file or run the EDA Netlist Writer again to generate a new netlist. If you want to verify timing changes, you can run timing analysis. If you want to verify that simulations are correct, you can run the Simulator.

---

**Identifying Delays & Critical Paths With the Chip Editor**

You can use the Chip Editor to view details of placement and routing. The Chip Editor reveals additional details about design placement and routing that are not visible in the Quartus II Timing Closure floorplan. It shows complete routing information, showing all possible and used routing paths between each device resource. See **Figure 2**.
The Chip Editor displays all the resources of the device, such as interconnects and routing lines, logic array blocks (LABs), RAM blocks, DSP blocks, I/Os, rows, columns, and the interfaces between blocks and interconnects and other routing lines.

You can control the level of detail of the Chip Editor display by zooming in and out, selecting specific paths you want to display, and displaying a separate Bird’s Eye View window, which shows a full view of the chip, with the portion shown in the regular window denoted by a “view-port” rectangle. You can also set options that control the display of different resources, as well as fan-in and fan-out, critical paths, delay estimates on signals, and Fitter placements. You can then use this information to
determine which properties and settings you may want to edit in the Resource Property Editor. Right-click one or more resources in the Chip Editor and click Locate in Resource Property Editor to open the Resource Property Editor and make edits to the resource(s). Refer to “Modifying Resource Properties With the Resource Property Editor” on page 222 for more information.

Right-click multiple elements and click the Selected Elements Window command to locate to the Resource Property Editor or other editors, and allows you to remove elements from the selection, if desired.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering change management and using the Chip Editor</td>
<td>Engineering Change Management chapter in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>Design Analysis and Engineering Change Management with the Chip Editor chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Using the Chip Editor</td>
<td>“About the Chip Editor” and “About Making Post-Compilation Changes” in Quartus II Help</td>
</tr>
</tbody>
</table>

Editing Atoms in the Chip Editor

The Chip Editor also allows you to create new atoms or move existing atoms to other locations. You can also remove atoms. These changes are reflected in the Change Manager.

To create a new atom, right-click a resource location in the Chip Editor window and click Create Atom. After specifying a new name for the atom, you can then right-click the atom and click Locate in Resource Property command (right button pop-up menu) to modify the properties and connections for the new atom. See the following section, “Modifying Resource Properties With the Resource Property Editor,” for more information.

If you want to move an atom to a new location, you can select the atom and drag it to a new location. To delete an atom, right-click the atom and click Delete. The Check and Save All Netlist Changes command on the Edit menu allows you to save all the changes you have made to atoms.
Modifying Resource Properties
With the Resource Property Editor

The Resource Property Editor allows you to make post-compilation edits to the properties and parameters of logic cell, I/O element, or PLL resources, as well as edit or remove connections for individual nodes. You can use the toolbar buttons that allow you to navigate forward and backward among the resources. You can also select and change multiple resources at one time. In addition, when you point the mouse on a resource port, the Resource Property Editor highlights the fan-in and fan-out for that port.

The Resource Property Editor contains a viewer that shows a schematic diagram of the resource you are modifying, a port connection table that lists all the input and output ports and their connected signals, and a property table that displays the properties and parameters that are available for that resource. If the port connection or property tables are not visible, you can display them with the View Port Connections and View Properties commands (View menu). Figure 3 shows the Resource Property Editor.
You can make changes to the resource in the schematic, the port connection table, or the property table. If you make a change in the port connection table or property table, that change is reflected automatically in the schematic diagram. You can also view equation and cell delay information.

The Resource Property Editor allows you to right-click a node in the schematic or in the port connection table and click **Edit Connection** to specify a new signal for the connection. If you want to remove the connection, you can right-click the node and click **Remove Connection**. In the port connection table, you can create or remove output ports by
right-clicking the port and clicking Create or Remove. In the schematic, you can right-click a node and then specify one or more fan-outs to remove with the Fan-Outs dialog box by pointing to Remove and clicking Fan-Outs.

Once you have made a change, you can use the Check Resource Properties command on the Edit menu to perform simple design-rule checking on the resource. You can also view a summary of your changes in the Change Manager. Refer to the next section, “Viewing & Managing Changes with the Change Manager,” for more information.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering change management and using the Resource Property Editor</td>
<td>Engineering Change Management chapter in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>Design Analysis and Engineering Change Management with the Chip Editor chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Using the Resource Property Editor</td>
<td>“About the Resource Property Editor” and “About Making Post-Compilation Changes” in Quartus II Help</td>
</tr>
</tbody>
</table>

Viewing & Managing Changes with the Change Manager

The Change Manager window lists all the ECO changes that you have made. It allows you to select each ECO change in the list and specify whether you want to apply or delete the change. It also allows you to add comments for your reference. You can open the Change Manager by pointing to Utility Windows on the View menu and clicking Change Manager. See Figure 4.

**Figure 4. Change Manager**

<table>
<thead>
<tr>
<th>Index</th>
<th>Node Name</th>
<th>Change Type</th>
<th>Old Value</th>
<th>Target Value</th>
<th>Current Value</th>
<th>Disk Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>test</td>
<td>New Loc Comb</td>
<td>Name</td>
<td>Exists</td>
<td>Exists</td>
<td>Name</td>
</tr>
<tr>
<td>2</td>
<td>nesi_mandelbrot_top_mandelbrot_sys_inclty</td>
<td>Location Index</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
</tr>
<tr>
<td>3</td>
<td>nesi_mandelbrot_top_mandelbrot_sys_inclty</td>
<td>Location Index</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
</tr>
<tr>
<td>4</td>
<td>nesi_mandelbrot_top_mandelbrot_sys_inclty</td>
<td>Location Index</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
<td>LCCOMB x</td>
</tr>
<tr>
<td>5</td>
<td>nesi_mandelbrot_top_mandelbrot_sys_inclty</td>
<td>Modify Source</td>
<td>Noii_mand...</td>
<td>Disconnected</td>
<td>Disconnected</td>
<td>Disconnected</td>
</tr>
</tbody>
</table>

The log view of the Change Manager displays the following information for each ECO change:
Chapter 13: Engineering Change Management

Verifying the Effect of ECO Changes

- Index
- Node Name
- Change Type
- Old Value
- Target Value
- Current Value
- Disk Value
- Comments (your comments about the ECO change)

Green shading in the Current Value column indicates that the changes have been applied to the current value. Blue shading in the Disk Value column indicates that the changes have been saved successfully to disk.

After you have committed the changes you want, right-click the change and click Check & Save All Netlist Changes to check the legality of the change for all of the other resources in the netlist. You can then perform the following actions on the ECO changes in the list by using commands from the shortcut menu. When you choose one of the commands for exporting, you have the choice of saving the exported data as a Tcl Script File (.tcl), which is a sequence of Chip Editor Tcl commands that can be sourced back into the Quartus II software to reproduce a set of changes if the Change Manager log has been lost or corrupted. You can also save a Comma-Separated Values File (.csv) or a Text File (.txt)—these files contain tabular representations of the data for documentation purposes.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering change management and using the Change Manager</td>
<td>Engineering Change Management chapter in volume 1 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>Design Analysis and Engineering Change Management with the Chip Editor chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Using the Change Manager</td>
<td>“About the Change Manager” and “About Making Post-Compilation Changes” in Quartus II Help</td>
</tr>
</tbody>
</table>

Verifying the Effect of ECO Changes

After you have made an ECO change, you should run the Assembler module of the Compiler in order to create a new Programmer Object File. You may also want to run the EDA Netlist Writer again to generate a new netlist, or...
run timing analysis or the Simulator again to verify that the change results in the appropriate timing improvement. You can run each of these modules separately by using the Compiler Tool window, or by using the `quartus_asm` or `quartus_edad`, `quartus_tan`, `quartus_sta`, and `quartus_sim` executables at the command line or in a script. Performing a full compilation, however, will change the values of the ECO changes.
What's in Chapter 14:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>228</td>
</tr>
<tr>
<td>Using EDA Formal Verification Tools</td>
<td>229</td>
</tr>
<tr>
<td>Specifying Additional Settings</td>
<td>231</td>
</tr>
</tbody>
</table>
Introduction

The Quartus II software allows you to use formal verification EDA tools to verify the logical equivalence between source design files and Quartus II output files. Figure 1 shows the formal verification flow.

Figure 1. Formal Verification Flow

The type of formal verification supported by the Quartus II software is equivalence checking, which compares the functional equivalence of the source design with the revised design by using mathematical techniques rather than by performing simulation using test vectors. Equivalence checking greatly decreases the time to verify the design. The Quartus II software allows you to verify the logical equivalence between the synthesized gate-level Verilog Quartus Mapping Files (.vqm) generated by
an EDA synthesis tool and the Verilog Output Files (.vo) generated by the Quartus II software. For the Cadence Encounter Conformal software, the Quartus II software also allows you to verify the logical equivalence between RTL VHDL design files (.vhd) or Verilog HDL design files (.v) and Quartus II–generated Verilog Output Files. Figure 2 shows which file types are compared in formal verification.

**Figure 2. File Types Compared in Formal Verification**

<table>
<thead>
<tr>
<th>Gate-Level Formal Verification</th>
<th>Quartus II–generated Verilog Output Files (.vo)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verilog Quartus Mapping Files (.vqm)</td>
<td>Compared with</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RTL-Level Formal Verification (Supported for Cadence Encounter Conformal Only)</th>
<th>Quartus II–generated Verilog Output Files (.vo)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTL Verilog HDL or VHDL source design files (.v, .vhd)</td>
<td>Compared with</td>
</tr>
</tbody>
</table>

**Using EDA Formal Verification Tools**

You can use EDA formal verification tools to perform formal verification on your Quartus II designs. The formal verification software compares whether or not the Quartus II software correctly interprets the logic in the VQM File or the source VHDL or Verilog HDL design file during synthesis and fitting.

Table 1 shows the list of EDA formal verification tools that are supported by the Quartus II software.
In the **Formal Verification** page under **EDA Tool Settings** in the **Settings** dialog box on the Assignments menu, you can specify the EDA formal verification tool you will use. See **Figure 3**.

**Figure 3. Formal Verification Page of Settings Dialog Box**

<table>
<thead>
<tr>
<th>Formal Verification Tool Name</th>
<th>Verilog Quartus Mapping File (.vqm) Support</th>
<th>RTL Verilog HDL or VHDL Design File Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadence Encounter Conformal</td>
<td>![Checkmark]</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>Synopsys Formality</td>
<td>![Checkmark]</td>
<td></td>
</tr>
</tbody>
</table>
Specifying Additional Settings

When you are compiling a project to generate files that will be used with formal verification tools, Altera strongly recommends that you turn off the following options:

- The Perform gate-level register retiming option must be turned off in the Synthesis Netlist Optimizations page, which is under Analysis & Synthesis Settings in the Settings dialog box on the Assignments menu.

- The Perform register retiming option must be turned off on the Physical Synthesis Optimizations page, which is under Fitter Settings in the Settings dialog box on the Assignments menu.

Altera recommends that you turn off these options because they often result in moving and merging registers along the critical path, which may affect the registers in cones of logic that the formal verification tools may use as comparison points.
<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional guidelines and options for Cadence Encounter</td>
<td>Cadence Encounter Conformal Support chapter in volume 3 of the Quartus II</td>
</tr>
<tr>
<td>Conformal software</td>
<td></td>
</tr>
<tr>
<td>Additional guidelines and options for using Synopsis</td>
<td>Synopsis Formality Support chapter in volume 3 of the Quartus II Handbook</td>
</tr>
<tr>
<td>Formality software</td>
<td></td>
</tr>
</tbody>
</table>
Chapter Fifteen
System-Level Design

What’s in Chapter 15:

Introduction 234
Creating SOPC Designs with SOPC Builder 236
Creating DSP Designs with the DSP Builder 238
Introduction

The Quartus® II software supports the SOPC Builder and DSP Builder system-level design flows. System-level design flows allow engineers to rapidly design and evaluate system-on-a-programmable-chip (SOPC) architectures and design at a higher level of abstraction.

The SOPC Builder is an automated system development tool that dramatically simplifies the task of creating high-performance SOPC designs. The tool automates the system definition and integration phases of SOPC development completely within the Quartus II software. The SOPC Builder allows you to select system components, define and customize the system, and generate and verify the system before integration. Figure 1 shows the SOPC Builder design flow.

Figure 1. SOPC Builder Design Flow

The Altera® DSP Builder integrates high-level algorithm and HDL development tools by combining the algorithm development, simulation, and verification capabilities of the MathWorks MATLAB and Simulink system-level design tools with VHDL synthesis and simulation tools and the Quartus II software. Figure 2 on page 235 shows the DSP Builder design flow.
**Figure 2. DSP Builder Design Flow**

```
DSP Builder → MATLAB/ Simulink → SignalCompiler

DSP block ready for SOPC Builder

Simulation test benches & Tcl Script Files

Verilog design files, VHDL design files (.v, .vhdl) & Tcl Script Files (.tcl)

Quartus II Analysis & Synthesis **quartus_map**

EDA Synthesis Tool

ModelSim/ ModelSim-Altera Simulator

SOPC Builder

Quartus II Fitter **quartus_fit**

Quartus II EDA Netlist Writer **quartus_eda**

Quartus II Assembler **quartus_asm**

Programmer Object File (.pof)

Altera Programming Software and Hardware

Quartus II Simulator **quartus_sim**

Other EDA Simulation Tool

Intellectual property (IP)
```

Creating SOPC Designs with SOPC Builder

The SOPC Builder, which is included with the Quartus II software, provides a standardized, graphical environment for creating SOPC designs composed of components such as CPUs, memory interfaces, standard peripherals, and user-defined peripherals. The SOPC Builder allows you to select and customize the individual components and interfaces of your system module. SOPC Builder combines these components and generates a single system module that instantiates these components, and automatically generates the necessary bus logic to connect them together.

The SOPC Builder library includes the following components:

- Processors
- Intellectual property (IP) and peripherals
- Memory interfaces
- Communications peripherals
- Buses and interfaces, including the Avalon™ interface
- Digital signal processing (DSP) cores
- Software
- Header files
- Generic C drivers
- Operating system (OS) kernels

You can use SOPC Builder to construct embedded microprocessor systems that include CPUs, memory interfaces, and I/O peripherals; however, you can also generate dataflow systems that do not include a CPU. It allows you to specify system topologies with multiple masters and slaves. SOPC Builder can also import or provide an interface to user-defined blocks of logic that are connected to the system as custom peripherals.

Creating the System

When building a system in SOPC Builder, you can choose either user-defined modules or modules available from the module pool component library.
SOPC Builder can import or provide an interface to user-defined blocks of logic. There are four mechanisms for using an SOPC Builder system with user-defined logic: simple PIO connection, instantiation inside the system module, bus interface to external logic, and publishing a local SOPC Builder component.

SOPC Builder provides library components (modules) for download, including processors, such as the Nios® II processor, a UART, a timer, a PIO, an Avalon tri-state bridge, several simple memory interfaces, and OS/RTOS kernels. In addition, you can choose from an array of MegaCore® functions, including those that support the OpenCore® Plus hardware evaluation feature.

You can use the System Contents page of SOPC Builder to define the system. You can select library components in the module pool and display the added components in the module table.

You can use the information in the module table of the System Contents page or in a separate wizard to define the following component options:

- System components and interfaces
- Master and slave connections
- System address map
- System IRQ assignments
- Arbitration priorities for shared slaves
- Multiple master and slave clock domains

**Generating the System**

Each project in SOPC Builder contains a system description file (PTF File), which contains all the settings, options, and parameters entered in the SOPC Builder. In addition, each component has a corresponding PTF File. During system generation, the SOPC Builder uses these files to generate the source code, software components, and simulation files for the system.

Once system definition is complete, you can generate the system using the System Generation page of SOPC Builder.

The SOPC Builder software automatically generates all necessary logic to integrate processors, peripherals, memories, buses, arbitrators, IP functions, and interfaces to logic and memory outside the system across multiple clock domains; and creates HDL source code that binds the components together.
SOPC Builder can also create software development kit (SDK) software components, such as header files, generic peripheral drivers, custom software libraries, and OS/real-time operating system (RTOS kernels), to provide a complete design environment when the system is generated.

For simulation, SOPC Builder creates a Mentor Graphics® ModelSim® simulation directory that contains a ModelSim project file, the simulation data files for all memory components, macro files to provide setup information, aliases, and an initial set of bus-interface waveforms. It also creates a simulation test bench that instantiates the system module, drives clock and reset inputs, and instantiates and connects simulation models.

A Tcl script that sets up all the files necessary for compilation of the system in the Quartus II software is also generated.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using SOPC Builder</td>
<td>SOPC Builder chapter in volume 4 of the Quartus II Handbook</td>
</tr>
<tr>
<td></td>
<td>Application Note 333 (Developing Peripherals for SOPC Builder) on the Altera web site</td>
</tr>
<tr>
<td></td>
<td>“About SOPC Builder” in Quartus II Help</td>
</tr>
</tbody>
</table>

Creating DSP Designs with the DSP Builder

The DSP Builder shortens DSP design cycles by helping you create the hardware representation of a DSP design in an algorithm-friendly development environment. The DSP Builder allows system, algorithm, and hardware designers to share a common development platform. The DSP Builder is an optional software package available from Altera, and is also included with DSP Development Kits.

The DSP Builder also provides support for system-level debugging using the SignalTap® II block or the Hardware in the Loop (HIL) block. You can synthesize, compile and download the design, and then perform debugging, all through the MATLAB/Simulink interface. The Hardware in the Loop block to your Simulink model allows you to co-simulate a Quartus® II
software design with a physical FPGA board implementing a portion of that design. You define the contents and function of the FPGA by creating and compiling a Quartus II project. A simple JTAG interface between Simulink and the FPGA board links the two.

**Instantiating Functions**

You can combine existing MATLAB functions and Simulink blocks with Altera DSP Builder blocks and MegaCore functions, including those that support the OpenCore Plus hardware evaluation feature, to link system-level design and implementation with DSP algorithm development.

To use MegaCore functions that support the OpenCore Plus feature in your design, you must download them before running the MATLAB/Simulink environment.

**Generating Simulation Files**

After verifying the design in the Simulink software, you can use the DSP Builder SignalCompiler block to generate files for simulating the design in EDA simulation tools.

The SignalCompiler block translates a DSP Builder Simulink model into a VHDL or Verilog model and generates a Verilog HDL or VHDL test bench file that imports the Simulink input stimuli. You can use the Tcl script for automated simulation in the ModelSim software, or simulate in another EDA simulation tool with the Verilog HDL or VHDL test bench file.

**Generating Files for Synthesis**

DSP Builder provides two synthesis and compilation flows: automated and manual. You can use the Quartus II software to synthesize the design, or you can use the Tcl script generated by the DSP Builder SignalCompiler block to synthesize the design in Mentor Graphics Leonardo Spectrum or The Synplicity Synplify software. If the DSP Builder design is the top-level design, you can use either the automated or manual synthesis flows. If the DSP Builder design is not the top-level design, you must use the manual synthesis flow.
You can use the automated flow to control the entire synthesis and compilation flow from within the MATLAB/Simulink design environment. The SignalCompiler block creates VHDL Design Files and Tcl scripts, performs synthesis in the Quartus II, LeonardoSpectrum, or Synplify software, compiles the design in the Quartus II software, and can also optionally download the design to a DSP development board. You can specify which synthesis tool to use for the design from within the Simulink software.

In the manual flow, the SignalCompiler block generates VHDL Design Files and Tcl scripts that you can then use to perform synthesis manually in an EDA synthesis tool, or the Quartus II software, which allows you to specify your own synthesis or compilation settings. When generating output files, the SignalCompiler block maps each Altera DSP Builder block to the VHDL library. MegaCore functions are treated as black boxes.

<table>
<thead>
<tr>
<th>For Information About</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the DSP Builder</td>
<td><a href="https://www.altera.com">DSP Builder User Guide</a> on the Altera website</td>
</tr>
</tbody>
</table>
Chapter Sixteen
Installation, Licensing & Technical Support

What's in Chapter 16:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing the Quartus II Software</td>
<td>242</td>
</tr>
<tr>
<td>Licensing the Quartus II Software</td>
<td>242</td>
</tr>
<tr>
<td>Getting Technical Support</td>
<td>245</td>
</tr>
</tbody>
</table>
Installing the Quartus II Software

You can install the Quartus® II software on the following platforms:

- Pentium III (400 MHz or faster) based computer, running one of the following Windows operating systems:
  - Microsoft Windows 2000
  - Microsoft Windows XP

- Opteron (AMD) or EM64T PC, running Microsoft Windows XP Professional x64 Edition

- Pentium III (400 MHz or faster), Pentium 4 (400 MHz or faster), or AMD64/EM64T based computer running one of the following Linux operating systems:
  - Red Hat Enterprise Linux 3.0 (32-bit or 64-bit)
  - Red Hat Enterprise Linux 4.0 (32-bit or 64-bit)

- Sun Ultra workstation running Solaris version 8 or 9

Licensing the Quartus II Software

To use Altera®-provided software, you need to obtain and set up an Altera subscription license. An Altera subscription enables the following software:

- Altera Quartus II software
- Mentor Graphics® ModelSim®-Altera software
Altera offers several types of software subscriptions. Table 1 shows the different license and subscription options that are available.

**Table 1. Altera License and Subscription Options**

<table>
<thead>
<tr>
<th>License Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIXEDPC</td>
<td>A stand-alone PC license tied to a USB Software Guard or Parallel Port Software Guard (T-guard or &quot;dongle&quot;)</td>
</tr>
<tr>
<td>FLOATPC</td>
<td>A floating network license for PC users with either a PC or UNIX license server</td>
</tr>
<tr>
<td>FLOATNET</td>
<td>A floating network license for PC, Solaris, and HP-UX users that are using a PC, Solaris, or HP-UX license server</td>
</tr>
<tr>
<td>FLOATLNX</td>
<td>A floating network license for PC users that are running Red Hat Linux and using either a PC, UNIX, or Linux license server</td>
</tr>
</tbody>
</table>

Customers who purchase selected development kits receive a free version of the Quartus II software for the PC and are given instructions on how to obtain a license for the software.

The following steps describe the basic flow for licensing your software:

1. When you start the Quartus II software, if the software cannot detect a valid ASCII text license file, **license.dat**, you will see a prompt with the following options:

   - **Enable 30-day evaluation period with no license file (no programming file support)**. This option allows you to evaluate the Quartus II software, without programming file support, for 30 days. After the 30-day grace period is over, you must obtain a valid license file from the Licensing section of the Altera web site at www.altera.com/licensing, and then follow the remaining steps in this procedure.
Perform automatic web license retrieval. Selecting this option requests a valid license file automatically from the Altera web site. If you are using a node-locked (FIXEDPC) license and the Quartus II software is able to retrieve a license file successfully from the web site, you can skip the remaining steps of this procedure. If you are using a network (multiuser) license, or if the Quartus II software is not able to retrieve a license file, you are guided through the licensing procedure.

Specify valid license file. If you have a valid license file but have not specified the location of the license file, selecting this option displays the License Setup page of the Options dialog box (Tools menu). It will give you an option to Specify valid license file or Use LM_LICENSE_FILE variable. You can also specify the license file or LM_LICENSE_FILE variable in your System control panel for Windows 2000 or Windows XP, or in your .cshrc file for UNIX and Linux workstations. If you select this option, you can skip the remaining steps of the procedure.

2. If you are requesting a new license file, in the Licensing section of the Altera web site, choose the link for the appropriate license type. Refer to Table 1 on page 243.

3. Specify the requested information.

4. After you receive a license file by e-mail, save it to a directory on your system.

5. If necessary, modify the license file for your license.

6. Set up and configure the FLEXlm license manager server for your system.
Getting Technical Support

The easiest way to get technical support is to use the mySupport web site and register for an Altera.com account. Your copy of the Quartus II software is registered at the time of purchase; however, in order to use the mySupport web site to view and submit service requests, you must also register for an Altera.com account. An Altera.com account is required only for using the mySupport web site; however, having an Altera.com account will also make it easier for you to use many other Altera web site features, such as the Download Center, Licensing Center, Altera Technical Training online class registration, or Buy On-Line-Altera eStore features.

To register for an Altera.com account user name and password, follow these steps:

1. Go to the mySupport web site:

   ✔ To start your web browser and connect to the mySupport web site while running the Quartus II software, on the Help menu point to Altera on the Web and click Quartz II Home Page.

   or

   ✔ Point your web browser to the mySupport web site at www.altera.com/mysupport.

2. Follow the instructions on the mySupport web site to register for an Altera.com account.
If you are not a current Altera subscription user, you can still register for an Altera.com account.

For information about other technical support resources, refer to Table 2.

**Table 2. Quartus II Technical Support Resources**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altera website</td>
<td><a href="http://www.altera.com">www.altera.com</a></td>
</tr>
<tr>
<td></td>
<td>The Altera web site provides information on Altera and all of its products.</td>
</tr>
<tr>
<td>Support Center</td>
<td><a href="http://www.altera.com/support">www.altera.com/support</a></td>
</tr>
<tr>
<td></td>
<td>The Support Center section of the Altera web site gives you access to the</td>
</tr>
<tr>
<td></td>
<td>mySupport web site, and also provides Altera Find Answers. In addition, it</td>
</tr>
<tr>
<td></td>
<td>provides software and device support information as well as design examples</td>
</tr>
<tr>
<td></td>
<td>that you can integrate into your design.</td>
</tr>
<tr>
<td>mySupport web site</td>
<td><a href="http://www.altera.com/mysupport">www.altera.com/mysupport</a> or choose Altera on the Web &gt; Quartus II Home</td>
</tr>
<tr>
<td></td>
<td>Page (Help menu) in the Quartus II software.</td>
</tr>
<tr>
<td></td>
<td>The mySupport web site allows you to submit, view, and update technical</td>
</tr>
<tr>
<td></td>
<td>support service requests.</td>
</tr>
<tr>
<td>Altera Find Answers</td>
<td><a href="http://www.altera.com/answers">www.altera.com/answers</a></td>
</tr>
<tr>
<td></td>
<td>Altera Find Answers uses natural language processing technology (NLP) to</td>
</tr>
<tr>
<td></td>
<td>analyze the meaning and context of your question and provide an answer.</td>
</tr>
<tr>
<td></td>
<td>Unlike simple search engines that return lists of documents in response to</td>
</tr>
<tr>
<td></td>
<td>keyword queries, Altera Find Answers delivers the actual answer.</td>
</tr>
<tr>
<td>Telephone</td>
<td>(800) 800-EPLD</td>
</tr>
<tr>
<td></td>
<td>(7:00 a.m. to 5:00 p.m. Pacific time, M–F)</td>
</tr>
<tr>
<td></td>
<td>You will need your 6-digit Altera ID to access the hotline.</td>
</tr>
<tr>
<td></td>
<td>(408) 544-8767</td>
</tr>
<tr>
<td></td>
<td>(7:00 a.m. to 5:00 p.m. Pacific time, M–F)</td>
</tr>
</tbody>
</table>
What's in Chapter 17:

- Getting Online Help 248
- Using the Quartus II Online Tutorial 249
- Other Quartus II Software Documentation 250
- Other Altera Literature 251
Getting Online Help

The Quartus® II software includes a platform-independent Help system that provides comprehensive documentation for the Quartus II software and more details about the specific messages generated by the Quartus II software. You can view Help in one of the following ways:

**To search through a list of Help topics by keyword** Click Index on the Help menu to perform a search with the **Index** tab.

**To search through the full text of the Help system** Click Search on the Help menu to perform a search with the **Search** tab.

**To search an outline of Help topic categories** Click Contents on the Help menu to view the **Contents** tab.

**To add topics to your Favorites list** Open the Quartus II Help topic that you want to add to your list of favorite topics. Click the **Favorites** tab and then click **Add** to add the topic to your Favorites list.

**To view help on a message** Right-click the message on which you want to receive Help, and click **Help**. You can also use the **Messages** command on the Help menu for a scrollable list of all messages.

**To get Help on a menu command or dialog box** Press F1 from a highlighted menu command or active dialog box for context-sensitive Help on that item.

**To find a definition of a term** Click **Glossary** on the Help menu to view the Glossary list.

---

**Working with Help Topics**

To print Help topics from the **Contents** tab, right-click the Help folder or individual Help topic that you want to print, and choose **Print** or click the **Print** button on the toolbar. If you select a Help folder to print, you can choose to print all the topics in the folder. You can also use the **Print** command or **Print** button to print any individual Help topic you are viewing.

To search for a keyword in an open Quartus II Help topic, press Ctrl+F to open the **Find** dialog box, and type the search text, and then click **Find Next**.
Using the Quartus II Online Tutorial

The online tutorial introduces you to the basic features of the Quartus II design software. It shows you how to create and process your own logic designs quickly and easily. The tutorial modules guide you through the steps required to create, perform timing analysis on, simulate, and program a sample finite impulse response (FIR) filter design, called \texttt{fir\_filter}.

To start the Quartus II tutorial after you have successfully installed the Quartus II software:

- On the Help menu, click \textit{Tutorial}.

After you start the tutorial, the Quartus II window resizes to allow you to view the Tutorial window and the Quartus II software simultaneously.

### More Information About Using the Quartus II Tutorial

You must have installed support for Cyclone™ EP1C6 devices if you want to complete the tutorial.

The tutorial is designed for display online. However, if you want to print one or more of the tutorial modules, click the \textbf{Printing Options} button located at the beginning of each module and then click the link to open the appropriate printable version.
Table 1 shows the additional software documentation that is available for the Quartus II software:

### Table 1. Additional Quartus II Documentation (Part 1 of 2)

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Where to Find It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quartus II Software Release Notes</td>
<td>Provides late-breaking information about new features, device support, EDA interface support, and known issues and workarounds</td>
<td>The Altera® web site</td>
</tr>
<tr>
<td>Quartus II Device Support Release Notes</td>
<td>Quartus II Device Support Release Notes - provides information about changes to device support, including changes to timing, simulation, and power models</td>
<td>The Altera web site</td>
</tr>
<tr>
<td>Quartus II Installation &amp; Licensing for PCs manual</td>
<td>Provides detailed information about software requirements, installation, and licensing for PCs</td>
<td>In Quartus II subscription packages and on the Altera web site</td>
</tr>
<tr>
<td>Quartus II Installation &amp; Licensing for UNIX and Linux Workstations manual</td>
<td>Provides detailed information about software requirements, installation, and licensing for UNIX and Linux workstations</td>
<td>In Quartus II subscription packages and on the Altera web site</td>
</tr>
<tr>
<td>Quartus II readme.txt file</td>
<td>Provides information about memory, disk space, and system requirements</td>
<td>On Quartus II software CD-ROMs and installed with the Quartus II software</td>
</tr>
</tbody>
</table>
### Other Altera Literature

The Literature section of the Altera web site at [www.altera.com](http://www.altera.com) provides documentation on many subjects that are related to the Quartus II software.

Altera provides literature that includes some of the following topics:

- Quartus II features and guidelines on using these features with your design flow
- Altera device features, functions, structure, specifications, configuration, and pin-outs
- Design solutions and methodologies
- Implementing device features
- Altera programming hardware features, use, and installation
- Using the Quartus II software with other EDA tools
- Using other Altera software tools
- Implementing IP MegaCore® functions and Altera megafUNCTIONs
- Optimizing designs or improving performance
- Synthesis, simulation, and verification guidelines
- Product updates and notifications

The literature that is available from the Altera web site is the most current information about Altera products and features; it is updated frequently, even after a product has been released. Altera continues to add new literature in order to provide more information on the latest features of Altera tools and devices, and to provide additional information that Altera customers have requested.

---

### Table 1. Additional Quartus II Documentation (Part 2 of 2)

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Where to Find It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quartus II Scripting Reference Manual</td>
<td>Provides information about command-line and Tcl commands and scripting.</td>
<td>On the Altera web site</td>
</tr>
<tr>
<td><strong>Quartus II Software Quick Start Guide</strong></td>
<td>Shows how to set up your project, set timing requirements, and compile your project for a target device</td>
<td>In Quartus II subscription packages and on the Altera web site</td>
</tr>
</tbody>
</table>
Searching through Altera Literature with Altera Find Answers

You can use Altera Find Answers, which is available from the Support Center section of the Altera web site at www.altera.com/answers, to search through all the literature that is available on the Altera web site. Altera Find Answers uses natural language processing technology (NLP) to analyze the meaning and context of your question and provide an answer. Unlike simple search engines that return lists of documents in response to keyword queries, Altera Find Answers delivers the actual answer.
Index

A

AHDL 55
AHDL Include Files (.inc) 53
Altera Find Answers 246
Altera Hardware Description Language (AHDL) 55
Altera Megafuction Partners Program (AMPP) 57
Altera on the Web command 245
Altera Programming Unit (APU) 189
Altera web site 246
Altera.com account 246
AMPP 57
Analysis & Elaboration 76, 89
Analysis & Synthesis 12
design flow 76
Integrated Synthesis 77
netlist optimization 83
performing with EDA tools 80
VHDL and Verilog HDL support 77
Analysis & Synthesis Settings page 84, 173
APU 189
Assembler 12, 187, 189
Assign SignalProbe Pins dialog box 212
Assignment Editor 66, 107
Assignment Editor command 107
assignments
importing 73
location 107
making 65, 171
path-based 176
verifying 74
viewing 169
attributes 83
Avalon interface 236

B

Back-Annotate Assignments command 171
back-annotation 117, 171
batch files 29
black-box methodology 61
Block Design Files (.bdf) 52, 53
Block Editor 53
Block Symbol Files (.bsf) 53, 54
block-based design 40
Board-Level page 163
ByteBlaster II download cable 189, 202
ByteBlasterMV download cable 189, 202

C

Chain Description Files (.cdf) 189, 191
change management design flow 218
Check Resource Properties command 224
Chip Editor 106, 216, 219, 221
Classic Timing Analyzer 145
clear box methodology 62
command-line executables 23
Comma-Separated Value Files (.csv) 66, 209
compilation flows 13, 28
compilation, incremental 39, 70, 126, 207
Compiler

compilation flows 13, 28
modules 12
specifying settings 69
starting 12
status 98
Compiler Database Interface 12
compiler directives 83
configuring 187
Convert MAX+PLUS II Project command 51
Convert Programming Files command 188, 192
Copy Project command 45
Create command 223
Create/Update > Create Jam, SVF, or ISC File command 188, 192
Create/Update > Create/Update IPS File command 188, 192, 193
Create/Update command 54, 55
critical paths 170
Customize dialog box 14, 15
customizing look and feel 14

D
debugging see SignalTap II Logic Analyzer; SignalProbe feature
Design Assistant 12, 87, 107
Design Assistant page 87
design constraints 65
design entry 43
design partitions 70, 71, 126
Design Partitions window 70, 71
Design Space Explorer 113, 178
devices, programming and configuring 187
documentation conventions 7
DSE 113, 178
dse.tcl Tcl script 113, 178
DSP Builder 234, 238
creating designs 238
design flow 235
generating simulation files 239
generating synthesis files 239
instantiating functions 239
SignalCompiler block 239
using with other EDA tools 239

E
Early Timing Estimate page 156
early timing estimate, performing 156
ECOs 218
creating 222
verifying 225
EDA interfaces 18, 32
EDA Netlist Writer 12, 132, 134, 164
EDA Tool Settings page 21, 81, 230
EDA tools
formal verification 229
functional simulation 135
minimum timing analysis 163
power estimation 134
simulation 132
specifying settings 21, 69, 81, 133, 230
starting synthesis tools 82
supported tools 20, 81, 132, 163, 230
synthesis 80
timing analysis 163
timing simulation 136
EDIF Input Files (.edf) 52
EDIF netlist files (.edf) 76, 80
Edit Connection command 223
evaluation of timing 178
Engineering Change Orders see ECOs
EthernetBlaster download cable 189
executables 23
Export Database command 50

F
Field View command 169
Files page 44
Fitter 12, 97
Fitter Settings page 108
fitting
analyzing 100
design flow 97
optimization 107, 174
performing an early timing estimate 156
Flash Loader Hexadecimal File (.flhex) 188
FLEX Chain File (.fcf) 189
Floorplan Editor see Timing Closure
floorplan
flows for compilation 13, 28
formal verification
design flow 228
performing with EDA tools 229
specifying settings 231
full compilation 12
functional simulation
EDA tools 135
Quartus II Simulator 139
INDEX

G
Graphic Design Files (.gdf) 52, 53
Graphic Editor see Block Editor
graphical user interface 11

H
Help, getting 248
Hexadecimal (Intel-Format) Files (.hex) 196
Hexadecimal (Intel-Format) Output Files (.hexout) 188, 192, 195
Hierarchy Display see Project Navigator

I
I/O Pin State Files (.ips) 188, 192, 193
Import Assignments command 73
Import Database command 50
In System Configuration Files (.isc) 188, 189, 192
incremental compilation 39, 70, 126, 207
incremental synthesis 39, 70, 94
Integrated Synthesis 77
Intellectual Property (IP) functions 56
ISP CLAMP State Editor dialog box 188, 192, 193

J
Jam Byte-Code Files (.jbc) 188, 189, 191, 192
Jam Files (.jam) 188, 189, 191, 192
Jam STAPL Byte Code Format File (.jbc) see Jam Byte-Code Files (.jbc)
JEDEC STAPL Format File (.jam) see Jam Files (.jam)
JTAG Chain File (.jcf) 189
JTAG Indirect Configuration Files (.jic) 188
JTAG port 201

L
Launch Design Space Explorer command 113, 178
layout, customizing 14
Library Mapping Files (.lmf) 77
library of parameterized modules (LPM) functions 56
List Paths command 160
list_path Tcl command 161
LMFs 77
Locate in Timing Closure Floorplan command 160
location assignments 107
logic options 84, 109
LogicLock 121, 122
block-based design flow 121
using with Tcl 125
LogicLock Region Properties dialog box 107
LogicLock regions 122
achieving timing closure 175
path-based assignments 176
properties 123
soft LogicLock regions 176
viewing connectivity 170
viewing intra-region delay 170
LogicLock Regions window 124
LogicLock Regions Window command 123
look and feel, customizing 14
LPM 56

M
makefile support 35
MasterBlaster download cable 189, 202
MATLAB/Simulink environment 239
MAX+PLUS II Assignment & Configuration Files (.acf) 73
MAX+PLUS II look and feel 14
MAX+PLUS II quick menu 15
MAX+PLUS II Simulator Channel Files (.scf) 142
MAX+PLUS II Symbol Files (.sym) 54
MegaCore functions 57
megafonctions 56
inferring 60, 62
instantiating 56, 60, 78
instantiating in other EDA tools 61, 78

ALTERA CORPORATION

INTRODUCTION TO QUARTUS II □ 255
INDEX

MegaWizard Plug-In Manager 56
  qmegawiz executable 25
    stand-alone version 25
    using with black-box methodology 61
    using with clear box methodology 62
Memory Editor 135
Memory Initialization Files (.mif) 135
Messages window 100
minimum timing analysis 145, 154
modules of the Compiler 12
mySupport web site 245, 246

N
NativeLink 135, 165
netlist optimization
  achieving timing closure 173
  fitting 174
  physical synthesis 174
  synthesis 83, 86, 173
New Project Wizard 44

O
OpenCore hardware evaluation feature 58
OpenCore Plus hardware evaluation feature 58
Operating Conditions page 183

P
partitions 39, 70, 71, 126
Path dialog box 176
path-based assignments 176
Perl scripts 29
Physical Synthesis Optimizations page 109, 173
physical synthesis, optimization 109, 174
physical timing estimates 169
Pin Planner 67
place and route
  see also fitting
design flow 97
POFs 187, 191, 192
power analysis 180
PowerPlay Early Power Estimator 184
PowerPlay Power Analyzer 180
PowerPlay Power Analyzer Tool 182
power estimation data, generating for EDA tools 134
Power Input Files (.pwf) 134
PowerFit Fitter 97
PowerPlay Early Power Estimator 180, 184
PowerPlay Power Analyzer Settings page 182
PowerPlay Power Analyzer Tool 180, 182
PowerPlay Power Analyzer Tool command 180
Print All Recommendations command 113
Print Recommendation command 113
Priority dialog box 124
Programmer 187
  quartus_pgm executable 190
  quartus_pgmw executable 25
    stand-alone version 25, 189
Programmer Object Files (.pof) 187, 191, 192
programming 187
design flow 187
programming hardware 189
programming files
  converting 188, 192
  creating secondary 192
Programming Files tab 192
Project Navigator window 45

Q
qmegawiz executable 25
QSF 44, 123, 152
Quartus II Default Settings Files (.qdf) 44
Quartus II look and feel 14
Quartus II Project Files (.qpf) 44
Quartus II quick menu 15
Quartus II Settings Files (.qsf) 44, 123, 152
Quartus II software
  command-line design flow 23
  EDA tool design flow 18, 32
general design flow 10
  GUI design flow 11
Quartus II Tutorial 249
Quartus II Workspace Files (.qws) 44
quartus_asm executable 25, 188
quartus_cdb executable 26, 50
quartus_cpf executable 26, 197
quartus_drc executable 25, 88
quartus_edda executable 25, 134, 165
quartus_fit executable 25, 98
quartus_map executable 25, 77
quartus_pgm executable 26, 190
quartus_pgmw executable 25, 189
quartus_pow executable 26, 182
quartus_sh executable 26
quartus_sim executable 26, 141
quartus_sta executable 25
quartus_stpf executable 26, 203
quartus_stpw executable 25, 204
quartus_tan executable 25, 155
quick menus 15

R

RAM Initialization Files (.rif) 135
Raw Binary Files (.rbf) 188, 192
Regions window 108
Remove Connection command 223
Report window 102, 158
Resource Optimization Advisor 110
Resource Property Editor 216, 222
revisions 46
Revisions dialog box 46
rout 97
congestion 170
connection counts 169
critical paths 170
delays 169
RTL Viewer 89, 216
Run EDA Simulation Tool command 134
Run EDA Timing Analysis Tool command 164

S

Selected Elements Window command 221
Serial Vector Format Files (.svf) 188, 189, 192
Set as Design Partition command 71
settings
Analysis & Synthesis 84
Compiler 69
Design Assistant 87
EDA tools 21, 81, 133, 230
Fitter 108
Fitter optimization 174
formal verification 231
HardCopy 69
physical synthesis optimization 109
PowerPlay Power Analyzer 182
Quartus II Project Files (.qpf) 44
Quartus II Settings Files (.qsf) 44
SignalProbe 212
SignalTap II Logic Analyzer 203, 206
Simulator 69, 140
Software Builder 69
synthesis optimization 86, 173
Timing Analyzer 69
Verilog HDL input 77
VHDL input 77
Settings dialog box 69, 107
shell, Tcl scripting 26
Shop Altera web site 251
Signal Activity Files (.saf) 131, 135, 180
SignalProbe feature 201, 212
compilation 212
design flow 201
using 212
SignalTap II Files (.stf) 203
SignalTap II Logic Analyzer 201, 202
analyzing data 208
design flow 201
incremental routing 206
Instance Manager 205
mnemonic tables 209
quartus_stpw executable 25
setting up and running 203
stand-alone version 25, 204
triggers 205
SignalTap II Logic Analyzer page 206
simulation
libraries 137

Simulation page 133
Simulator 139
  specifying settings 69
  using 139
Simulator page 139
Simulator Tool 142
SOFs 187, 191, 192
Software Builder
  specifying settings 69
SOPC Builder 234
  creating designs 236
  creating system 236
  design flow 234
  generating system 237
System Contents page 237
System Generation page 237
  using 236
SRAM Object Files (.sof) 187, 191, 192
stand-alone Programmer 187
Standard Delay Format Output Files (.sdo) 132
STAPL see Jam Files (.jam); Jam Byte-Code Files (.jbc)
Start Early Timing Estimate command 156
Start EDA Netlist Writer command 134, 164
Start EDA Synthesis command 82
Start Partition Merge command 95
Start SignalProbe Compilation command 213
Start Timing Analyzer (Fast Timing Model) command 154
Start Timing Analyzer command 154
State Machine Viewer 90
state machines, viewing 90
Support Center 246
Symbol Editor 54
Synopsys Design Constraints File (.sdc) 165

synthesis
  design flow 76
  incremental 39, 70
  Integrated Synthesis 77
  netlist optimization 83, 86, 173

performing with EDA tools 80
VHDL and Verilog HDL support 77

Synthesis Netlist Optimizations page 86, 173
system debugging see SignalTap II Logic Analyzer; SignalProbe feature
system-on-a-programmable-chip (SOPC) 234

T

Table Files (.tbl) 209
Tabular Text Files (.ttf) 188, 192
Tcl 26, 29, 32
technical support 245, 246
Technology Map Viewer 92, 161, 216
Technology Map Viewer command 161
test bench files 134
Text Design Files (.tdf) 52
Text Editor 54
time group assignments 152
Time Groups dialog box 153
timing analysis 145
  design flow 145
  performing 154
  performing an early timing estimate 156
  performing with EDA tools 163
  specifying settings 69
  using fast timing models 154
  viewing delay paths 159
Timing Analysis page 163
Timing Analyzer 12, 145
timing closure 168
  design flow 168
  making assignments 171
  using LogicLock regions 175
  using netlist optimization 173
  viewing assignments 169
  viewing routing 169
Timing Closure floorplan 104, 168
Timing Optimization Advisor 172
timing requirements 149
  individual 152
  project-wide 151
specifying 149
Timing Requirements & Options
   page 149
timing simulation
   EDA tools 136
   Quartus II Simulator 139
Timing wizard 65
tutorial 249

U
USB-Blaster download cable 189, 202

V
Value Change Dump Files (.vcd) 180, 209
Vector Files (.vec), 142
Vector Table Output Files (.tbl) 142
Vector Waveform Files (.vwf) 142, 209
Verilog Design Files (.v) 52, 76, 80
Verilog HDL 55, 77
Verilog HDL Input page 77
Verilog Output Files (.vo) 132, 229
Verilog Quartus Mapping Files (.vqm) 52, 76, 80, 175, 228
Verilog Test Bench Files (.vt) 134
VHDL 55, 77
VHDL Design Files (.vhd) 52, 76, 80
VHDL Input page 77
VHDL Output Files (.vho) 132
VHDL Test Bench Files (.vht) 134
View Port Connections command 222
View Properties command 222
VQM Files 76, 80, 175, 228

W
Waveform Editor 134, 141
Waveform Export utility 209